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Getting Started.
Building the system Framework with 4TQExplorer.

Where to start.

r -
The key to successfully mapping your business processes is to 21 4TQE xplorer - untitled

start with an overall framework upon which you can build your File Edit Proceduss Detals Updates F

Process Knowledge base. Ipr,;,m:_.dun:_.5 List j ™ | E,"'l El

4TQEXxplorer is the tool that provides this framework during the Pl B et Lok B2
"start-up" phase, then as the system develops, its role expands to
cover overall system management, document registration, Review
or Audit cycle management and, most importantly, the master
index (register) providing a quick "on-line" location and access
service.

Building the Implementation Framework.

The first step is to build an initial framework that will provide the foundation for your Process Management
journey.

Run 4TQExplorer from your Start Button's Programs - 4TQToolkit menu.

4TQExplorer has two main windows, the Procedure List tree view window (Navigate) on the left-hand side
and the Tabbed List window (Explore) on the right. You will only need to use the left hand Procedure List
window to build the implementation framework.

A |nitial Framewark)

Click once on the top label (Procedure List) to select it, pause and then click -
once again to place the field into edit mode. Then replace the text with a -
meaningful title like your "Company name" or "division name" plus "Initial framework". Press the [Return] key
to set the changes. This "top of tree" label is your anchor point for this view of your business.

The next task is to expand from this anchor point and build your initial framework perspective.

W R Select the label again and then right Button click on it to display the context
= menu shown left. Select the Add menu item to reveal the sub-menu and click
Update All Erocedures on the Category item. 4TQExplorer will add a "New Category" label to the
Previews s+ | Procedure List, indented one level under the Top of Tree label. The "New

Category" label will automatically be selected and in edit mode ready for you to

Tocls ' over type the label with your content. The names of the categories are entirely
Expand &l your choice, and as we are building the "Initial Framework" using a functional
Sait [52) breakdown that you are comfortable with is likely to be the sound approach.
Most businesses have a "Sales" function, so let us name our new category
Benarne "Sales". Now continue to add the other main categories to complete the second

i i level of your framework.
Print Procedure List

Rieports » | Go with your first ideas. Remember your aim is to get started. You can change
— the "shape" of your framework any time as easily as you build it.

Saznciated ElEs
Properties. ..

Your framework should look something like the one shown on the right. Naturally you E@ AZ Initial Frameork
will have different categories and maybe more of them to suit your needs. o
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For the moment let us expand the details in one of the main categories. Click on the Sales label, then Right
Click and select the Add -Sub-Category menu item. Re-name the "New-Sub-category", "Taking Orders".

You could add further Sub-Categories to the "Taking Orders" label and repeat this process to a maximum of
99 levels. Between 3 to 6 levels is normally adequate.

=50 AZ Initial Frarmewark,

Continue building your Framework until you feel comfortable that it covers all E“%l Sales —
the areas you may need. Remember it does not have to be (and will not be) o SR T aking Orders
perfect. At this stage the task is to get started. Details can be changed as and [£5] Operations

when you need. ------ ES] After Sales Services

L [BS] Administration

Saving the 4TQExplorer File.
Before moving on to the next phase lets save the work done so far.
When the 4TQToolkit was installed it required two File locations to be _ . .
selected. The first, called the ProgramPath, sets the location of the EI% LC'—aps an Sm700° (L)
master directory where actual programs and common support files E"a are
installed. - Archive

=20 1PMs

- Admin

The second, called the SystemPath, sets the location where your --{:I Forms
configuration and data files are located. If your SystemPath was for -1 Palicy
example L:\4TQ you will find that a set of sub-directories (Folders) -] Procs has
been created as well. One of these sub-folders (IPMS) containing [—]D Macros four
sub-folders named "Admin", "Forms", "Policy" and "Procs". You can -0 Words add
to these if you wish. What is important is that all of your Procedures #-0 Words be
stored in or below the actual SystemPath for the Document control -0 WPETS
aspect of the 4TQ Guardian function to work for you. {27 Records

[+ Samples

=1+ Training
4TQExplorer files may be sayed in any location withir_1 the #-{21 archive
SystemPath branch of your file system. However saving a -] educake
4TQEXxplorer file into the actual SystemPath itself has a special effect --{:I health of
making the file a "Company System File". 553 qa

27 WebRoat
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This will have two main effects. Firstly, you will receive

warning messages when saving changes to the file. The

message is shown (right). ! Dﬂw-::?'vmri-r:mnumr caation,

Secondly, the Framework file will appear under your
company's name on the File menu, as shown (right). Use
this feature to help other users locate your company's

—_—e

Woup Compary Mare Sribam fles reflect & spscific viem,

standard Frameworks easily without having to know the file's location and name.

Since you are creating your initial Framework and you will develop it into
your master system file, click on the Save button on the Toolbar or use
the File - Save menu item to save the file in the SystemPath.

If you close the File or 4TQExplorer and then run it again you can open
the file from the "Your Company name" File menu item. Note, files
opened in that way are normally opened in Read-Only Mode. To re-open
a file in Write mode you must open it using the File Open menu dialog
and check off the "Open as Read Only" flag. While this is the default
behaviour, your administrator may have altered the default or your
specific settings.

Migrating an "old" system.

E!ciTQElenrer - untitled
|F[:§ Edit Procedures Updates Re

[T

Open, ..
Save
Save As

v Check Procedures On Open

BxI0N Syshems g
Your Company Mame Syskems  #

Properties...

Exit

B s |

Experience has shown that rarely will your system be for a "green fields" site. The fact that you are in-
business means that you already have a history of knowledge in the form of procedures, policies and

guidelines. What is needed is to find, sort, relate and cull this material so you can manage and control it. It

makes sense to locate and catalogue the things that you already have and make good use of them. The
framework you have built in the previous section is the ideal place to catalogue the existing material you
have. At the end of this phase you will have a coherent structured way to quickly locate the existing material,

and perhaps more importantly, you will have

started to identify the things that are missing and =+ Your Company Initial Framework

needed. E||§| Sales
; e E

The existing material can be in many forms.
Common examples include Policy and Guideline

|§| AFter IUpdate Categary Procedures
' Remove Category

Procedure
Palicy

statements, printed or computer based template B8 Adnir

Link. Procedure
Direct-Tree

forms, and Process documentation in the form e '
of "Standard Operating Procedures (SOPs)" or Expand Category
Work Instructions. Sort (A7)

Rename

Prink Categary

Repatts

fAssosated Fles
Propetties...
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Adding a Form to your Framework.

Run 4TQExplorer and open the perspective to which you wish to add the Form. Using the Initial
Framework, which you constructed earlier, let us now add an Order Form to the Sales - Taking Orders label.

Click on the Taking Orders label, then Right Click and select the Add - Form sub-menu item (shown below).
Using the dialog box, find and select the corresponding file of the Form and click the Open button.

=0 AZ Initial Framewark,

The Form's label is added under the current label and has a special & Sales

Form icon as shown. You can edit the Form's name to give it a more Ell%l T aking Orders
meaningful title by clicking on the label and over-typing the default entry.

If the document contains "Summary" or Property sheet information, Iﬂ
4TQExplorer will extract and use the appropriate values storedinthe &l Operations

Property sheet. If the Documents property sheet is blank or not available ... ES] After Sales Services
the Form Label will default to the Documents actual Filename. Notall =] Administration

files have "property" sheets. To edit or add information to a Property
sheet when using MS Word select the Properties item from Word's File menu.

To view the Form, right click and select the View Form item.

Adding Policy Documents. =50 AZ Initial Framework

E||§| Sales
To add a policy statement to your framework, right click on the required El ES] Taking Ord
category to select the one that the policy relates to, and then select the = L ARIng Lders

Add - Policy menu item. For our example let's add a "Credit Policy" to [ ] Order Form
the Sales category as shown on the right. - ﬂj Credit Policy

------ ES] Operations
------ ES] After Sales Services

------ ES Administration

, . . : . : & Gales
To view a Policy statement, right click on the Policy label and select View EI |§|+ T aking Orders

Policy.

Delete Policy
-[E5] Oper,
Yiews Policy

&S] Admi Fename

Saznciated ElEs
Properties. ..

More about adding Policy, Forms and other document types

When a document is added to a 4TQExplorer framework as a Policy or Form, 4TQExplorer will check the
document for the presence of Property information. This information can be used as a source to populate the
Title, Owner, Reference or Version displayed in 4TQExplorer lists. MS Word and MS Excel documents are
examples of documents types that have a Properties sheet or page.

The Property sheet is accessed on the File Menu of the source application.
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Behaviour without a Property Sheet.

If a Property sheet is not available 4TQExplorer will add the document with the label displaying the file’s
name and with the field in edit mode. The label can be changed later with the right click rename option or left

click edit.

Behaviour with a Property Sheet.

If a valid Property Sheet is found the contents of the sheet are used to provide the Title, Owner, Version

number and optionally the Document Number as detailed
below.

The Title Field.

The Document label cannot be edited in 4TQExplorer.The
Title field contents from the Summary tab of the sheet are
displayed.

4T ExplorerFields. doc Properties

Garmwal Summary | Sestutics | Conterts | Custon |

Ditle; TITLE
Fubject

fthor o heace
Bienage |y Chokd]
ARy

If the Title field is blank the label will display PROPERTY: Title <blank> - filepathname.

The Owner Field.

The value used in the detail list will be selected from the Property
Summary tabs field Manager field. If that field is blank the Author

field is used. If both are blank the owner field will display
PROPERTY: Author <blank>.

The Document (Reference) Number Field.

The Document Number value, contained in Properties Custom tab, is

displayed in the Details Reference column if present.

To set the value for the Document Number open the
Properties dialog from within the source application and
select the Custom tab. Scroll down the name list until you
locate the Document Number field as shown on the right.
that the type is set to “Text” and enter the document number

The Version Number Field.

4TQExplorer will check for the presence of a Custom field
labelled “Version”. Unlike the Document Number field the
Version field doesn’t pre-exist in the field list. You will need
the field.

To add the Version field type the label (Version) into the
Custom tab’s Name field, set the Type to Text and enter the
desired value.

4TQToolkit User Guide
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If the Version field value is not present in the Property sheet 4TQExplorer will use the value contained in the
standard internal “Revision number” field. This value is normally displayed on the Properties sheet’s
Statistics tab. In MS Word the value of the Revision Number is incremented by one each time the document
is saved. In other applications the field may or may not function.

Updating the Field values.

To update a custom field value open the Properties dialog in
source application (ie MSWord) and select the Custom tab.

In the Properties list (bottom of the tab display) select the field
wish to change in the list and enter the new value in the Value
field. The Modify button should become active, replacing the
button. Click the Modify button to commit your new value.

|:1 A TUE eploner

undidlezd
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Adding a Procedure to your Framework

One of the functions of 4TQExplorer is to deliver the "horizontal" or process view, of your organisation's
"system of work" based on the process layering provided by 4TQFlow. During the building of your initial
framework, you will possibly need to do one of three operations,

e Create a New 4TQFlow Process Map,
¢ Use an existing Document in its current form,
e Add an existing or supplied 4TQFlow Process map.

Usually you will have some existing documentation. As a general rule it is best not to immediately convert it
into a 4TQFlow Process Map form. There is no real need to do so if the existing material is up to date and
providing satisfactory results.

The first two operations are performed by

the Add - Link Procedures command. = W o .
The Add - Link Procedure command Gperations

displ dialog box in which the Title of Update Category Procedures Procedure
ISplays a dialog .OX IntW Ié: deth : ?l o After Sales Remove Categary Policy

your new process is entered and the file Administration e

name of any existing document (if Toals b

required). Clicking the Link Button will Link Procedure

automatically create the 4TQFlow Expand Category Direct-Tree

Process Map with the supplied details. Sork (A-Z) -

Clicking the Link Button causes the "Add 4TQFlow Procedure" FileSave dialog to be displayed, with the
default path set to your 4TQ SystemPath\IPMS\Procs and a default file name constructed of "LP" (for Local
Procedure) followed by a Sequence number and the Process Title.

You may move the file location or change the file's name as required. Remember to save your file within the
SystemPath for the 4TQ Guardian features to have effect.
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Creating a New Procedure.

Right Click on the desired category item within your framework to display the context menu, then select the
Add - Link Procedure item as shown

above. -

Cimaln & newy Link Paocedins by snlenng 4 THs
(0 Biomsbi lo L a7y icssln) Fioceduie

The Link Procedure dialog box

(shown) has three fields. Your entry Te | Sigima |
in the Title field will be used within

4ATQFlow's Title Page as the “m'“"” | Bocwse |
Processes' Title.

Enter the Process Map's Title and B i N b

then click the Link Button. The chiien of Link Procedise.

FileSave dialog will be displayed and

if you are happy with the location "Im;dmn::’

and File name offered, click the Save Procedern Litl salscior

button.

The Link Procedure feature will

always offer to create the file in the
IPMS\Procs Sub-folder. The default |—|
file name structure is made up of =
“LP” (Link Procedure) followed by a
sequenced number and the Process Title.

4TQFlow will automatically run if it is not running and display the newly created (saved) procedure file. The
new procedure will also be displayed on the 4TQExplorer framework with a special icon (shown on the right).

The icon will revert to the standard icon(s) once you have altered Process B 2] Sales
Owner field in the map's Title Page. 4TQExplorer will display a message o
prompting you to save your Framework. - E T

E ...... L::F:i

Counter Sales
You can leave the Process in this initial form and complete it later, using the icon to identify the new partially
completed Processes. It is a good idea to at least complete some of the Title Page as soon as possible. If
you wish to complete the process information, use 4TQFlow to open the new procedure's Title Page by
double clicking on the Title box or by pressing Control + T.

The steps involved in creating (and modifying) a Process Map are explained on page 20, and the details of
Step 3 should be the minium information you initially seek to complete. Additionally, adding the Review
Schedule Property to the Title Page Property list brings the process within the scope of the 4TQ Review
Schedule management reports. For details on the Review Schedule Property refer to page 38.
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Using an Existing Process Document

In many cases you will have

existing text based documents B P e HE
that should be added to your Canrts.s new Lirk Frocadies by o Tile

Framework at the appropriate [ Broesss to Link, an swsking Fiocedus

point. Follow the same steps for -

creating a new procedure using Tde  [Prom Sde: st

the Add - Link Procedure
’ RurFletolink [0 ccunenisPhone. G sies, Proc
additionally entering the existing s [/ ooumeniFhone_S ales_Prooschae dod Bucwrvn

document's file name into the
"Associate RunFile to Link Procedure" field as shown.

4TQFlow will behave as it did when adding a new Procedure, however this time a Task figure will be created
on the Process map's workspace and the RunFile reference to the existing document established. The Task
Figure's Label and Performer's Field will both be filled in with default text.

By incorporating your existing Procedures in this way you have established the ownership of the process and
optionally turned on the review schedule, so that 4TQExplorer can assume the review cycle management
function for this procedure. Your existing process document may be perfectly adequate for continued use,
and can be maintained in this way until the need arises. For instance, as a result of a review you may need
to alter (improve) the process. You can take that opportunity to convert the information into a 4TQFlow
process map with the current process details in mind. Use 4TQScribe to assist you when you decide that the
document should be converted. The use of 4TQScribe is explained on page 52.

Complete the Title Page information as before.

Adding Existing 4TQFlow Process Maps

To add a single existing 4TQFlow Process map, use the Right Click Add Procedure menu item at the desired
point in the framework. With the File Open dialog, locate and select the Process file and click the Open
button. Any Sub-Processes referenced by the selected procedure will also be included into the 4TQExplorer
framework.

Adding a Directory Tree.

The Add - Direct Tree method can be of great use if you have existing 4TQFlow Process Maps or other
people are assisting you by documenting specific areas of the business.

The key feature of this method is that 4TQExplorer does the hard work for you. Use the Add Directory Tree
context menu item, and then select the Directory that contains the 4TQ Process Maps that you wish to add to
your framework. 4TQExplorer will analyse the relationships between all the Process Maps in the directory.
Based on this analysis, 4TQExplorer then selectively adds only the Parent Processes to the framework. This
may take some time.
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Adding Background Information to your Framework.

Each label in the Procedure List can be associated (linked) with up to five documents, a Web URL and a
4TQLink measurement file. We will deal with the use of the measurement files later in this guide.

In your search for existing material, let us say you have found a "Credit Guidelines" document and you wish
to include it in your framework under the Sales category.

(Note: The information in the "Credit Guidelines" is not required by anyone actually performing the procedure
and is background information only. If it is useful to a person "doing the job" then the reference should be
made from within the 4TQFlow Process map itself, as a "Runfile". Refer to page 29 for details)

First click on the Sales label to select it, then right click and select Properties from the context menu. The
Properties dialog has four tabs, select the Associated File tab. Press the Browse button, then find, select
and open the file containing the "Credit Guidelines". The File will appear in the list shown on the Associate
tab page. Click the Associate button to complete the association.

=50 AZ Initial Framewark,

To remove an association, select H- 5] Sales
the file in the list and click the
Disassociate button. You can also
run the file directly from the

Associate tab page by selecting ~E=] Operations A .
the required file from the list and o [B] After Sales Services Lipdisis Caispoe Piovedant
clicking the Open button. L i e d
e [E5] Adrinistration B .
Tomade ]
Essend Lo
S B
The Framework example now shows a yellow folder icon with a small .
plus sign to indicate the category has additional information. You can
right click on a label with this icon and run the selected associated file w i
directly from the context menu. i E—
To view an Associated Guideline or reference file select the label and i e |

right click. Then select the required reference file from the Associated file list.

What's Next?

Your initial framework is a catalogue or “register” of your process information and identifies the process
owners. Now you have a start point on your journey to implementing a system of management, based
entirely on the actual layered shape of your processes.

You will also have revealed any missing, weak or needed items and in doing so performed a form of “Gap
Analysis”. The challenge now is to fill in the process gaps, align them with your policies then implement,
control and review them.

4TQExplorer also provides a Process Review scheduling register and, if needed, an 1ISO9000 element
versus Process deployment matrix. To use these functions, the appropriate information needs to be added
to your Process Maps. The next section deals with using 4TQFlow to capture and document each Process.

Using other 4TQEXxplorer features to manage and control your system is dealt with in the “Managing your
System” section of this guide (page 56).
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Documenting a Process.

Axion has had the privilege of viewing procedure documents from many different sources. Based on our
observations, there are a few points that you may wish to consider when setting about documenting your
processes and building your "system of work".

About your users

The documents you supply must be useful and of benefit to the intended reader. Anything that is of little
benefit to the user will be perceived as almost valueless and given little regard. We have seen many
beautifully presented, well organised, and expensively maintained Documentation Manuals (and libraries)
with dust on them! Worst, in some cases there has been more than one set, one for "Safety", another for
"Quality" and maybe even one for actually doing the work!

So, what makes a Process document beneficial? Well, here is a list of points we believe worth considering.
e Content - Factual and correct.
e Presentation - Consistent and very concise.
e Directed at the user's needs.
e Add value to the work of the individual.
¢ Incorporate "Compliance issues" into the actual work practises.

The hard part in all of this is in truly understanding the needs of the user. It seems that, given the scale of
large organisations, and the specialisation of workplace roles, you could expect such a definition of needs
would be exhaustive and potentially internally in-conflict. Fortunately, it is not!

You will only find two types of the real user. Type one is qualified, competent, and experienced for the role
he or she plays. Thankfully, type one people are, by far, the majority in any established organisation. You will
need them, for they already know the How, Why, When and Where of the enterprise. They are precious, as
you will see further on.

Type two users differ from type one in only one aspect. They are qualified and competent for, but
inexperienced in the roles they play. Type two people become type ones very quickly when given the
appropriate leadership, support, encouragement, and ready access to "How To" information upon which they
can reliably build their own personal experience. When the type one work colleague of a "new" person does
not actually show that they (by actions, not words) see beneficial value in your documentation, you cannot
expect them to.

The challenge is to engage your organisation's experienced people to want to use the "documented system
of work" because they see it as helping them. It will only be so when it is easy to find, easy to use, up-to-date
and relevant to their work and life. Given such a state, the task of the getting user "buy-in" and actual
process ownership is self-driven.

Some of keys to engaging your experienced people include;
¢ Including them, directly in the evolution of the system.

e Actively seek "Process Owners", select wisely, aligned with the actual accountability and
responsibility of and for the work outcomes.

e Measure the Process, in process outcomes terms and feedback the information.

e Keeping "it" short and to the point, use "layering"(sub-processes) to handle complexity.
e Make it easy to do, and easier to get changes (improvements) made.

e Do notinclude "Policy" or Policy interpretation in Procedures under any circumstances,
e Use the "picture" (chart diagram) as the best quick finder "of the bit of detail | need",

e Don't use "references" as a substitute for information.

e If you do make a "reference", use a live link at the step where it is used.

e Always test it in the "real world" with both types of user (if possible).
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Getting started with 4TQFlow.

Before starting to document your first process, it is worth spending a little time adjusting the layout of the
4TQFlow workspace to suit your needs and preferences.

Preserving the screen layout.

To preserve your current 4TQFlow window size and screen position, hold down the shift key while clicking on
the EXIT button. To close the program click on EXIT again, without the Shift key. The next time you use
4TQFlow, the screen will be exactly as it was.

Creating a new process file.

There are two ways to create a new workspace. Firstly, clicking the ToolBar’s new button clears the screen
and Opens a new workspace based on the current 4TQ Template.

The second way is to use the File Menu's New command. This method will allow you to select a different
4TQFlow Template for your new Process Map. Each Process Map may be associated to a 4TQ Template,
which will customise the Global Performers, change Section Headings and set up the Title Page's Property
items automatically.

The optional properties include Amendment Records, Review Schedule, Process Chart Preview and
Compliance Issues.

Mew ’
Selecting the <<Default>> Template applies the default setting as Template
stored in your 4TQFlow configuration File. T
If you have a document on the screen, 4TQFlow prompts you to —EE?-_I

save the document before you create a new one. If you do not I# | Ereate Froperizs

save the document, any changes are lost. ¥ Feset Headms

— Description
With each new chart, your New Chart Scale Preference is applied I
to the workspace. Refer to the Options - Preference Dialog box to | Default values for 4TQFlow Documents
alter the size of the Figures (scale), and set the position of the
mandatory START Figure. This size is measured in grid units and
is based on the size of your selected Figure "Figure Text" font.

Note: Charts created with different scale settings cannot be pasted onto each other.

The following nine steps detail how to create and publish a new Process Map. The steps cover opening a
new Workspace, entering the Process Map’s Title Page information, adding the Process activities, and
generating the report document.
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Using the 4TQFlow Figure types.

Flowchart Figures represent the type of action that occurs in each step of the process. Understanding each
Figure will help you to interpret those process actions.

7
GROUP
1. Start
The beginning of the process. There is only one start 2
in a process map. The Start Figure can not be | 1 gagrt 3 TAsK
deleted. It is the ideal place to detail the
assumptions and required conditions before
someone commences the procedure. 4 8
4 N
2. Direction of Flow - TEST >~ _"®
All Figures are connected by arrowed lines that
indicate the sequence of activities. Yes
_
3. Task A |~ SPLITTER B
An action step that must be performed and
completed before proceeding to the next activity.

The Task figure is where the work is done.

6 suB 6 suB
8 PROCESS PROCESS

4. Test

na O——

A decision that can only result in a yes or no

answer. It determines what path the operator must 9

take to complete the process successfully. " END
5. Splitter

Used to show a process that is split to handle non-sequential activities. The splitter is created with two
outgoing flow line start nodes. You can add more outgoing nodes by Double Clicking immediately below
the bottom line of the splitter symbol. Up to ten Nodes can
be added to a total of thirteen. The Node labels will
automatically be sorted in alphabetic order (A to M). If you

0
are using a very small figure grid width setting you may not
be able to get all twelve node. [AlB[CIDIE[FIGH[ITI[K[L] ™
Note: All paths must be completed. The operator(s) select
which path to complete first.
6. Sub Process
0
A task containing a micro process; a stand-alone process required to
complete the macro process. A Sub-Process is a process that divides PREDEFINED
a large process into smaller manageable processes. You will often find PROCESS —
that one how-to-do manual may refer you to another reference for

more detail or extra reading. Sub-processes work much the same way.

Sub-Processes also include cross-functional processes (common processes used throughout the
organization controlled by one department). Examples include supply procedures, leave applications,
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payroll, training programs etc. Instead of each department duplicating this documentation, 4TQFlow has
the capability of linking these cross-functional processes as sub-processes.

To create a Sub-Process first create a Task figure then add a “Jump To” entry in the Figure Dialog

General tab’s “Jump To” Field.

Group A Group B
7. Group
A collection of process steps that have a common attribute, function or A Ly
are associated in some way that you wish to display. Organisational

grouping may be used to show how processes cross through other 1 !
divisions, functions, locations or areas of responsibility. . .

l —
0 1

8. Connector & Socket Pairs @
Extends a flow line without the entire line being drawn. This is useful when the
actual flow line path would clutter the chart and make it difficult to read.

Connector & Socket
(socket has a tail)

9. Finish
Indicates the conclusion of the process. It is normal (desirable) to have 0
more than on Finish on a chart. The Finish figure is used to record the
outputs and outcomes of a process. FINISH

Having more than one allows you to detail the optimal and less desirable outcome instances
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The Nine Steps

Open 4TQFlow.

Step 1: Run 4TQFlow from the Start button - Programs - 4TQToolkit Menu list

Ensure the MenuBar, ToolBar and StatusBar are displayed.

The Utilities Menu may be used to toggle the bars on or off.

The StatusBar is displayed at the bottom of the 4TQFlow Window.

The ToolBar, when displayed, is positioned within the MenuBar on the left-hand side.

Saving the File.

Step 2: Click on the ToolBar's File Save button.

Fill in the File Name.

The 4TQ Process File suffix (.FLW) will be appended automatically if omitted.
Press the OK button.

The directory shown on the right displays a typical SystemPath
structure. The SystemPath in the case shown is L:\4TQ. You can
the location of your SystemPath by opening the Customise Dialog
can be found on 4TQFlow’s Options menu.

The IPMS sub folder is created during the software’s installation and
contains four folders, Admin, Forms, Policy, and Procs. The Procs
folder is a good place to store your Process map files. You can of
course add other folders to extend the structure to suit your needs.

Choosing File and Folder Names

There are a few general tips that you should bear in mind when
naming your files and building a folder structure.

If possible use DOS 8.3 filenames.

Only use alphanumeric characters (A-z, 0-9) for file and
folder names. Do not use “white-space” characters like
space or tab.

Keep the depth of sub-folders below 7.

Always store your 4TQFlow files in a folder below the
SystemPath.

[

A

=52 Lel_apps on 'Sm700" (L:)

S| check
{:I Archive that
= 1PM3

-] Admin
-2 Forms sub-
D Falicy
{:I Procs

[—]{:l Macros

-] worda

-2 wardg

-] WPETS
{7 Records
i-27] Samples

[—]D Training

=[] archive
{:l educate
&[] health
=1 ga

i-{_7] WebRaot

Keep the total length of a file’s combined name and pathname to less than 255 characters.
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Filling in the Title Page. ﬂ
Step 3: The Title Page holds the common and control information of the process. It consists of a series of

Property sheets. Always start a new process map by O |
completing the Title Page properties. If you do not get

the whole process mapped in one session, you will at M_:I | ew |

least have the main information to refer to later. Procar Dats Careal |

| -

e Click on the Title Page button on the MenuBar. Hew | Do | | oo | | s |
The Title Page dialog will open and display the TGPl Bk e pu-dnci G et i ol G inci il =]
Process Detail Property Sheet. e e o oy e e Einmar o ot s sbuck b cerlial

The property list is shown at the top of the dialog. AT (Ficws woll grvm ke scrays o Confolied documants orle when the
ol coraborn. arm el
1. The Fraceas Fils o ol cfeckasd o " Fessd Dok
. i i 2 t'-&t(llﬂlml #A T i Ddriead . i
. chiII in the Process Details Property sheet including F _'r:'ﬂ':;';t :::.: ;mf:_;'ﬂju‘;ﬂ_m N
e: hyerant
|

o Title = The Process's shortest meaningful
name.

e Owner = The Position Title of the person who owns and controls the process.

e Version = The version number of this process.

e Click on the Process Summary Property.

Summarise both the Purpose and Scope of the Process. Enter a brief description of the purpose of your
process in terms of outcomes or results, the event that starts (stimulates) the process, and the state that
exists when the process ends.

The Process Summary is a very important part of the Title Page information. Your intended reader relies on
the Processes Title, and the contents of the Process Summary to quickly verify that this process contains the
information needed. The Process Summary is also automatically referenced and included in any Parent
Process Reports when the process is used as a Sub-Process.

Other Properties, including the Review Schedule and Amendment Record can be added now or later.

All of the properties shown on the Title Page Property list will be included in the report, and the order in
which they appear within the list governs the order that they will appear in the generated report.

e Press Title Page dialogs Apply button when you have finished.
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Begin Process mapping the activities.

Step 4: [*1= 2l a)ein]« [=[a] min|=]n]

0 Ll = O e e e e T

Click the Tool button to show the ToolBar.

Click on the Task symbol button in Toolbar.

Vad

Move the mouse until the Task symbol is positioned below the Start chart symbol.

Click the left mouse button to drop the Task symbol on the chart. The Task will be placed onto
the workspace, the flow-line from the start will be connected and the Figure dialog will open El

and display the General Property sheet.

In the Label Field enter a brief description of the step.

Fill in or select the Performer of this step.

Click on the Description Tab and add the
instructional details.

Click on the Techniques Tab and add any
explanatory details as needed.

Click on the Assurance Tab to map the
relationship of this task to an 1ISO9000:1994
element (if required).

Click on the Compliance Tab to map the
relationship of the figure to ISO9000:2000
and / or other Compliance systems that may
be available on your system. If the
Compliance property has not been added to
the Process map's Title Page the
Compliance Tab will be disabled.

Press Apply. Repeat Step 4 until you have

Create Hun-Téde Link &t Refevant Task

Tak
[Commte FlurFie Lk Al Fiskesvan T il
Figan Typs Pailread Hy
[ [ o =
Jirete | _bad.. |
Jizirhil |
I ks Ak Siacm [ Galely
™ Crangs Indicaim [ Ervaonmenis
I CrackPon ™ Complsrss
r [ Siratagc
[ Cese ] |  soa |

finished entering all the Tasks & Tests in your process.

You can optionally create a “Checksheet” report for the process. Checking (Ticking) the “Checkpoint”
Checkmark on the General tab on any figure turns this feature on. For more information on creating Check
sheets refer to page 38.

TIP: Instead of selecting from the ToolBar each new Symbol, try Double Clicking the left mouse button under
the previous task and select the Figure type needed from the pop-up menu.

4TQEXxplorer can display the consolidated matrixes for the Compliance Issues, General and Assurance Tab
elements (refer to Page 63).
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Finish and test each flow path.

outcomes at have been attained. It is common to have more than one Finish figure.
Check that each process flow path has been completed and that all of the flow lines are connected,
The MenuBar’s Unterminated button will be active if any figures are not fully connected.

To Locate each missing flow-line Click the Unterminated button. Repeat clicks will locate each missi
Flow-line in turn.

Sorting the order of the document.

ol

Step 5: Add a Finish figure to logically end each of the process flow paths with the details of the outputs and

ng

@

Step 6: Sorting refers to arranging the order in which the process steps will appear in the Generated Report.

£

By sorting the order you can ensure the steps are sequenced so that your readers can W5t - PURD

follow the document easily. = Latmi
Immediately after creating a new chart the figure order is the same as the creation :-::1'::“--" pgies 1
sequence. Generating a Report in creation order may unnecessarily confuse your reader.  mm T
To avoid this, alter the Report order, by Clicking and Dragging Labels to the different e
positions within the list. The Layout of the Chart is not changed. Groups may also be G
'Dragged’, Press the Ctrl key and Click on each of the required Figure labels to build the P St e vt S
group, then drag the group. The mouse pointer will change shape when dragging. e i b

irresr] bimrss i gl
I rchude Sugwier Condect

¥ s 0 Dl o

Baarwi

The left-hand number in the Sort Window indicates the current sequencing and position of P

il

wred]

each Figure in the Report. The right hand number is the Figure's unique identity number
(ID).

The ReSequence command aligns each Figure’s unique identity (ID) number with its Reporting order
number.

If the Report order has been manually modified, use this command to realign the ID numbers with Report

order number.
Double Clicking on a label will open the Figure Dialog.
¢ Click on the SortWindow button on the MenuBar.
¢ Position the SortWindow by clicking and dragging the Title frame.
e Clicking on a Figure Label in the SortWindow selects that Figure on the Workspace.
¢ Double Clicking will open the Figures Dialog box.
¢ Right Clicking opens the context menu.
e To alter the Sort order Click on_the Label you want moved.
¢ Hold down left mouse button (drag).
e Move the mouse pointer up or down the list into the desired position.
e Release left mouse button.
o Repeat until all steps are in the desired sequence.

e From the Edit Menu, select ReSequence to match the Sorted Order to the Figure Numbers (Fi
IDs).

e Close the Sort Window.
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TIP: To Zoom in or out, Click on the Zoom buttons on the MenuBar.
The Figures may be aligned (vertically or horizontally)
¢ Click and drag the mouse to draw a rectangle over the figures that you wish to align.
e Depress & hold the Control key down and select by clicking on the figure that you wish to align to.
(You should have the one figure highlighted (the target), and a number of other figures selected.)

e From the Utilities Menu - Align items select the orientation required.

Final Checks, Presentation and Save. El
Step 7:

e Use the BugHunter feature to check your file for common problems like Missing Performers, Figure
arrangement (Documentation flow) and Sequencing errors. The use of the BugHunter feature is
detailed on page 27. To launch the BugHunter select it from the Utilities menu.

e To save the file, Click on the ToolBar File Save button.

Generating the Report Document. ﬂl

Step 8: To create the Process Report Document, Click on the File Generate button on the MenuBar.
e If the Spell Checker appears, Spell Check the chart.
e You can turn off the automatically pre-report Spelling Check with the Options General menu item.

e The Generate Report dialog will display the default file name and your default file format. If you are
using Microsoft Word, always select the Word 2 format.

e The default formats can be altered after installation with the Options WordProcessing menu item.

e Again, if you are using Microsoft Word, ensure that you have selected the correct Word template for
the exact Word version. Press the Attach to Template drop down list if you need to change it.

e You can set the reporting options by clicking on the Options Button.

e Press Save.

T |
g A = §-11E3

Meree  [RETOIET =
R A e |
S 202 chEEN
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Viewing the Report. ﬂl

Step 9: The View Report button launches your Word-Processor and loads the Generated Report Document.
If the Word Processor supports attached macrocode or templates, and you have attached one in Step 8
above, a dialog box may be displayed, allowing detailed layout choices to be made.

e Click on the View Report button in MenuBar.

¢ You can set the reporting options by clicking on the Options button. Click Save when ready. Wait for
the Word Processor to start and load the report.

e If a 4TQ Macro Dialog box opens, select the layout and options required and Click the OK or Continue
button. The three Standard layouts provided for Microsoft Word 8, 9,10 and 11 are Standard, Audit
CheckList and Uncontrolled. For details about the Template layouts refer to MS Word Template
section in this guide. (Page 45)

¢ A Message Box will advise you when the macrocode has completed and the report has been saved.
The report may be printed if required.

The View Report command gives you direct access to the Generated Report in your chosen Word
Processor, ready for printing or formatting. The default Word Processor is selected during installation of
4TQFlow.

The Report must be generated (using the Generate Report command) before you can view the report. If no
report has been generated, an error Dialog box will advise you to generate a report before using this
command.

The exact behaviour of the View Command is dependent upon the chosen Word Processor and the attached
Word Processor template.

Adding the Process Chart Property to the 4TQFlow Title Page will insert the Chart diagram into your
formatted Procedure document.

CETEE—— B TE
Word Macro Security Settings Sty ool || Trusted S |
Word 9, 10 and 11 have an inbuilt macro security setting. To "t o e s s et i o bt
access the security setting use Word’s Tools — Macros - e e e
SeCUrity menu item. i, R . st e it £

ot inlly Ut AL

The Word 9, 10 and 11 versions of the 4TQ Templates contain o il
an "Axion" security certificate that you can optionally accept as b ety v D g A X
a trusted source thereby by-passing the "Enable Macros" b robeberyuing Lo gy

prompt.

If your current setting is High, the macro code will be prevented
from running. Change the Macro Security setting to Medium in
Word, Generate and View the report using 4TQFlow. The s 3 e

“Security Warning” dialog, shown below right, will be displayed. e
You can tick the “Always trust macros from this source”
checkmark if you wish to reset your Security setting back to High in Word.

|- o i S ey [

rerE e e b

PE——— - _ ok |
Tap Fum mck ww kb

FEmon s corcan vwam. B e ks s o dealis remim, bl
Fon remres e epimain, Fourghi oss s heebioraliy

T sy sl indigh Messfoas, pa carmal srels
e e sarees el e o ek bre

I st rvuan woncrom droars FinE BCeBcR

| |
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Converting to Adobe Acrobat (PDF). T T Ty Y W —T )
If you have Adobe Acrobat (4.05 or 5) installed with the fetens | ey | Dffes St | Pacpar g |
optional Microsoft Word support components you can bmirat gmm
now convert the generated and formatted document into T Coneart e ot gding b Buokuanis
a PDF file. Use the “Convert to Adobe PDF” button to do b e e B
thIS Bovai s b (Csoarehdin Dagrel Tamor: [l.l-ul Foars 'rl
Elwmeri | T Bociwark | Level | =
i s
To have Acrobat create the PDF bookmarks open the i - :
Adobe “Change Conversion Settings” Dialog (shown on M aninll iy :
the right). Tick the “Convert Word Styles to Bookmarks” o -
option. Mo i
Clear all of the listed style Bookmark boxes. Then re-set ::-:::..'f' .":.
the following styles; [rceemer St
H N i ke
e 4TQTitle to Level 1, ek pire 3
e 4TQProperty to Level 2,
e i PN S8

e 4TQFigure to Level 3.

Complete the conversion after altering any other setting as required and clicking OK.

4TQWebgen Links

Generated Documents (both DOC and PDF) are identified by 4TQWebgen and if these documents are
present when the Web-Site is being generated “Printer Friendly” links are created to them. For more details
refer to page. 78.
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Advanced 4TQFlow Features.

Proofing with "BugHunter"
The Bug-Hunter feature is used to check or proof a BugHunts

4TQFlow Process map for some of the common
omissions.

Hr bl ssapcision st i nol hemmnsted

s bl bgks o el Hhsd dossn hase 8 parioames
e Firsd e wath el Juang-T oo oo Flun-File
Hre sl higuae:thad 13 nol amangesd

Hes Fad b thaad 13 nod i equasnns

e Fad g thaad by niok sl & soelleng reress
Hhe fusd higuae: thad hass & change mdaion

The Bug-Hunter is operated by selecting it from the
4TQFlow Utilities menu.

Clicking the Hunt button starts the Bug-Hunter operation.
When a problem is detected the figure containing the
problem will be selected and its figure dialog opened to
display the problem. A red Tick is shown at the line of
each test line if all figures have passed that test.

The checking routine has seven test components. These m Earscel
are listed in their application order within the Bug-Hunter
dialog (shown right). Each part may be turned off by

clicking on the “x” icon. Turning off a particular test may also cause another test to be turned off. For

instance, the Sequence of figures cannot be checked if the Not Terminated check is not performed.

Checking Terminations of Flow lines

This tests that each figure line start node has been connected to another figure so that all flow lines have
been created. This test is similar to the test performed by the “Unterminated” command.

Missing Performer

This test checks that each step in the process has been associated to a performer.

Missing Sub-processes or Run files

A check on external file reference links is performed to ensure that the files are valid and available. This test
is particularly important when 4TQWebgen will be used to create a Web-site as it uses the file locations to
create the URL addresses for the hyperlinks.

Check Figure Arrangement.

Checks that reading order of the figures is based on the flow-lines.

Check Figure Sequencing

Checks that each Figure’s ID number is in a logical ascending order.

Check figure Spelling check status

This test identifies figures that have not had a spelling review since the last change to that figure.

Check Change indicator status.

Identifies Figures that have the Changed Indicator checkmark set to on.

Adding a BugHunter Button to the ToolBar

A button may be added (or removed) to the Toolbar by Double Clicking the Toolbar itself and adding the
command button using the Customize Toolbar dialog.
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Navigating by Performers.

The Performers Dialog Box lists all of the Task Performers involved in the current Chart (left-hand upper box)
and all Global Performers. It provides a way to navigate around the chart based on the Performers.

The lower box displays the Tasks and Tests that the selected Performer is involved with. Performers can be
added by typing a new position title or name into the label box and clicking on the NEW button.

Any Performers may be made Global (available to other Charts) by selecting the Performer and clicking on
the GLOBAL button. Global Performers are stored in the 4TQFlow configuration file or attached 4TQFlow
template. Performers may be included in each Figures description in the Report Document, and a sorted list
is provided as Appendix- A. Refer to the Options Preference Dialog box for information on changing the

report settings. Poiomens |
[ I TR T T |

To create a new Performer, clear the Label field Prerirres likobal Pedtormens

and enter the Performer Title, then click the New P Pt & h*;";ﬁ_rw‘ i

button. Procar: Owran Hanrgrg st
By, dbraresl infin M arvd ey Diecks

The Change button changes the Performer text in :’,“Aiﬁ;—;ﬁ.}mu

Chaly | omcadtrem
5wz ek
T ebermanrha Fwn o F1a L idd

The Goto Figure button locates and returns you Figuist using selached Pedormner
to the selected Figure on the chart.

L] Wiard T o Sutorseiscaly Dorgl Hew Fracedues?
L T ot Dl el T (Flrar T il il ™
B Consne AT OFkea Tomplan Ei F
it Fi ; [ [rmsn Thee Tormpists Irckuds Tha =4 Placpas F
The Edit Figure button will open the selected : Draoe The Termsen Inchade The “Wamndvent Recodl Ppedy

Figure's Dialog box.

e |

T

T

all of the Figures linked to the old Performer title. (hasily fuissanece Marage |
x|

Gnka Figpura |

_tafae |

Note: When using 4TQFlow on a network, Global Performers are only 'Global' to each individual user unless
a 4TQ Template is attached and is "shared read only" via the Network.

Altering the Report Headings.

The Headings, or Figure field labels may be changed to suit Lebest [
your requirements. This is useful when dealing with Pefomedby B [Peiomedby
disciplines such as Occupational Health & Safety or Human Duerpion  F [Fatod
Resources, as specific headings are often desirable within

T ez hrwpees =] |LI:-:I.I Tigss

the discipline.
SubFipcace = |".||'F|-r|-'.'

The changes can be Applied to the current chart, and

optionally saved to the 4TQFlow configuration file as a T Chens o Capiabne i Agats
default for all new Charts. If you currently have an attached [hook | Cowent | sae | Load
4TQFlow Template the Headings are loaded and Saved to
the Template file.

To capitalise the Headings within the generated report, click on the check boxes to the left of the required
fields. The diagram shows all fields will be capitalised in the Report Document.

The Headings for the Description and Techniques field will not be applied to the Finish Figure type. They are
preset to Output and Outcomes.
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Changing Templates.

The Change Template Dialog box is the same Dialog used to select
a Template during the creation of a new Chart (File New). Unlike
the New File case both of the available options are changeable.

Checking the Create Properties item will add the additional Property
Item to the Title Page list if they do not already exist in the current

flow Chart.

Checking the Reset Headings Check box will reset the current
charts Heading text to the selected 4TQ Templates values. - Dezcription

The Global Performers list is always loaded from the current 4TQ

Template.

Creating Sub-Processes.

A Sub-process or pre-defined
Process cannot be created
directly on the Workspace. Any
Task Figure is converted to a sub-
process when a 4TQFlow file is linked to the Task
Figure.

Sub Process

The Add button on the Figure Dialog box must be
used to create the link to the Sub-Process. Once a
4TQFlow Process map file has been linked to the Task
the Add button changes to read Edit.

The “Add" button, on the right of the "Jump To”

Change Template

=]
Template
_ Cancel |

<< defaulty >
— Cancel

[T Create Properties
[ Reset Headings

Default values for 4TOF low Documents

Tanm O Process Guardian E
[ Genersl  Desoion | Techiguer | Assuarcs |

Taik
[T O Prccess Gusnden
5 ELRE =] Pailoimied by

| J |"':u-|l:'|ﬂ. vt 11
dusng T ! | ||_|u.-|'\-|F|"'.I-' el
[zl |

[T Vi Ackiind Slage
[ Crangs Indicaio
™ Crsick Poirdt
© Boundsy

k.

11171

Close i Spel

opens a sub-process file selection dialog box. After selecting the 4TQFlow file containing the sub-process
and Clicking on the OK button, the Figure is linked to that Sub-Process. The Figure will change from a
normal Task rectangle to the Sub-Process symbol. Only Task Figures may contain a sub-process. Sub-
processes themselves may also contain other sub-processes. 4TQFlow allows you to use up to twenty Sub-

Process layers.

The "Jump To" will open the Sub-Process Chart. If the current file has not been saved since the last changes

were made, you will be prompted to save the file.

The “Jump To” command closes the current WorkSpace and opens the selected Task’s sub-process chart.
Each Task Figure contained in the sub-process may also have a linked sub-process. The “Jump To”
command along with the “Return To” command (see below) are very effective means for navigating between

related processes.

To return from a sub-process to one of its parents, select Utilities / Return To command. Then select the

required parent Process from the sub menu list.

A Right Button Mouse Click on a vacant area of a Sub Process WorkSpace will also invoke the Return To

Sub Menu.
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Running other Applications.

The Run command launches another application (program). . [ESE [ T L et E s e Help
files, word processors, spreadsheets, communication Fla Ed Ui Zoom 100 Oplions  Help
packages, or any executable file can be run.
Profains repais

—— (O
The Run command is available via the Utilities Menu or by 1 ,L et
selecting a Figure and Clicking the Right Mouse button. B

-orrduct thes masirs &II.

——
The diagram on the right shows the menu that appears after _-Ln'_l_ ::.-:L: : the
“nght Button Click”. Tas Blrager on

et Ravew
Aramef o P |

To associate an application or data file, click the "Add" button on the Figure Dialog Box and follow the
instructions.

All Figure types can have a Run option.

The lower "Add" button allows 4TQLink (or other & 20 Fguwe RumFle |

applications) to be launched by associating a e — —

program file or registered data file. For example, S— -

4TQLink is run when a .4LK file is attached. Refer =

to your Windows documentation for more details e Ak B

about associating and registering files. g
Lisi Fifizs ol Tvpe: D

The 4TQLink Help file contains details on supported = |4TGwins Fikes 4| [=meong [+

"Command Line" arguments. Use the Help search et

command to search for 4TQLINK (in the 4TQLink [-GPF: - -sOperatos Lot

Help file) then select the "Command Line

Argument” topic for details.

The Dialog box shown above, will run 4TQLink, open the "EX_PRTO.4LK" file search for the "Operator Error"
Label, display the PARETO Chart in full screen mode, and open the Label annotation window.

The "Add" button will change to "Edit" when a valid file name is added.
Clicking on the RUN File button will start the associated application.

If the Show ID option is set to ON, Figures with a Run File or program attached are indicated by an # next to
the Figure's ID.

Tip: 4TQLink can be used to record the Problems, Causes & Effects, Notes and data about any step in your
process. 4TQLink will perform analysis of the data and produce PARETO, HISTOGRAM, FISHBONE, RUN
& CONTROL Charts.
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Locating Figures.

The Locate command will find and File  Edit Zoom 100 Options Help then

move the cursor and the focus of the Current figure Chl+E mber
Workspace window to the matching st Fgure b
component. This can be of great Previous Figure R

assistance when navigating around a
large Chart.

The Locate Unterminated option
function will also cycle around each unconnected line start node. This option is also available on the
MenuBar. The Un-terminated button is disabled if all line start Nodes are connected.

The Locate Function can also be used to navigate the process flow Forward or Backward.

If a Figure's Beginning is selected the Locate Matching menu will show Matching ending. Pressing the Enter
key moves the cursor directly to the end of the Flow Line.

If a Connector is selected, the Locate Matching command will move the cursor to the associated Socket.

If the target Figure is not on the visible area, the Workspace window is re-positioned so that the target Figure
is approximately centred.

An appropriate Figure or Flow Line Beginning must be selected for the Locate menu item to be enabled.

Assurance & General system element mapping.

For each Figure the dialog Assurance tab (shown on the right) may be used to record the linkage to
1ISO9000:1994 elements.

T N -

This information is collected and used in the ISO Compliance Title Page Bl | Do | Vi [ Toierns |
Property. This Property can be optionally included into your Generated - (i S Sl Y
Reports. Refer to page 21 for information on the Title Page Properties. ™ 2 i ™ T s Shan

T Lombmd Faerw 10 L N e g bt
If you do not want the Assurance, Compliance Issues and General Checks 7 speriem ™ 1 T, P s i
reported in your Generated reports, turn off the "Report Fig Check" option ' ;':‘:':“"' . ::::.T e
that can be found on the Options - Preferences - Reporting dialog. TR et Pt 1 1 T
4TQEXxplorer provides a whole of system view of the Assurance, r ::':'_"m :: :r::.
Compliance Issues and General system relationships. Refer to Page 63 F bl 1 W T
for information on using 4TQExplorer's Assurance and General Tabbed s | [T | ]
pages.

The checks located on the General tab of the figure dialog are reported separately in 4TQExplorer on the
"General" Tab.

The Assurance tab (ISO9001:1994) will be maintained in the 4TQToolkit until at least the year 2004 to
support the progressive migration to the new ISO 9001:2000 standard.
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Mapping Compliance Issues

The Compliance Issues property is the replacement for the "ISO Compliance" Property (R5). The ISO
Compliance property is used to provide the mapping between the ISO9001/2/3 (1994) standard elements.
The Compliance Issues property provides multiple requirements set mapping, including ISO9001 (2000).
Other Compliance, Business Plans or Legal frameworks may be included in your installation.

The Compliance Issues property must be added to the Process Map's Title Page Property list before you can
perform the mapping between the Process steps (Figures) and the requirement element.

Adding the Compliance Issues property.

To add the Property open the 4TQFlow process map's Title Page
by double clicking on the Title Box or press [Control + T]. Click on
the New button and select the Compliance Issues item of the list

of properties types. Click the OK button.

Using the Up and Down button on the Title page position the
Property with the list in the order you wish the Reports to be
Generated. Close the Title Page when you are satisfied with the

list order.

If all of your procedures need to have the Compliance Issues

Fropesty Type [ ]
r = |pEueg -
S e .
Ttk Fropeidy
Emeradrent Fscoed
50 Complarics _l
W Corcience e B

Property you can arrange to have the Compliance Issues Property (and any other property) created by

default in every new map you create.

Mapping Issues (Clauses) against Process Steps.

To map a Process Step to a required system clause
open the step's figure dialog and click on the
Compliance Tab.

If the Compliance tab label is greyed the Compliance
Issues Property has not been included in the
Property List of the Title Page for that 4TQFlow Map.

Click on the Drop Down List Arrow button, which is
located on the right hand side of the Clauses listbox.

A tree view of all of the systems included in your
installation will be displayed. Expand the list by
clicking on the boxed plus symbols until you can
select the required element. Double click on the
required clause to create the link between the figure
and the process step.

To add other Clause linkages click on the next free

Genersl | Descigtion | Techigues | Asssance [ Compiance
Clansmes

_G

[ TSR0l | Gty Sssirancs

[4 ] Gualty mansgement sysharm reguinsments
] ] Mansgerment resporabity

i [6 ] Resource management

#-[7 ] Process Management

=| |8 | Mesiriadisind, Ankbsas wrad Tadnoeiesnt
#-[ 15014000 ] Erveironment
+ [ TAMM ] Techrical Armork lineas B aglat on

il | | [ e

line in the list and using the Drop down Arrow button, repeat the steps above until you have added all of the

clauses required for that Process step.

To delete a Clause linkage, click on the clause and press the Del (delete) key.

4TQToolkit User Guide

Page 32 of 131



Using the Title Page's Property Sheet.

The Title Page Compliance Issues property can also be used to link and unlink clauses. The Property sheet
has two buttons, "Clauses for Figures" and "Figures for Clauses".

Clauses for Figures Mode.

Click the Clauses for Figures Button.

The top listbox will display all the figures in the process
and indicate which steps have a linked Clause with a
system based coloured # symbol.

Clicking on a Step that has a # indicator will display the
Clauses linked for that figure to be displayed in the
bottom Clauses listbox.

Figures for Clauses Mode.

Click on the Figures for Clauses button.

The top listbox displays all of the Clauses linked in the
Process.

The bottom Listbox shows the Process steps.

Selecting a Clause, by click on it, will highlight the
figures that are mapped to that Clause.

To link the selected Clause to a number of Figures click
on each figure in turn to add or remove the linkage.
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4TQFlow Optional Features

The 4TQ Process Guardian
The Process Map Guardian features provide
1. Automatic Archiving of superseded versions
2. Automatic Version Numbering
3. Automatic Amendment Record creation
4. Access Control
5. Work-In-Progress Collaboration.

To turn on the Process Guardian features use the Options Customise menu item and set the SystemPath
and ArchivePath to valid and available directories.

With the Guardian active, "Controlled" Map files outside the SystemPath and its sub-directories can only be
opened in Read Only mode. The StatusBar will show the C Indicator if the File is Controlled, SYS if it is with
the SystemPath, and READ if the file is Read-Only.

Controlled Process Maps

Each Process Map may be marked as "Controlled" on the Title Page Process Details Property sheet. You
will be asked to provide a password and confirm it.

If the Guardian feature is active, adding an Amendment Property will automatically mark the Process Map as
"Controlled", and a password will be demanded. Only Controlled Files located within the SystemPath can be
opened for modify (write) access when the Guardian is on.

Opening a Controlled Process Map.

To Open a Controlled Process Map with write (modify) access
rights This i & cordided docuanes [ ox
To Fh-d.a-'ﬂ'ﬂl &
« Select the File Open menu command. ’ : | : _ Lwe= |
e Locate and click on the required file. |

¢ Remove the CheckMark on the "Open Read Only" flag.
¢ Enter the access password when prompted.

You now have access to make changes to the file.

NB "Controlled" Process files stored outside the "System Path" directory are not accessible in write
mode. The System Path directory setting may be changed via the Options - Customise menu item dialog
box. A file may be saved outside of your "SystemPath". 4TQFlow will provide a warning message advising
that future access in write will not be available if the file is saved outside your system area.

The StatusBar will indicate when you are working within your "system" area and if the process is
"Controlled".

The Status bar on the right, shows the |Ready | 200 50 |[Clsvs READ ,«;fjl
Ready Status, the cursor at position 20,0,
and that the process currently in use is a version 5 file, is Controlled (C), is within the System Area (SYS)
and is open in Read Only Mode (READ).
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Saving a Controlled Process Map

To Save a Process File, use the File Menu Save option. T N - |
With the Guardian feature you can i b i |
1. Use the Save button to retain your "work-in-progress" PR b bt o A |
changes. (Your alterations will not be visible to other L 0 [ ]
4TQFlow Read-Only users and 4TQCoach, 4TQWebGen ihrychi Lwest |
and 4TQExplorer users.) i, -
I
2. Update the file, effectively publishing the changes you o
have made to all users without changing the Version

number or creating an Amendment record or Archive copy
of the superseded version.

3. Alter the Version Number and fill in the Amendment field to enable the Update & Archive function.
The action of changing the Version field value will cause the Save Only button to become inactive
and the Amendment Memo field to become active.

The Archive & Update button remains inactive at this point.

The “Please add comment describing this change” prompt, above the Memo field, is now in normal
text. The user may only exit the dialog with the cancel button at this stage.

When text is entered into the memo field, the Archive & Update button is enabled.

Clicking on the Archive & Update button causes
1. The changes to be saved, with the Amendment Record property updated to reflect the Version
number change and the contents of the memo field, with the internal 4TQFlow Version change
indicator, and the date of the change.

2. The Backup file (. BAK) is refreshed to be the same as the new version.

An Archive file to be created with full relative pathing under the 4TQ/Archive directory. 4TQFlow
will maintain 99 archive versions of each process file.

NB: The Auto-Archiving, and the Revision Collaboration feature are only available on "Controlled" files, and
write access is only available when the process file is within or below the "System Path" directory. The
System Directory can be set via the Options - Customise Dialog setting "System Path". The default
installation sets the SystemPath directory to Drive:\4tg\qa

4TQFlow will not allow you to use the FileSaveAs function if the file name and directory is the same as the
file currently open. To save the current file with the same name and location, use the FileSave menu item or

Toolbar button.

Process revisions & team collaboration.

When a "Controlled" procedure is partially updated by the Process owner, and the required modifications are
not completed in one session, the changes may be saved so that further alteration may be completed in the

next editing session.

The partial modifications to procedures saved using this option are not visible to the general (read only) user.
The general user still sees the "current" procedure from 4TQFlow, 4TQExplorer and 4TQCoach.
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While the Procedure is in the partially edited state, any
other user accessing the procedure is advised that the
procedure has already been modified. The dialog is
shown on the right.

If the password is entered correctly, write access is
granted to the modified information, not the current
published version.

If a procedure file is actively being edited during an
access attempt, the second user is granted Read Only
access.

Paszsword !

Thiz iz a controlled docurment with ik
changes in progress by
B, Uzer Cancel I
A pazsword iz required to access
the changes in progress. HeadOnly

Pazsword

In addition to protecting your "work-in-process" changes and hiding them from the other (Read Only) users,
this feature allows team members to actively collaborate on the task of improving and revising a process.
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Smart Report Navigation. e | God | Mowoira_ComnFion |
F Mg Apparats '
4TQFlow textual Navigation has four options available from the F Haccs FigLukais
Options - Preferences - Reporting Dialog. (Shown Right) I" | R Fa TR
k' Ao Py Sorboeees
The "if not next" setting causes 4TQFlow to only include the I Mopaos Taad Niguaas
navigation line for figures that are not immediately followed by F (s mnd F A Pt
the next process step. T Gesis o Outer ol 8l [omior ot igerr 7]
The "test only" setting will result in only the Test (decisions) [Crove ] cowa | swa | Lows |

figures having the navigation lines included in the report.

The Process map diagram (Flow Chart) may optionally be inserted into the generated report document. It is
highly desirable to place a copy of the Chart diagram in your reports. The 4TQ-template macro provided with
4TQFlow will do this automatically for you.

Printing the Chart diagram

To Print the Chart diagram use the File Print menu item. The chart will be printed at 100% scale and
optionally include the cut-lines and multi-page numbering in the form Row and Column. (ie. A1, B10) to
assist in assembling multi-page charts.

Setting up the Page layout

The File Menu’s Page Setup command opens a Dialog box controlling the page margins, printable size, page
number position and fonts. The printer you have selected controls the options available.

The Print Setup options should be set before the Page Setup.

There are two ways to set the Page size. The "Determine Page Size by" Radio Buttons on the middle right
allow you to choose between using the margins or the printed area measurements provided by your printer
(driver).

The Units Radio Buttons, on the upper right controls the Unit of Measurement.

Spins
e 1
® x 10

The Spin options sets the increment value when using the thumb ]| wheel controls

The Auto-Feed Margins option is useful if your printer is an auto loading dot matrix

Ty e1o0 | tyPe. If you have had instances of missing text on the bottom of a page from your Word
Processor, setting the Auto-Feed Margin to exclude this unprintable area will overcome this
problem. Page Numbers
The position and Font of the Chart Page Number is controlled by the  Top / Left
th_reg radio buttons and F'ont d!splay area. Clicking the Font Display box @ Bottom / Right
will invoke the font selection Dialog box. The pages are numbered in
columns (1,2,3 ...) and rows (A, B, C ...).  None Fort

The Save Button will store your selections as your default settings. The
last Saved setting can be recalled with the Load Button.

The Apply Button re-draws the WorkSpace, using your new settings. The Dialog box remains so that further
changes can be made.

The Accept button will apply your setting, close the Dialog box, and return to the WorkSpace.
The Printer button opens the Printer set-up Dialog Box.
The Cancel Button returns you to the WorkSpace with the settings unchanged.
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Printing a Process Checksheet.

The Process Checksheet report is available from the File menu. Designed as an individual Job or Batch
record, the report lists each specified process step, with an adjacent field to record the action taken and a
checkmark completion box.

Individual Process Steps may be included or excluded from the report by checking or un-checking the
"CheckPoint" flag which can be found on the lower left hand side of the Figure dialog.

Page one of the CheckSheet shows the Process Title, Version and Document Reference number information
and provides boxed fields for Job or Batch Number and date information. The report includes Page
numbering and printed date information on the bottom of each page.

The Review Schedule Property.

The Review Schedule provides two important functions to assist with the management, control and cost of
the process review cycle. To add the Review Schedule Property to a Process Map, open the Title Page and
click the New button, then select “Review Schedule” from the list of available properties.

The top portion of the Review Schedule sheet is the "Ready Reckoner". It provides a consistent way of
deciding which processes require more or less of your organisation's attention and resources. The "Ready
Reckoner" ensures that processes that are more critical and less stable receive management attention more
often than the less critical and more stable ones.

The resources consumed performing process m""’"" L m L I%
reviews are precious to your organisation, and the _‘| _.‘- ST

use of the "Ready Reckoner" directs those maih
resources in a uniform way, across the whole Lt s | Mt R |

enterprise, at the areas were the best gains can be made.

To use the "Ready Reckoner”, set the Criticality and Stability slide controls to reflect your assessment of the
current situation. Use the Criticality control to indicate the level of impact the process has on your business
outcomes, and the Stability control to indicate how stable or "problem free" the process is.

Lastly, we need to modify the combined Criticality and Stable Review Rate (RR) to reflect the Repetition
Rate of the process itself. There is little to be gained by attempting to review a process on a monthly basis if
that process only occurs very six months. The Repetition Rate should be set at "Very Often" for a process
that occurs many times a day, "Often" for a process that occurs many times a month, and "Occasionally" for
a process that occurs only a few times a year. The Period value shows recommended interval between
reviews and the Next Review date, and is calculated from the Last Review date. The Calculated Next Review
Date may be manually altered. Once a review is Due the Date cannot be changed.
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The lower portion of the sheet is used to record details
of each Review cycle. |

Use the "Any comment for the reviewer" to add g pommen! abois e (e sl |
comments or instructions to guide or assist reviewers. |
This field is disabled if the Next Review field is empty,

or the current date is the same or later than the date in
the Next Review fields. .

The "Any comment about the review" field is used
to record the results of the current review. This field is disabled if Next Review field is empty, or the Review is
not due.

Complete Button

Clicking the complete button writes the current Review record and starts a new review cycle. Remember
that you may wish to re-assess the Criticality and Stability setting as a result of Review findings. This button
is disabled if the Next Review field is empty or the review is not due.

Review History Records

The lower portion of the Review Schedule page shows the history of Review Schedules. You may browse
through the records of previous reviews by clicking on the scroll arrows. Review Records can not be
changed.

Clicking the complete button commits the current Review Schedule and starts the next review cycle. It will
update the current Review Schedule record, clear both comment fields, reset the review dates, and create
the new Review Schedule record. The complete button is only active when the review is due or overdue.
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Completing a Review cycle.

The Review Schedule property may be accessed without the need for the reviewers to have the password
for controlled files.

This feature allows the reviewers to enter the review completion information, and restart the review cycle
without the Process Owner needing to provide the Access password. The Complete Review function is
accessed via the Utilities menu.

Adding other Property Sheets.

To add additional Property items, click the NEW button. Type in the new property name in the Property
Name field, ensuring that the Property type is set to Text File, and click OK. The new Flow Chart Property
Dialog Box is shown below.

The Browse button enables you to select an Process Propert !
existing text file for inclusion in the Report Ete
Document. Property Type ITI
Text File -
I “"! Cancel |
TIP: Use the Browse button to include standard text like

disclaimers, warnings, copyright notices etc. Froperty Mame

fl
Property iz external Brawse.. |

All external text type properties are created and edited
by the Windows Notepad editor. I
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Settlng 4TQF|OW Preferences File Edit LUtilities Zoom 100 gl Help

4TQFlow has many options which you can set to m
. . . Wigw

either enhance its use, or produce certain output

features for your specific requirements. General 4
Beportz »
LColors 3

The Option Preferences menu item opens a dialog Fonts | box

containing four tabs allowing access to the options Customize. ..

grouped by function. Save Options
Load Options

The selections can be saved as your default settings WwordProcessor by

clicking the SAVE button. Once saved the settings
become your defaults for all new charts.

The LOAD button will recall your current default settings. The APPLY button will apply the current settings to
your current chart without altering your defaults.

View Preferences.

Show Grid

Displays a grid on the chart workspace.

Break on Words Preferences __E
Selected OFF will cause text to be broken | igw Germial | Fiepailing | Colors & Forlz |
within a word to save space (if spaceisa | _
premium). ™ Bhowiid F E | E
¥ Sk D Aoy |'-_E v |—E

¥ Ao Line Dras

Grcnp Lateel Stple [t -]
Colour Workspace I Broak o wWosds Lt ple | righi
Selected OFF will invoke a grey scale ¥ Color'Wokspace Gecup Bordes Sipe | =
instead of colour (useful for black/white and [ Show Tide Pags Gooup Boidee Sz [T E i
monochrome screens). e
b Shadoaed Fuguse: Shadow Size |1 =] P
Show Title Page | Aopk I Canc=l | Rme | Load |

Selected OFF will remove the Title Box
from the flowchart (title information will still be printed in the document).

Shadowed Figures

Selected ON will place a 3D shadow around each Figure.

Unit

The Unit shows the size of the Grid Units and is based on the current Figure Label text font. The Unit fields
are always disabled.

Scale

Controls the size of the figures based on the size of a grid unit. Used to make the size of the figures larger or
smaller.
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Group Label Style
Select justification (Left/Centre/Right) of the Groups Heading.

Group Border Style

Select a patterned or solid line for the Group’s Border.

Group Border Size

Select the thickness of the solid line border.

Shadow Size

Select the thickness of the 3D shadow.

General Preferences.

Guide Figure on New

Selected ON offers first How-To- W ol | ':““”‘F""""]

Instruction (for beginners). It is [ Gt Frgarw o new] o ol & I"_E ; I_E
automatically removed after creating S e S =
first Figure. ::::ZBW Stat k[ E 1 E E
I L o Sane

. Sered & [0 E,hs E
Make Backups ¥ Fiint Page Comes AustuS v Time [1 Eu'm
Selected ON creates a .BAK file on [ 30 Daslogs Zioom Stap [0 @ X
Exit. [ & ¥ PsRepodSpel [ AudoSpel

| I Cance| S Load

Auto Save Deny | |

Selected ON creates and periodically
File.

Colour Printing

Selected OFF invokes grey scale for non-colour printers.

Print Page Corners

Selected ON prints sequenced Page Numbers and Cut Lines to assist in the assembly of multi-page

flowcharts.

3D Dialogs

Selected OFF removes 3D effect for black/white and monochrome screens.

New Scale

Sets the size (width and height) of all Figures when a new file is created.

Start
Adjusts the starting position of the Start Figure. Used with the File New command.

the

File

Saves
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Scroll

Adjusts the scroll rate when using the Window Scroll Bars.

Auto Save Time

Sets the time interval for when the File is automatically Saved.

Zoom Step

Adjusts the step rate when using the Zoom Icons.

Preferences !
Reporting Preferences.
P g iew | General I Reporting  Colars & Fonts ;

Report Appendix
Mavigation IaII ""I

Adds consolidated information on process

workers, groupings, sub-processes and run- ¥ Repart Fig L abels I ExtraBlank Lines
to files to assist in process evaluation for [ Repart Fig. Types [ Report Fig. Coords
subsequent improvement. ¥ Report Fig Performers ¥ Report Fig. SubProcs
™ Report Text Figures ¥ Feport Fig.Checks
Report Figure Types ¥ Generate .wmf ¥ Repart Fig Dz
Indicates the type of each step within the ™ Generate xid Generate xid I vI

report. (Start, Tasks, Tests, etc)

Apply I Cancel | Save | Load |

Report Figure Labels

Includes the Figure Description and Techniques Label’s text in the generated report (as per the defined
headings).

Report Figure Performers

Performer information is included in the generated document.

Report Text Figures

Adds the additional process information you have provided.

Generate wmf

Generates a picture of your flowchart (Windows Meta File) ready for inclusion when using the 1SO9000,
Audit CheckList and Uncontrolled Word template layouts.

Generate XID

Generates a file containing the cross-reference synchronisation information for use by other applications.

Navigation

Adds directional "sign posting" text to the end of each Figure's Report text to speed up the reader’s access of
information. The included text directs the reader to the next logical step to be performed.

Refer to the Smart Navigation section on Page 37 for more information
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Extra Blank Lines

Places an additional carriage return (line feed) between each process step and section.

Report Figure Co-ords

Includes a relative Figure position (x,y co-ordinates) in the report document to aid location of the Figure
within the Chart diagram.

Report Sub Process

Adds the Process Summary from the Sub-Process file to the generated report.

Report Figure Checks

Includes the Assurance and General checks in the report.

Report Figure IDs

Includes the Figure ID number within the report to aid signposting.

Colours & Fonts Preferences.

Profevemces B
view | Geowd | Repong [Cokrsafoms

Clicking on any of the boxes shown on the | Fiu | | Tesd J |H,,:,,,J| l Pt | right
opens the Colour selection or Font
selection dialog. | | | Fape J |i ot | | Soit Winddow Font |
Make your selection and click the Apply [ e | B For- | e
button.
- IR 1o | 5o [ it Page font
| Giow || Ten | Bignd | | Group Font |

The left-hand side preview boxes show the

current colour selections.
| sy | cance | Save | Load |

The right hand side preview boxes show the current font setting.

If you are unhappy with the changes you have made, simply Click on Load to revert back to Default Settings.

If you want to save your changed settings as your Default settings, click on the Save button.
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MS Word templates.

The Word templates supplied with
4TQFlow provide support for Word 8
(MSOffice97), Word 9 (MSOffice 2000),
Word10 (MSOffice XP) and Word11
(MSOffice 2003).

When a Report is viewed, the report is
loaded into Word and a dialog box is
displayed (shown on the right).

You can choose one of four layouts.
Selecting a layout will change the list of
options available.

Your installation may have custom
Templates and the options and layout
names may vary from the defaults
shown.

You can save your settings for each
layout type, by clicking the Save button
before clicking the OK button.

aTgacro-
ﬁ ATF o R Diooumsnt Fomeathing Macm -
Trechahs AppeTeiies
Srfernatad = Tabks OF Conkents I+ Pt orivers
Aupdit Chesckiet M Process Chart [ Sroapings
Liresril s ;I ' Process Distal ¥ B Pies
[T Apgsranl Foem [ Sub Prisoesses
™ Rt Racap Oplera
F¥ Hnader (Focke: ¥ Extra Page fresks
[ Image Border
¥ Eage Bordar
[+ EmapTogsthe
™ Mulkipsgs Chst

iy

Copaight 5 EWS Py iLkd 1957-2002

G icencs bo Auian

Warion &.1.0

[+ Earoremmend Bl Oede
i Farss <A Tag

5m-r||ixlcm

Refer to the list on page 46 for an explanation of the use the optional macro actions.

Standard Layout Types.
Unformatted.

The macro exits and leaves the document in its raw generated state.

Standard.

The document has style formatting applied, Headers & Footers created and Table of Contents information

added. There is no actual specification for ISO9000 documentation format. The layout is offered for your use

as is, and provides a useful example of what your Word Processor can do automatically.

Audit Check List.

This layout is ideal for use as a “working paper” document and permanent record when performing process

Audits or Reviews.

Uncontrolled.

This layout is the same as the ISO9000 layout with the exception that the document is marked with the

warning “Un-Controlled Copy, Do Not Photocopy”.

Word 8 to 11 uses a set of four Templates. Release 6 of the 4TQToolkit Word Templates no longer support

MS Word 6 or 7.

MS Word Templates containing code are encrypted to protect them from virus attack. If you wish to make

alterations and require an open version of the macrocode, or wish a Custom Template (Macro) developed to

your specific layout, contact your 4TQ supplier or send an Email to support@4tqg.com.
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Standard Macro Options.

Table of Contents

Process chart

Process Detail

Approval Form
Return Receipt
Header/Footer

General Checks

Assurance Checks

Review History.

Review Detail

Compliance.

Performers
Groupings

Run Files

Sub Processes
Extra Page Breaks

Image Border

Page Border

Keep Together

Multi-page Chart

Recommend read
Only

Parse <A> Tag

4TQToolkit User Guide

if checked adds a table of contents to the start of the document. A TOC entry is
made for each property and figure in the 4TQFlow process map.

controls whether an image of the process map is include in the document.

If the document contains a Process Chart property the image is inserted after the
Process Chart heading in the document, otherwise the chart is inserted
immediately after the Process Detail property heading.

controls whether the Process Detail section is included in the document. The
Process Detail property contains the detailed figure information in the process
map.

if checked adds a document approval form to the document
if checked adds a return receipt to the end of the document.
controls if headers and footers are added to the document

if checked the values from the checkboxes on the General tab of the Figure Dialog
are included in the figure information.

if checked the values from the checkboxes on the Assurance tab of the Figure
Dialog are included in the figure information.

if checked will include summary information about all process reviews that have
been conducted otherwise only the next review date is displayed

includes detailed information about process reviews.

controls how compliance plan information is displayed in the document.
e ByPlan orders the output by Compliance Plan/Compliance Item/Figure.
e ByFigure orders the output Figure/Compliance Plan/Compliance Item

includes a list of performers

includes a list of groups

includes a list of run files associated with each figure

includes a list of sub processes

includes additional page breaks before and after the Process Detail section

draws a border around images in the document (Process Chart and ISO
Compliance properties)

draws a border around the page.

if selected marks each property and figure as keep together. This prevents
properties and figures being split across pages unless absolutely necessary.
includes an image of the chart split into pages as displayed in 4TQFlow

If selected the macro saves the formatted document with the “Recommend read
only” feature set. Refer to your Word documentation for details.

If Off the A tag is passed unaltered. If the flag is On the A tag is converted into a
word hyperlink.
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Word 8, Word 9, Word10 and Word11 (MSOffice97, Office 2000, Office XP,Office2003 ).
Four templates are supplied for use with each of Word 8 to Word 11.

The 4TQ.dot template is encrypted to protect against alteration by macro viruses and Anti-virus programs.
The 4TQ.dot template contains all of the macrocode, including the AutoOpen function.

The 4TQAudun.dot template is used in the same way as the 4TQ.dot, except that it does not offer the
Standard layout option and is restricted to the "Audit Check List" and "Un-Controlled Copy" layouts.

The 4TQFMT.dot template does not contain any macro code elements. It is not protected.

The page size, page layout, margin setting and styles are all set with this template and are applied to the
report document during the execution of the 4TQ.dot template macros.

4TQWDS8.DOT carries the Word 8 specific extensions and options that are valid only for Word8.

NB: Changing the 4TQ sample text will not change the style applied by the 4TQ.dot macros. You must
change the style in the
4TQFMT.dot file itself.

LT oo Dwor S04 T DOT

conksrs macros by

Aocian Ausiraba Pey Lid _ v |

This publisher has not besn sithenbicabed snd ersfore coild be
miksbed, Dot sk bhess credankisls)

Word 9, 10 and 11 Note: The
Word 9,10 and 11 versions of the
4TQ Templates contain an "Axion"
security certificate that you can
optionally accept as a trusted
source thereby by-passing the
"Enable Macros" prompt.

Macrins mary Contain viiuses. Tt 5 absays safe o disabis macnes, bot o
He mscros s legiimats, wou might lose some functicnalty,

The sscirity' bassnl s dmst b Hagh, Thersfors, you cefrot sretils
Padecr v T oo midur € Bl yeon oo et brust

Optional 4TQAdmin.ini settings.
The macros respond to the following custom settings in the 4TQAdmin.ini file.

[4tgmacro]
FileOpenRetry=10
MacroLogFile=
ACLReviewNumberFile=
UnformattedStyle=
1ISO9000Style=
AuditCheckListStyle=
UncontrolledStyle=

FileOpenRetry defines the number of seconds that the macro will keep trying to open the macrolog.csv.
Default is 10 seconds.

MacroLogFile is the full pathname to the file that the macro uses for tracking usage. The default is the
Records directory found in the 4TQ program directory.

The macro looks up the entry MacroLogFile in the 4TQFlow section of 4TQFlow.ini. If this does not exist, the
default name is macrolog.csv. The file format is Comma Separated Values (csv). The log file name should
use a short form (Dos8.3 filename) to support Word 6 users.
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ACLReviewNumberFile is the full pathname of the file for obtaining the next Audit CheckList review number
form. Default is the Records directory located under the 4TQ program directory.

UnformattedStyle
ISO9000Style
AuditCheckListStyle
UncontrolledStyle

Each layout type offered by the Macro can be set to use another Word Template instead of default
4TQFMT.dot for individual control of Styles, Paper size and other layout features.

For example if you wish to have the AuditCheckList layout in landscape and leave the other styles as portrait:
1. Open the 4TQFMT.dot in Word.
3. Change the paper orientation with Word's Page Setup - Paper Source dialog.
2. Save the 4TQFMT.dot as 4TQFMTL.dot
4. Add the following line(s) to their 4TQAdmin.ini file in the [4tgmacro] section.
[4tgmacro]
AuditCheckListStyle=4TQFMTL.dot

Altering the Styles, Page layout and Paper Size.

The 4TQFMT.dot template contains the 4TQStyles and AutoText (shown in sample text) that are applied by
the macros contained in the 4TQ.dot template.

Changing the sample text or the sample text font or other formatting attributes does not have any affect on
the report document. The style must be changed and saved in the template.

To change the format of a Style, or an aspect of the page layout follow, the steps below.

1. Make a back up copy of the 4TQFMT.DOT file before making any changes. (i.e. copy the file to
4TQFMT_ORG.DOT)

Run Microsoft Word.
Open the "Systempath"/4tg/macros/Word XX/4tgfmt.dot template. (see the note below)
Position the cursor on the style you wish to change.

From Word's Format menu select styles.

oo kw8 Db

Select the modify button and select the attribute type you wish to change (ie. Font, Paragraph
etc).

N

Make the desired changes and click OK with the Add to Template option checked.
Apply the Style changes.
Repeat for other styles in turn if needed.

10. Make any changes required to the Page Setup (Word's File Menu) (ie. Margins, Paper Source,
or orientation).

11. Save the template with the File Save or File SaveAs menu item. The FileSaveAs can be used to
create an altered copy of the 4TQFMT.dot under another name with different Styles and Page
layout properties as discussed in the Optional 4TQWFlow.ini settings section above.

Note: WordXX: - Substitute Word8 for Word 8 (MSOffice97), Word9 for Word2000, Word10 for Word XP
and Word11 for Word 2003.

4TQToolkit User Guide Page 48 of 131



4TQWebGen / MSWord Format tags.
The MS Word Templates Macros support the following format tags:

pathname
<PICTURE d:\MyPictures\Diagram.wmf).

On Off MS Word Action 4TQWebGen Action
<B>... </B> bold Bold
<U>... </U> underline Underline
<|>... </I> italic Italics
<S style>... style Converted to remark
<F font>... </F> font font
<FS size>... </FS> | font size Converted to remark
<FC color>. </FC> | font colour (color) (color = integer 0 to 16) Converted to remark
x is the colour number. Don’t place a space
between the FC and the number.
<NL> </NL> | numbered list Converted to remark
<BL> bullet list (insert on each line to be bulleted ) | Converted to remark
<IN> indent
<PB> Page Break
<LP> Left paragraph
<RP> Right paragraph
<CP> Centre paragraph
<PICTURE Inserts filename into document as a Picture. Translated to HTML form,
filename> The filename must be a fully qualified embedded picture. Warning the

browser must be able to support
the picture format. No checking is
performed

<FILE filename>

Inserts filename into document as an

included file.

The filename must be a fully qualified

pathname

<FILE d:\MyPictures\Diagram.doc).

Translated to HTML form as an
Hyperlink reference.

<A HREF=URL>

HyperlinkText</A>

Converted to Word Hyperlink

Passed as native HTML
(Hyperlink)

4TQToolkit User Guide
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Other Notes.

1. The Audit Checklist layout is slightly different to the R4/5 version. It creates the Review Memo as the first
page of the document followed by a section break. Page numbering and headers/footers start on the
page after the Review Memao.

2. The macrolog.csv file records the username shown in the Options - Customize Dialog.

Extra page breaks option puts page breaks around inserted WMF’s and the Process Detail property.
Without extra page breaks the macro uses Words paragraph handling to keep the content of a property
on one page. This means that a chart may appear on the same page as another property if it fits.

4. |If you are using Word 8 or above, a document map is generated. Use View/Document Map to display it.

MS Word Template Networks Notes.

Users require read/Write/create permission to the 4TQ /records directory.

Changing the Word Templates Selection List.

Select the 4TQFlow Option Menu item, and then from st Fps - " i
the Sub Menu select the Word Processor option. e s E:hi“ o
L]

Sovalahls Fomals Ir Q
The Dialog box shown right will appear. Ensure that Tast ) Diescruarvind E iz
Word 2.0 format is highlighted as shown. Z:jfg'“"f- [T —
Note Word 2 format is used for Word version 2, 6, 7, 8 \wiped Prerlect 5.1 i J |
(Office97), Word9 (Office2000), Word10 (OfficeXP) and ot Docxcuammprd Tampletn S irkuchaei
Word11 (Office2003). [ 'wicackd (DrFces) |
Only Word versions 8, 9,10 and 11 are supported by the Sal Dafindl Fosinat | Add | Rty |
R6 version of the 4TQToolkit template macros.
Changing your default Template Welpacskcumnp uiglechis ol

changar mads here onip sifeci lemplate &<l alls
Select the desired template from the Document T 48t Far deladl “Fleper Terplais™ i Fa

ATCFlosm Templsls shached I rod Ltz

Template / Stylesheet list box (Lower Right), then Click
the Apply button.

Adding a new Template

To add a new Word Template to the Generate list Click on the "Document Template/Stylesheet" ADD Button.
(Lower Right)

Document Template

The Dialog box shown right will open. Clear

the current name field by over typing in the
field. ['words (Dfficed7]

M arme Ok,

Cancel

You should "name" your new template in a Path

meaningful way. Search

C:5AT Dsmacroshword3 4 T0.0OT

Pk

Browze
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Next, click in the Path field and change the field to the exact file name of the template. Full path names are
supported.

The default file-pathnames for macro supplied with 4TQFlow are in the form
"Drive:\4TQ\Macros\WordProcessTypeVersiondTQ.dot". The default values for
"WordProcessTypeVersion" are Word8 (for MS Word 8 -Office97), Word9 (MS Word2000), Word10 (MS
WordXP), Word11 (MS Word 2003) and WP678 for WordPerfect (versions 6,7, & 8).

If the template file (.dot) is installed in your Word Processor's Template Path directory only the file name and
extension is required.

Click on the OK button to close the Document Template Dialog Box.

Click on the "Set Default Button" (lower left) in the Main Dialog Box then click on the "Apply" Button.

If you are using a computer on a network please consult your network administrator for assistance, as you
may not have the correct permission level to save a file in the required directory.
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Converting Documents with 4TQScribe

4TQScribe is designed to help you create 4TQFlow process maps quickly and accurately. 4TQScribe
automatically builds your 4TQFlow process map from the text selected in your existing documents.

If you already have process information stored in documents then
4TQScribe allows you to convert the documents into a 4TQFlow
process map with minimal typing. All you need to do is to open your
existing document, start 4TQScribe and drag the relevant information
from your existing document into 4TQScribe.

Launching 4TQScribe

To start 4TQScribe you first need to start 4TQFlow. Once 4TQFlow has
started select 4TQScribe on the Utilities menu in 4TQFlow as shown
right.

4TQScribe will clear 4TQFlow's Workspace and perform a File New
operation. If you wish to add information to an existing Process file,
open the file after 4TQScribe runs.

Closing 4TQScribe will also clear the 4TQFlow Workspace.

4TQScribe has three modes of operation.

4710 Scribe

Elll..lth- Jurditled] LWl US amples

Eia Edt | Liies ZoomB2 OpSons  Help

2 &

Locsls

o

By Mty
|l figure chargey
Aeset changed Fdaaton

W sty B
Tood B
v Mieru Bar

ATk,
ATOCasch
ATOE spkme

S

I ]

Chbk
Chi+
CarieLl

[ Scribe

|

Brainstarm

I

Drop Zone

L4

]

Each mode is selected and indicated by a tab at the top of the 4TQScribe window.

Scribe Mode is useful when the source document is not that well structured and you need to perform editing

as to proceed.

Brainstorm Mode is useful when you wish to extract the key steps from a text source without using the text

itself.

Drop Zone Mode is used when the source material is well structured, and contains most of the information

required intact without the necessity for major editing.

To select a mode click on the appropriate tab. A description of the functionality of each mode follows.
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470 Sois M= I

Scribe Mode s | mwwr | i
e oo |l
“Scribe” provides a quick figure by figure creation approach. Use this [ ek I Fempiiafom
mode when converting text based documents into 4TQFlow Process Laba
maps.
B
Setting up
With both 4TQFlow and 4TQScribe running, open the source text
document in your Word-Processor. Maximise the 4TQFlow Window. Tt m
Create (if required) a new Process map by completing the Title Page
properties and saving the file. Click the 4TQFlow button (Windows
Task Manager) to minimise the 4TQFlow window. e i -
Position the source document and 4TQScribe’s Windows so that both r . ;:.. " Led
are visible on your screen. 4TQScribe on the left and the document on

the right are likely to be the best positioning. Click on the "Keep On
Top" option to prevent the source document covering the 4TQScribe window.

How to

Read through the source document and copy the parts you wish to add to your new process map. Paste the
selected text into the 4TQScribe field (Label, Description or Techniques) as required. You can add additional
text by typing directly into the 4TQScribe fields.

Check that the figure type is correct for your new step. 4TQScribe defaults to the task figure type unless you
change the Figure Type selection at the bottom of the 4TQScribe window. Ending the Label text field with a
question mark (?) will automatically set the Figure type to “Test”.

Click the Apply button when you are ready to create the figure and clear the 4TQScribe fields ready for the
next figure. The Apply button will not become active until the label field contains text.

Continue this process until you have transferred all of the information from the source document into your
new 4TQFlow process map.

Click on the Task Manager’s 4TQFlow button at any time to check your progress and remember to save your
work frequently if you haven't engaged the AutoSave option.

When you have finished extracting text from the source document, return to the 4TQFlow Window to review
and change the layout and information as required. Remember to add the performer information for each of
your steps. The Utilities menu's BugHunter command will locate most problems or omissions for you.

Instead of creating a new chart you can add more process steps to an existing map. Open the required
Process map in 4TQFlow. Position the “Auto-Line Draw” focus from where you wish to add the additional
steps. You may have to delete an existing flow line to do this. Now operate 4TQScribe in the same manner
as for a new map.

Option Settings
AutoSave

The AutoSave option forces 4TQFlow to save the process map with each "Applied" action. If the Process
map is Controlled the changes are stored as "Work-In-Process" changes. Remember to manually save the
4TQFlow Process Map by using either of the Update options to publish the changes made.

Auto Line Draw

If you do not want 4TQFIlow to automatically create the flow lines for you, turn the “Auto LineDraw”
checkmark off (upper left of the 4TQScribe window).

Keep On Top

This option forces the 4TQScribe window to remain visible when you switch to your source document
window.
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Brainstorm Mode [ Sme | esemerm | oo i

.
“Brainstorm” accepts Label based line by line entry to create an entire flow P At i Sppy
process as defined in a keyed-in script. Use this mode when [ Aaie Sy
“brainstorming” a new process map. Tae | LA |
-V SECII Yar PATH CASK LABEL
How to 2] o P TAdE Labe

E0TmD Fe PATH Teir LASELTRER | LESEL

Each line in the Brainstorm window represents a potential Figure (process
Step).

With both 4TQFlow and 4TQScribe running, create and save a new
process file, or select an existing one that you wish to modify. Remember
to complete the Title Page information if you are creating a new process
file.

u ]
Select the Brainstorm tab in the 4TQScribe window and enter the script

line as needed.
To create a task figure enter the label field information and press enter. Keep entering task labels as needed.
To create a test figure place a question mark (?) at the end of the label’s text and press enter.

The new line under the Test will display a "Yes" prompt (shown as “Y->") to indicate that information entered
on this line will be added to the Yes response path from the test question above it.

Adding further tasks will continue the Yes path until you Backspace over the Yes prompt. Once the Yes
prompt has been removed from the new line all of the tasks from that point on will be added to the flow line
starting from the question’s (Test) "No" response node. The Yes path will be terminated automatically with a
Finish figure.

It is easier to create complex decision trees in 4TQFlow. However, you can enter sections of the process in
script groups, building up the entire process in manageable segments of figures. Remember to set the
location of the Auto Linedraw focus point in the 4TQFlow o

window when adding more steps to your map.

Start chart

To create or add the scripted figures to your chart click the
Apply button when you are ready. The script is cleared
when the figures have been added to the map. TASK 1 LABEL

1

The script shown in the Brainstorm window (upper right)

3 5 [

will create the process map shown on the immediate right.

Complete the process map by assigning the performers

FIRST "Yes" SECOND "Yes"
PATH TASK — PATH TASK
LABEL LABEL

and entering the other detailed information using
4TQFlow.

The 4TQFlow Undo / Redo function records each line of
the script as a separate change and can be used to L1
progressively wind back the script one line at a time.

FIRST "No" PATH

TASK LABEL

SECOND "No™
PATH TASK
LABEL

Option Settings .

AutoSave

The AutoSave option, forces 4TQFlow to save the

process map with each "Applied" action. If the Process map is Controlled the changes are stored as "Work-

In-Process" changes. Remember to manually save the 4TQFlow Process Map by using either of the Update
options to publish the changes made.

Auto Line Draw

If you do not want 4TQFlow to automatically create the flow lines for you, turn the “Auto LineDraw”
checkmark off (upper left of the 4TQScribe window).
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Drop Zone Mode
AT0 Fcale =

The “Drop Zone” tab accepts and optionally translates (parse) . selected
text directly from a compliant program (like MSWord) and [ St | oo | ewydene
automatically creates and fills in process map figures. Use i Eptmickal  F Triss when
converting existing text based procedural information into oA Lew F iapiia fom

4TQFlow process maps. As you read through the text material | L you can
select portions of the text and Drag and Drop them into the Drop
Zone Tab. i

Setting up

Run 4TQFlow, 4TQScribe and the application that will provide e the
source text (like MSWord).

Arrange the 4TQScribe window and the source Window so Figes Tipe that it is
easy to read and select the source text and have access to i ey ~ Ermh the
4TQScribe Drop Zone window. 4TQFlow does not needtobe - = ~ Gnies £ 41 visible
when using 4TQScribe.

If your screen size and resolution make it difficult to arrange the Source window and 4TQScribe for easy
Drag and Drop access, run the source in its maximised state. Perform each operation by dragging the text
onto the 4TQScribe button on your task bar. Wait until the 4TQScribe window appears then continue the
drag operation by releasing the text into the window.

How To

Select the required text by clicking and holding the left mouse button. The selected text will be highlighted.
Release the left mouse button and place the cursor within the selected area, then click and hold again to pick
up the text and move (drag) the cursor to the label field in the 4TQScribe Drop zone window. Release the left
button when the mouse cursor indicates you can drop the text by displaying the "Drag" cursor.

Option Settings
Confirm Actions

If you need to alter or add information prior to saving the information, select this option. This forces you to
click the Apply button before the information is transferred to 4TQFlow.

Translate

When on, 4TQScribe will check the text structure for a paragraph heading or suitable short sentence to
become the Figures label and move the rest of the text into the description field.

AutoSave

The AutoSave option, forces 4TQFlow to save the process map with each "Applied" action. If the Process
map is Controlled the changes are stored as "Work-In-Process" changes. Remember to manually save the
4TQFlow Process Map by using either of the Update options to publish the changes made.

Auto Line Draw

If you do not want 4TQFlow to automatically create the flow lines for you, turn the “Auto LineDraw”
checkmark off (upper left of the 4TQScribe window).

Keep On Top

This option forces the 4TQScribe window to remain visible when you switch to your source document
window.
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Managing your System.

4TQExplorer has two display modes. Navigate mode only displays the left-hand tree Framework while
Explore mode that displays both the Procedure list tree and the tabbed Details List. To toggle between
modes click on the Explore or Navigate Buttons. (Note: If you can't access the Explore mode your 4TQ
Administrator may have locked your 4TQExplorer into Navigate Mode).

Navigate or Tree Control.

The Navigate window pane or Framework tree shows the structure of your system. By selecting an item
within the tree you have access to the associated information about that item. The Right Click context menu
gives direct access to the five Associated reference file links, the link URL address (Web-Link), the
Measurements (KPI or Cl information) and any RunFile links if the item is a Process map. Double clicking an

item will cause that item to open. lﬁ Edt Procedures Updates
Loading a Framework File. gzgn /
When you open at Framework you can have 4TQExplorer check the Sawve i
stored Framework information against the current state of the linked Save As :
items. To enable this on-load checking to occur ensure that the [
“Check Procedures on Open” item is ticked on the File Menu. If you Check Procedures On Ope are
performing the role of the Framework administrator you should have i this
option checked. Changed or missing files will be notified to you after fint the
On-Load check is complete by special icons and by a message box if AXION Systems 9 the
check reveals any changes.

Properties. ..

Exxit

Tree Item Display options.

The Explore Tree normally displays the Title Fie Edit | Proced TE—— of 3
process map (4TQFlow File). You can also  — o oceaes

have the tree display the File location or

Document Reference number field. Use the
Procedure -> Display Format menu item to on-Load Level. .
select the display type.

Expand Level r
Max Load ko First Procedure

Display Format k=T

Diocument Referenge
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Explore Mode Controls.

The Explore window list content (the right-hand side) is controlled by selecting one of the available Tabs. The
default Tab is the Details list. The number of tabs available will vary depending on the configuration of your

specific 4TQ
installation. B 4 1o - W TP A TS et b e
Ge DN Bosiaes s bt Lt e

. . | DFH & SBBEX Fod 5S4 8T E S&|FE

Details List. -
. . i Prstiwm i Ol e gd Lemb 300 Betwrin it ' Mgraprng "wn d7D Bppige!
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information displayed — [FEsssim=s = S e

in the columns is
controlled by the setting in the “Customise Details View” dialog (shown below) and is accessed by the
Customise button (Explore window pane, middle bottom).

Button Controls

The Buttons shown on the bottom of each Tab list may change, dependent on the type of list selected.

Duplicates Button.

This option controls whether procedures (sub-processes), which are called more than once, are to be
displayed only once or for each occurrence. Unless the number of appearances is particularly distracting, it is
suggested that you leave the display to show all appearances. This allows you to double click on any of the
listed entries to highlight its location in the Procedure List (left-hand window), to identify the parent.

You may change your view to either show or hide duplicates without having to update or re-insert

Procedures.
ostanmseistabives O]

Customize button. Crates o

r T Pessis
Click this button to access the Customize Dialog Box. The FHEB_ - M[ ::;_H
Customize dialog box allows you to select which attributes are B b
displayed in the list. Fie = [rianced Ve
To display Policy and Form information on the Details List, E:;""“‘ B [oesied

select the Policy and Forms option. If the first column header
button is pressed, any Forms displayed in the list are sorted to Hedin F FaA Poliy
the bottom of the list. : :

| o 1 Caresl b

4TQExplorer will remember your layout, and will restore the
Custom View set up when the application is re-started.

Columns may be re-arranged by dragging and dropping the column header buttons.

Sorting the Lists with List Column Buttons.

The Navigate Window lists can be sorted on any of the displayed column items. To sort, based on a
particular column, click on the column’s label button. Clicking a second time reverses the sort order.

Right Clicking on a Procedure in the Details List will display a pop-up menu for that Procedure.
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Owner Button.

Click this button to set the Process Owner's filter to restrict the list item to only Procedure owned by that
Person / Position.

Performer Button.

The list of Performers must be compiled after a 4TQExplorer file is opened. The process of compiling the full
Performers List may, depending on the number of Procedures to scan, take some time. Selecting a
Performer from the menu list will automatically filter the Details List, and place the Performer’s name at the
bottom of the application in place of ‘No Filter’.

Updating the Procedures List.

4TQExplorer stores the structural details of the framework as individual records. You and other users may be
adding or removing Sub-Processes from Procedures contained in the framework and the structure below the
parent process will need to be updated to reflect the changes made. If the Check Procedure on Load
function is enabled (File Menu), 4TQExplorer will display a message advising you when a change has
occurred. This message indicated that you should perform an update and save the file.

4TQExplorer allows you to update records at three levels.
1. You can update Procedures in the entire 4TQExplorer file at once:
Select All from the main menu’s Updates item.
2. You can update all of the labels within a particular Category or Sub-category:

Place the mouse pointer on Category to be updated then select the category name from the Main
Menu Updates item.

or

Place the mouse pointer on Category and press the right button and select the Update Category
item

3. You can update particular Procedures:

Place the mouse pointer on a Procedure and press the right button and select the Update Procedure
item.

Whichever level of update you choose, all file associations are preserved however the hierarchy layout within
a Category will be into ordered groups of Policy documents, Forms and Procedures.

Due to changes in the 4TQFlow files, don’t be surprised to find Procedures inserted or removed.
Note 1: These options are not available when 4TQEXxplorer is in Read Only mode.

Note 2: The Max On-Load Depth setting may affect the Update by limiting its scanned depth range. Do not
save a file that has not been scanned to a level that includes all the parent procedures.
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Tools Menu

ATQFlow Link (DDE). | Tools  Help
This menu is used to control the | 4TFlawe Link (DDE) 3 r'-.RF'.I:tin:nn on 4T 3Flow Changes [
behaviour of 4TQExplorer and e Redistribut Wsrn Only on 4TOFlaw Changes
ATQFlow when they are running on v Pzdistribution Copy Update All on 4TQFlow Changes
the PC at the same time. Find in Procedures. .. Update Branch Only on Changes
4TOFlow (4TQReader) 4TOFlow bo Track 4TQExplarer Selection
4T Coach 4TQExplorer ko Track 4T QFlow File Open
4TCLink (4TOPiat)
4T ERGER

Expmrt bo Excel

Make Redistribution Copy

4TQExplorer files cannot be successfully moved from one file system / location to another. The “Make
Redistribution Copy” feature creates a special copy of the current 4TQExplorer file that can be relocated
along with the referenced process map, form and Policy documents without the need to re-build the
frameworks. The created copy can be found in the “REDIST” folder contained in the SystemPath.

Find in Procedures

The Find in Procedures dialog (shown
right) enables you to perform text-based

Fund Procedisre conkamg bext

searches in the selected Procedure Smorciy 'lmp"“' = F“"“I_ { |

List's branch (Navigate window). : . |
( g ) ﬁ F 1 F 5l

The dialog is available from the Tools

menu. T b Raaia

Enter the text to be located in the Text Tind easich o cams sensing Closz:

field. Note that searching is case Q

sensitive. Pincadun ! ?ll“l'-ﬂ )

Then select the fields types within each
Procedure to be checked. You may
select any/all Title Page and Figure
fields listed. Searching Figures can take ) e Dk - Bk Procadine: b opset
some time, dependant on the number
and size of Procedures to check.

Once your criteria fields are set, press the Find Now button. You can stop the search at any time by pressing
the Stop button.

The list displays the name of any Procedure having matched the search text, and the location (Title Page or
Figure) of the matching text, plus, where the location indicated is in a Figure, the Figure ID. Note that the
location given is for the First found location only; there may be other locations within the Procedure that
match the search text.

Double clicking on listed procedure will run 4TQFlow with that Process displayed.

Press New Search to clear all fields.
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Framework Snap shots - Export to Excel

The Export to Excel report feature creates a multi sheet Microsoft Excel Workbook detailing the contents of
the current 4TQExplorer framework. These snap-shot reports may be useful when preparing for a system
Audit (working papers) or instances when you require a permanent record of the state of your system at a
specific time.

The options listed on the dialog M

(right) are all available for inclusion in Select ilems Io st
the Workbook. Selec_tlng some items I Procsduse List [o lbome]
may cause other options to become

unavailable. Exploia Tabe o deplaped on scisen]
After selecting the items you want to ™ Deatals List ™ R Fapoi
have included Click the Export LEEER T EREH
Button. You will need to waﬁt for the r :u:mmL; W H_"
report to be initiated, Microsoft Excel ™ Fun i I Gereal Maris
to run and build the report contents.
— Compliance Tab
Clanspec: Lisl dewns Compharss L bevis:
r I Addbecsad Dlausas Lt
™ Al Plans: jone shesi| r '
™ Plan jper shesi| ™ Plans Addressed Clares Mabis [one dhest]

[ Plan fuddiessed Clases Matix [per sheel)

Wt Canos]
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ATQExplorer Toolbar Buttons

Restricting list Contents

The Toolbar has three buttons to control the content of the Explore Mode lists. The buttons = E E |
are shown on the right.

The first button will limit the list to only show the details of the currently selected procedure in the Procedure
list (Navigate or Left-Hand window).

The Second Button will limit the list to all procedures below the Procedure selected in the Procedure List.

The third button shows the details for both the selected Procedure and all of its children.

Tracking Selection Changes in 4TQFlow. = &

The first of the 4TQFlow Tracking Buttons cause 4TQFlow to open files in synchronisation with the
procedure selected in the Navigate (Procedure list windows). To turn this form of tracking on, click to depress
the Button.

The Second form of tracking causes 4TQExplorer to relocate the current procedure selection based on the
process opened in 4TQFlow.

These options are also available on the Tools menu (4TQFlow Link (DDE) menu.

Tip Information Bubble T E

The two buttons turn on and off the Bubble information for the item under your mouse
cursor. The first button controls the feature in the Procedure list window and the second button controls it for
the Navigate Window.
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Showing Next Review Dates.

The Review Schedule is a Title Page Property set
through 4TQFlow R5/6 for each process map. (Refer to
page 38).

To display the Review icons preceding each Procedure
name, ensure that the Review Dates information item
has been selected in the Customize Button dialog.
When this option is not selected, the icons revert to
normal.

If you have included the Review Date the date displayed

Daimdi Lot * Sandgeng Vaui-ST0 5ptam

= i}

| B T ey ey pme——

T oanpletng Pracsst eesw

Craatmg & Stardardosd [o
Doroingorral ' bibin v
Coammarnand £ Prows;
Irshstrg & Lommysled Lo
Irshatwg Tha Peorwris Ry
Wl aepre] Progests Alesviess
Feararraeg | rdkrrusiean 5 g
S akrgy Up AT (0 F ks’ Praz

Ligrd st Ving | i paditnan

Ml B

Mot S
Pt St

Pk G

[
Mat St

Ko B ¢
Pt Gl

Fat S
My E@

Mok Geml ¢

Al

A

(ALt ]
L L BT |
105
ATl
G
i
Tl
105w
A1
TG
105wl

110
1

1.0
1.0
10
1.0

i

1
1
i
1.0
1

ki | ity

|ﬁul
Padurini 0 Ble

shows when each Procedure is due for Review. The colours of the Procedure icon are used as a visual

indicator of impending Review dates. The full Icon Legend is available

from the Help menu.

e Blue indicates no Review date set — ‘Next Review’ is “Not Set”
e Green indicates that the Review date has been reached but is less

than 28 days due

¢ Red indicates that the Review date has been exceeded by more than

28 days

¢ No colour (white background) indicates that the Review date has not

been reached.

24 Month Review Schedule Tab.

To show the 24 Months Review Schedule, select

TR - I B - T

Hest Pl due Flow
Fravitis [iate eacetidad by 78 daps
Fearwma [latm ol 1mi

Frzcedus Hol Fourd Lipdsts
Fiagund|

Proxsdug Ve son Clanged Llodale
A

[ ]

st Pl Cigte et rached

Review Tab in the Navigate window.

The table displays all the Procedure Reviews in 24

Azsociated Procedurels

JUME | JuLy | aUG.. | SEPT.. =

anaging Pro

monthly columns.

The first column is that of the current month.

S — denotes the month in which a Procedures
Review is scheduled.

n Develaping aur Inf...

n Completing Process ..
n Initiating The Proces..

n Conducting Process. .
n [mitiating & Controlle. .

1

o

D — indicates that the Procedure is either Due or Overdue.

Both Due and Overdue indicators will always appear in the first (current month) column.

To see which Procedure Reviews are scheduled for a particular month, press the column-heading button.

The list is sorted, based on the Review Scheduling. Note that Reviews not scheduled for the month selected

are not sorted into any particular order.
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The Assurance Matrix Tab

Lists the Sub-procedures for the current

Aasociated Procedurelz] |1 |2 [3 [4 [5 [ [7 [2 =

Managing rour 4T0 ...

selected Procedures and, for each Procedure, n Completing Frocess ...

ggg?glslg:(tje.s and flags the Assurance criteria n Conducting Process ..
This tab is to provide Legacy support for n Creating A Standardis...

1ISO9001/2/3:1994 standard.

An “X” indicates the procedure that is directly
mapped to an Assurance element.

A “+” indicates that the element is mapped
within a Sub-Process of the procedure.

n [ ritiating

1 —

The displayed information is stored in the 4TQExplorer file when the particular Procedure was originally

n Dreveloping vour nfar...
n Document & Process

A Controlled ..

+

o

added or updated. It may therefore be out of date. When you first select the Assurance Matrix view, you will

be asked if you require the data to be updated. If so, then each Procedure file is interrogated to provide

current information (Assurance information updated only).
This updating of information can be done at any time by using the Update Assurance Matrix option.

The General Matrix Tab

Lists the Sub-procedures for the

current selected Procedure and

8 Spoiam W anagement

displays the General cross checks for m :

all of the process steps in each
Procedure.

directly mapped to a crosscheck item.

é = ertoornirg Indomeatcs
e Setting Lip 4T 0Py
#l M ariprey Piocer: Hi
.

pdatng Vo Informal

An “X” indicates the procedure that is z Cazstng & Stanclasdine

A “+” indicates that the crosscheck is

Asyocisied Fincntaslt] | Salwy | Erveonsenisl | Complsnes | Shalsge | CheckPonl | Changs |

Fillam Dt Pl Fillust

Fafaimai Ma Filas

mapped within a Sub-Process of the procedure.

The Performers Tab.

The Performers tab displays
each step within the selected
procedure. The figure ID
number and the Performer are
also listed.

To sort the list based on the
Performer or ID numbers click
on the column’s heading button.

Clicking a second time reverses
the sort order.

The list filtering options are a useful way of constraining the list, so that you may concentrate on a single

n Creating & Standardize. ..
n Creating & Standardize. ..
n Creating & Standardize...
n Creating & Standardize. .
n Creating & Standardize. ..

Filters Cwwner: Mo Filter

Ferformer: Mo Filter

[003] Setting Up 4TQFlow's. .
[004] lgnore Systern & Archi...

[005] Set Uszer Dptionz
[00E] Set Utiliky Options
[007] Set Headings

Azzociated Procedure(s] | [ID] T ask/Test | Perfarmer
Creating & Standardize...  [001] Open Cugtomize Dialo...  Management
n Creating & Standardize...  [002] Do You wWant Docum...  Management

Syztem Adminiztre
b anagement
b anagement
M anagement

b anagement

performer or Process Owner. (Refer to page 58 for information on applying filters)
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Compliance Tab

The Compliance tab window uses two tree list boxes to display the linkage of System Clauses and 4TQFlow
Process maps. The Systems (1ISO9001:2000, ISO14000, etc) shown will vary dependent on the configuration
of your 4TQ installation.
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to set the start point of list to be displayed.

In the Clause list box (navigate window, middle) select the Plan or System and Clause required. Click on the
boxed Plus (+) symbols to expand the branches of the tree as needed. The Compliance List (right hand side)
will display the Procedures that have the selected System or Clause and are contained within the part of the

Procedure list selected.

Refer to page 32 for details on adding the Compliance Issues Property to your 4TQFlow Process maps.

4TQToolkit User Guide Page 64 of 131



Checking Parent & Child Procedures & Run Files.

When modifications are made to either a specific procedure or to a Run File, it is useful to know the affect
the modification may have on related procedures.

Place the mouse pointer on a particular Selected & Associated Procedures | Last Modify |
Procedure in the Details List window (right pane), -@ Dieveloping Your Information Managern. .. 1101995
a.nd press the rl_ght mouse button. The menu -é- Performing Information Syskern Inkeqri... 171041995
displays Run Files (only enabled where the

selected procedure has Run Files in place) & -é- Setting Up 4TQFlow's Process Guardian 1j10/1993
Linked Checks. -@- Managing Process Reviews 1/10/1993

. . I . pabiecl b diega baLiment Te. .. 1071995
The Run Files option will display a list of all Run Performer List et e =il

Files linked to the selected procedure. Selecting a -@- Ul pocess Summary anageme. .. 1/10{1995
listed Run File menu item will activate the Run ,@, U es Prope. .. Mot St

File. The Run File menu option is also available to R File

Procedures in the (left pane) Procedures window. Linked Checks W
hild Items

Linked Checks displays further menu options ,

which all, on selectign,ydisplay a Linked pChecks R e Check

dialog. Note that disabled items indicate no ‘linkage’ of that particular type exists for the selected Procedure.

e Parent Items - displays a list of all Procedures from the Procedure List that have the selected Procedure
as a child.

e Child Items — displays all of the child Procedures of the selected Procedure.

¢ Run File Check — displays a menu showing all the RunFiles used by the selected Procedure. Selecting
a particular Run File from the menu lists all the Procedures from the Procedure List that use the selected
Run File. This option is also available for Procedures in the Procedure window.

You can now check relevant items one at a time, to ensure that the affect of a modification has been fully
investigated.

Select an item in the Linked Checks dialog and press Check.

The (left pane) Procedure list selects the referenced item, and a check symbol appears alongside the item in
the Linked Checks dialog, to indicate that the linkage has been sighted.

The Linked Checks dialog is modeless, and it will remain visible until you press Close. This enables you to
use 4TQExplorer to further investigate modifications without having to re-start the investigation. Starting a
second Linked Check session while the Linked Check dialog is open from a previous check will cause the
original dialog to close.

Note that this is a volatile checking system. No record of checking is kept internally after closing the dialog.
More permanent recording can be obtained by

: ; " - S B 110N gk i limicmie ________H]|
using the Print facility on the dialog.  AFA Tl Ty —
The Run File Check feature is also available from el [ e— | the
left-hand window. Right Click on a listed &=
procedure and select the Run File Check option. o o The

Run button is only enabled where a Run File is
selected during a Run File Check. Pressing Run
start the relevant Run File application.

will
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Indication of Version changes to Procedure files.
If, while opening a 4TQExplorer file, a change in a Procedure Version is detected, a momentary message is

displayed and, if the Custom View Version information has been selected, a % icon is displayed adjacent to
the Procedure, in the Details List only. Note that removing Version information from the Details List returns
icons to normal. Detection of Version change will also over-ride the restoration of the previous Details List
information view, to display Document information — Reference, Version and Control status.

Indication of "Work in Progress"” to Procedure files.
If, while opening a 4TQExplorer file, a "Work In Progress" status is detected for a Procedure file, a special
F icon will be displayed in place of the standard icon.

Saving Process files using the 4TQ guardian features, including "Work-In-Progress" is explained on page 35.

Indication of missing Procedure files.
Where the file open check fails to locate any date information, the existence of the Procedure file is tested. If

the test fails to find a Procedure file, an g icon is displayed adjacent to the Procedure in both the
Procedures, and Details List. Date fields, if displayed, show No File. A momentary message is also
displayed, after loading the file, advising that an Update of the file may be required. This sequence will also
over-ride the restoration of the previous Details List information view, to display— Process Owner and
Modification Date.
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Distribution of Process information.

On-Line process guidance with 4TQCoach

4TQCoach provides a safe, effective and easy means of distribution for your process information within your
organisation. 4TQCoach is a simple way to supply your people with the most up-to-the-minute approved
versions of your procedures on-line. Everyone will be able to safely access the latest procedures as needed.

The "On-Top" feature and small display window size means that 4TQCoach can be used as a step by step
training aid for data entry staff.

4TQCoach can be launched from 4TQEXxplorer to provide easy navigation to required procedures and related
information.

Run 4TQCoach.

Launch 4TQCoach from 4TQExplorer, 4TQFlow, or from the Start Program Menu. When running 4TQCoach
from 4TQFlow the current process file is automatically loaded. When running 4TQCoach from 4TQExplorer
the selected process file is loaded.

e Run 4TQExplorer and open a Framework file. = g Hanageg o 410 Epten
. . 21| Puzisas Dogumerd sl
e Click on a Procedure Label to select it (Tree 'T- -
View Window). = Caneiy maﬁm ol
e Right-click on the label to display the context - B gk
menu and select Tools — 4TQCoach as H LF""“ "i.?:;'-::-mmum
shown on the right. n g m

- - rabwtngp & |

Gpding 3y
H Loz SIPTIE]S
o, W diDFowheat |
When a Procedure is selected in the 4TQExplorer B Froces: Pertrery  Frepods "
Tree View Window you can also launch S (B Frocasy Fee | PRpiEd

4TQCoach from the 4TQExplorer Toolbar.

[E]using 4TQCoach - 4TI =] ]

File Figure Yiew Help

e Click on the File menu item @Ewﬂ detsl B

e Click on the Open menu item
Select the 4TQ Process file required from the File ﬂ

open dialog box. The sample files supplied with
4TQCoach are located in the 4tg/samples/4tgflow

directory. You will need to select the sample and Open a Process File fram the
4TQFlow directory in turn to locate them. To try out ’ File-Open Menu Herm.

4TQCoach, select the UseCoach.flw process file by

clicking on the file-name. The UseCoach procedure ﬂ

will step you through the features and use of
4TQCoach. Click the Open button.

To load a procedure directly into 4TQCoach:
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The 4TQCoach window will load the UseCoach process. The Start 4TQCoach is the first and therefore the
current step. It will be highlighted. The next step in the process is shown below the current step.

Click the Go Forward '* Button.

Clicking the NEXT button will move you forward through the process steps, one step at a time.

Click the Go Back 4 Button.

The BACK button moves you backward through the process on the exact path you followed.

Displaying the Detail text. ] using 4TQCeack - 4TQCoach : =101 x|
Click the ~®=__¥ Bytton. The A0 rd el a Parfirmed By

Detail Button expands the S D dadd § Cefinition

4TQCoach window and displays 4 ATQCosch iy be Giored dumc =
the "Description" or "Techniques" tart ATOCOCH 1. The Wintdaws Teskbar

text for the current step. Clicking _ Clickihe Eaart bution, Frograms 4 TOTookit—
the Detail button presents a fOpen a Brocess File #om the guk-mienu, om the Taskbar on
drop-down menu. Select the field P | Fite.Coan Menu sem Ll L AT

you wish to view from the menu 7. STCExgponar

list. 4 gelectthe Process you'wish o use and |

The text field labels may be different from the generic terms "Description” and "Techniques", as these fields
can be re-named with 4TQFlow's headings dialog for each process file.

Use the Scroll bar, on the right of the text field, to move through the text —loi x|
box. B Fare Wew Help

o I 1 deiwd B
Clicking the description | again will hide the text. :

| Steg Hough he Procass usng s
conira | buions

Apanding e e o show mine

Click on the il (home)button to return to the start of the process, display > Expanding b Wiw io s the Charl
the description text field. The description text details the ways that

4TQCoach may be launched. To see all of the text use the scroll bars on ¥

the right-hand side of the text field. DUITOnS

Displaying the chart diagram.

To show the process chart drag 4TQCoach's bottom window border to 4 o
enlarge the window.

Expanding tha
The Chart diagram can be displayed in two modes. The full chart or """’IT":r';"'"'
scaled mode is the default. This mode scales the diagram so that all of it nfeemakion
fits into the chart window. The current step is highlighted on the chart. To
toggle the chart display mode, place the mouse over the chart and left

click on it.

The chart display zooms in on the current process step. 5 4

e Click the L button a few times with a small pause between each
click. The highlighted (current) figure moves forward with each click of the Next Button.
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Jumping to a Sub Process.

Each TASK in a 4TQFlow Process file can contain a Sub-Process (another complete process file). A TASK
figure with an attached Sub-Process has two vertical lines, one at each end as shown below.

Click on the '® button until you reach the Sub Process step.

The “¥ will become active when the current step has a Sub-process attached.

Click on the ¥ button to Jump To the Sub-Process. Iurpie tx gl b

Finram

4TQCoach will load the Sub-Process file. The = will become active. This
button will return you to the main or parent Process.

Click the - button to move through the Sub Process Steps until you reach the Finish figure.

Click the ¥ again and 4TQCoach will automatically return you to the Parent Process.

Launching a RUN file.

Every Figure in a 4TQFlow Process file can link to another application file. When the current figure has a
RUN file attached the % button will become active.

e Click on the ® button and make the "Launching a Run file" step current.

e Click the Y button. The calculator (if available on your PC) will run.

. Close the Calculator.

Behaviour of Splitters.

£] Uy 4 1GLsach - 410 =101 x|

Once 4TQCoach encounters a process Splitter its behaviour is altered fle Fgus T e
to ensure that all flow paths leading from the splitter are completed. 4l AT
On arriving at a Splitter the next step field changes to a drop down list 4 Empanding he v o shis he Chis

(with an arrow head on the right). Click the Arrow to display the list of
valid steps and select the one you wish to perform next. The Green

flow lines shown leaving the splitter indicate the flow paths that are valid
[

choices at this time. Click the “£ button to move to the selected process . T
step.

bemrpang b m sosrepis Sub-Focear

The colour of the flow line from the Splitter to the selected step will
change to blue to indicate that path has been taken. If the flow line
leaving the new current step is coloured orange then that path is
blocked until the other splitter path are completed.

To complete the other paths Click the Arrowhead again and select | ||.-
another path. Steps listed but “greyed” are not available for selection. .

Once a process splitter has been encountered the Back and Home —r e
button functions are disabled. To re-start the process use the Figure ITEANG 0 A Launchin
Menu “Return to Start” item. il I:. o Run flc
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Using 4TQWebGen.

Building a 4TQ Website.

4TQWebGen is extremely fast and effective at converting your 4TQ-process information directly into a fully
linked HTML Web-site. Using your company's existing Intranet or LAN / WAN file system, Procedures can
be updated and distributed to everyone quickly and inexpensively.

4TQWebGen (R6.04+) g ST

creates a self-contained Web HF_., " r Biiyiboen ,:rl, ".—l-l a & m 3 B & w -'E-
of HTML pages based on L by | Tish  Hew | Gewdh Feesien gy €k e
each the 4TQExplorer EgA L] [ e, agrrv' g slabhiondate_rudes =] o |l =
frameworks from which a . : ok .

generation has been made. Managing Your 11Q System

The image shown on the ﬁ'&;ﬂ{“ﬂ RPTa— —_— g
right shows the Frames & B Clmencim ba] Fiofet

JaVa enabled VieW (Slte_ Eij:::: I;:Il:.::ll:'::'::lnuu ......... 4 J mrmenl Spidl al.
Index.htm). The Browser EHED Procmees Ay 35001 ey

window is divided into three e il WAL CossoorMonmrmay

frames. The top frame ™ - ie—n T e ST

displays the main title of the HL

information displayed in the

lower right hand frame. The

Lower left hand frame

contains the Site Plan ) =
navigation tree. L kS Hr Compies

The tree is dynamic and automatically tracks and displays the current location within the tree of the current
contents of the main frame. This means that if you follow the Sub-Process links contained in the actual
process description (main frame) then the Site-Plan will re-draw to show you your current location in the
Framework tree.

B HEW Managmg Your 4TQ Syslem EI
EHE aegociations
E-EOFrocess Dorumentation
Fa Cocurmsssiteg & Process
=1 2Ir|l|:|||"u_'| B Cordrnllad Docymant
B prinier ey
BLojcnnbents
[#]1. Process Summarny
1 Process Char
= ﬂ3 Frocass Delall
1.0 Edarl char
1.1 1 ATOF e Process Dumndian T
3.2 Turn On Process Guardian
1.3 Wan To sulomalically Corrol Mey
3.4 Is &n Organisaional 4 TAFow Tar
1.8 Creale 4TGF low Templake
3.6 Daszs The Ternplabe Inciude The
A7 Bmiend Thee 4 TOFow Tamiplale
1.0 Apply Orgaresaional Templale Fo
3.8 ¥an] To Margaly Contod Tha Do
310 Click On Conlrabed Checkbox In
= 111 Finish
l'l.ﬂ.l:pl:rldlr.ﬁ.
_i'|-’;.|'.l9||l]|= B
B Appendis C
L _1'|.-I.|:|:-rnl:lli i
1 |

The Site Plan can be used in a similar way to the “Folder”
windows pane in Windows Explorer (95 or greater).
Clicking on a [+] symbol opens that branch of the tree to
reveal its contents. Clicking on a Document, Form, Policy,
or procedure opens that item in the main frame (lower
right hand frame).

E @B FE REFAE KON

uf
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The features available are dependant on the entry page used to gain access to the site. The address entry
pages are listed in the table below. The key features for each capability set are listed in the second table.

Address locations Table

Page Address Use Features Capability
Site_Index.htm Multi-Framework Master page Docked Site-Plan Navigation window Frames, Java
Site_Index2.htm Multi-Framework Floating Site-Plan Navigation Window Frames, Java
Site_Index3.htm Multi-Framework No Site-Plan, No Frames No Frames, No Java
Site_Index4.htm Multi-Framework No Site plan, with Frames Frames, No Java
“4FWK”-FRAME.html Single Framework Master page Frames, No Java
“4FWK”-MAIN.html Single Framework No Frames, No Java

“4FWK” denotes the 4TQExplorer frameworks file name without the file extension (.FLK).

Key Features.
Capability Features
All e  Framework List
¢  Document Reference ID Sorted List
. Change Date Sorted List
e  Hot Spot link Chart diagrams.
. Signpost Navigation links
. Base HMTL version 2
e  Dublin Core metadata
. Re-locatable
e  Run File Links. (Forms)

. Sub Process link

Frames with Java (Joust) e  Tracking “Site-Plan” Navigation.
. Dockable or Floating menu.
. Site “Home” page.

. 4TQExplorer Association
Hyperlinks.

. Printer Friendly links

Frameless without Java . Chart Diagram Hover mode Pop-up
(Joust) (Option)

4TQToolkit User Guide Page 71 of 131



Performance Issues

The Site_Index.HTM entry point utilizes your browser’s internal Java Script language to support the active
components of the site. This provides the ability to re-locate the Web-site onto removable media (CD-R) and
use the features without the need for a Web-server. It does however mean that the browser is relying on the
host PC’s resources to perform the processing required.

When planning your 4TQ Web-Site utilizing the Site_Index.htm entry point consider the following;

e The site was designed for use with IE5 and above or equivalent (Java Script 1.3).

e The site supports the use of multiple frameworks (4TQExplorer files) within the one main entry
point. You are not restricted to just one framework and splitting up a large framework into two or
more smaller ones will make a significant difference to the speed of the Site-Plan refresh.

e The number of items (Maps, Documents and Forms) within a Category in a single framework is
the most significant factor in determining the amount of Java processing the browser needs to
perform. The smaller the number of items within a category the faster the response. Aim for less
than 40.

e Keeping the source files path and file names short reduces the processing load on the Java
interpreter.

¢ When distributing via CD, remember to keep the maximum depth of folders to seven or less.
e Files Pathnames should be kept to less than 255 characters and should be strictly alphanumeric.

e Do not use the space character in File or folder names. Use the Underscore character (_) as a
replacement.
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. [ a0 Process Web Gemerator 11 x|
Running 4TQWebGen

_ ophon: | dooumenis | generate ek

4TQWebGen is launched from the 4TQExplorer Tools
menu. The menu item only appears if 4TQWebGen is Help. | About.. | geresatn | | _view | Boowne.
installed.
To run 4TQWebGen you will also need 4TQFlow. You et e B el
will also need a suitable Web Browser to view the Process Document Eapene Claim procedune
Website. AT G armpes G P tabl LW ]
e Run 4TQExplorer and open the required A -

4TQEXxplorer file. LOWATIONS a5 T

L -L_..:.E-.'n'nr: FLips
Ensure that the 4TQExplorer file and the 4TQFlow i ::-'-'{{ﬂ:;'f;g:"m‘r “
Process files all reside in or below the SystemPath, : TS gl \SP
05 i

The SystemPath is only configurable during the t i ﬂb-""ﬁ:=-'ﬁ‘;fi1;ti

installation process and not from within LTINS :ﬁ,;j I.-fj:an-.-L

4TQWebGen. : :i'

Any Process map files located outside your D : _

SystemPath will not be generated into HTML L:\ATID Ew.- S LYy I

e Select 4TQWebGen from the 4TQExplorer Tools menu. 4TQWebGen will automatically run 4TQFlow if it
is not already running. If it is already running make sure you save the current process map before
continuing.

e Check the 4TQFlow Colours and Fonts options are as you require. The colours and fonts used on the
charts in the Web site can be set using the 4TQFIlow Options- Preferences — Colours and Fonts Menu
item (refer to page 44 for details).

e Setthe 4TQWebGen Options (Tab) as required. (refer to the next page for details).
e Set the Document Handling Option as required (see page 77 for the details).
e Click 4TQWebGen's Generate Button.

The HTML Pages will be created. Before starting the HTML generation ensure that you have selected
the options in both 4TQWebGen and 4TQFlow as required.

To stop the generation process, click on one of the 4TQFlow menu items.
e Wait until the view button becomes active.

If a post generation command file has been set to be run after the generation of the Web-site as
completed (on the Options Tab), wait until the command script completes it task and then either

Click the View button on Generate tab to see the individual non java framework site.
or
Select the Explorers Tab and click on the View Button to display the Master Site_Index(.HTM) page.

e Review the error log (tab — see page )and test the Site paying attention to the behaviour of any links to
external documents and forms. See page 77 to details on the issues and options involved with
document reference links.
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. . | oy il T il T o w1
Options Setting tab — [ docwmems | wwtions
The Option Tab is shown on the right. Digssrigg Tills

|"':-l.-| Cormpary Marme of Busiress Uit Rarme

Process Map Specific Options Cimvarant ¥ ‘comment only cortilsd poceduss

The 6.07 (or higher) release of [rconkcled wher e

4TQWebgen prOVideS for the ¥ RAepal Apperdic FasRgaon |l nd red "'|

separation of the normal 4TQFlow

Reporting Option from 4TQFlow itself. R P it Eipnd KSmiSets

The settings altered and retained by I Haporn Foue Types ™ Fepos Figurs Consdingtes

4TQW<_abg_en are only used wher_1 a [ Bepor Figue Pefoumets [ Repot Figue SubPincesses

Web-Site is generated. The Settings

used by 4TQFlow are not affected by I Pepon Tect Figaes ™ Fiwpon Figure Checks

these controls. [~ Repail Fun Fles ¥ R Fagae 1D

For details of the use of each option

F s =
refer to page 41
™ out of dabhs ™ singls pags " WHF

4TQWebgen Specific Options . T witede i -

Document Reference List

This option is pre-selected and locked if 4TQWebgen locates the presents of the Java support files
in your installation This option creates an additional HTML page, listing all the Process Maps in
Document Reference number order.

The Document Reference field on the Title Page of each Process map (4TQFlow) is used as the
source for the list.

To see this list in your browser, click on the Document Reference List hypertext link shown at the
top of the main page (non-frames) or within the heading frame.

Frames

This option is pre-selected if 4TQWebgen locates the presents of the Java support file in your
installation.

If you have a mixture of browsers, and are unsure if they can all support frames, generate the site
without frames first, and then generate the site again with this option on. Users with a Web browser
that doesn't support the frame layout will automatically be directed to the non-frames HTML
equivalent file.

ImageMaps.
This option is pre-selected if 4TQWebgen locates e Lo e mﬁ- tpme i i|
the presents of the Java support file in your e T ] T
installation. Use this option if you wish to include a T T e il T Yl et e e
Hypertext marked Process Chart diagram in the , J
generated HTML for each Process file. e e ¥
To include the Process Map diagrams, this option oy s ey i, I
must be on and each 4TQFlow Process Map must Tor Hofoiem g fodidab o
have the Process Chart Property included in its list _;Z ik Lee T M |
of Title Page properties. The Chart diagram is Tirimck 3 6501w b U AT o' Prvven (oo
Hypertext hot-spotted providing direct navigation T e s o niiael inirnt Theeski

from the diagram itself. - S

o] i Lrim
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Out of Date

Select this option if you only want to replace the e M e i s e s _HI
pages that have changed since you last generated St il . T L R |
the site. T Compsting Pocess Aasiess L :‘
CoRTENTT YT o
Single Page e I L
When this option is selected 4TQWebGen will only %
generate the HTML for the current 4TQExplorer or

Process Document.

WMF
Select this option if you wish to use WMF format files
for the Process Chart images.
The Microsoft Internet Explorer (IE4 or IE5) supports = i
the WMF format with an ActiveX control. This may not be a suitable choice if not all the target
audience has IE4.0 or IE5 installed.
The advantage of using WMF over JPG format is that WMF files are much smaller than the JPG
equivalent.
Some of the other modern Browsers will correctly display the WMF image if IE4, 5 or 6 has also
been installed on the viewers' platform.

JPG

Select this option if you wish to use JPG format files for the Process Chart images.

Most Browsers support the JPG format, so this is the safest choice.

The disadvantage of using JPG over WMF format is that JPG files are much larger than the WMF
equivalent

Entire Site (default)
This option causes 4TQWebGen to traverse each 4TQFlow process map and any Sub-Process files
in turn, creating an entire Web-site with all the Sub-Process hypertext linking.

All (default)

Selecting this option will cause 4TQWebGen to replace all of the HTML Pages not just the one’s that
have been changed since the last generate for the current 4TQExplorer Framework.

Auto Expand Contents

Use this option to control the Auto Expand level of the
Site Plan when viewing a process map.

EI.@. FParent Process - Example
- printer friendly
B contents

R |®8]1. FPROCESS SUMMAR™Y
- Parent Process - Example B~ ®] 2. Frocess Detail
.D printer friendly b e EI 3. Process Chart
E‘...Dcuntentg ----- EI 4. Review Schedule
g Sub Process 1 - Bxample 1 3] AppendicA
g How to use 4TOFlOw 1 2] AppendicB
----- |®] Appendix C
----- |®] Appendix D
- SUb Frocess 1 - Example
- Howe t0 e 4TOF [0ty
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Paths Tab

This tab is used to set the file and file locations required by 4TQWebgen.
System Path

This field shows the current SystemPath. [ EE I A 1l
It cannot be altered from within [ — I I
4TQWebgen. i el
Syham Palh
Generate To [L4T0
The Generate To field shows the target Eaneais To Biowe . |
folder that will receive the generated AT D wetr
HTML pages.
) Pisl Serigt Browss
The browse dialog allows you to select |
the folder location that will receive the
generated HTML files. Left Tt Loges _Browss _ |
Use this option to create and manage l
more than one site where you have the Fight The Loge oy appeas in rames and romdianes) _Brovse . |
need to provide a site tailored to intranet |
use and other using removable media Hesrws page Conpary Logo Browss |
distribution (CD). (see page 77 for details f'our pompang pchue/ogd
on Document Options) Opering The
r'r'u-.r Ciorpmrey B ame

PostScript

Use this field to automatically run a Command, Batch or Script file immediately after the Generation
process has completed.

This feature can be used to move or copy the 4TQWeb-site to other locations.

Logo Left / Logo Right

Use these fields to set the title frame graphics images and override the defaults of 4TQTL.GIFand
4TQTR.GIF.These images are only used in the title frame of the framed pages.

Home Page Company Logo 7 410 Process Web Generstor 1lx
aiﬁéhealrr;age file to be inserted in the sites [ — I | | [ .
ovenine w2 ghie | eesws | e
ening Title
P 9 . , . . seticia | o |
Sets the Title displayed in the Title Frame of
the Site_Index Home page. ZRMINE 34600 PM naccmsshaby geriaind L AT 'S snclastuel_p = |
2T 385 00 PM anci - 53 TED Fibe vl Pournd - LT85 aimplecs
2022002 285 (12 PM successhly gereiated LA T O WS ampkesaand_si
ZEAS200E 285 05 PM suncesshuly gersisted LT 05 sepdesmapd_s)
ZEAA2002 38508 PM papcesshaly gereested LA T 05 sspdeseand_ny
ZEMAINE 34510 P pccaschly gerwmealed LTS snplesh el 5
ZEMACN0D 38513 P successhaly geraiaied L AT \S angtes'usedT |
. 2RN2002 28515 PM successhuly cersiated LA T 0 WS smphes' e
Log File Tab 2RTI002 28517 PM encr- 53 18D File ricd Foured - L5W4TIDN
_ _ 2EOGZ002 8517 M enor - 53 160 Fle nol fourd - LN
The log file tab shows the success or failure 0L/ Z002 1:07:53 PM DD E indigirgfion: lang = EM

message for each item generated within the
framework. The log should check after each
Site generate action to ensure that all link
items have been located and linked within the
site.
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Document Handling Options.

Run File Links
The Run Files that are linked to the 4TQFlow figures are included in the generated HTML pages as

Hypertext links. Linked Files that are located within the SystemPath may be duplicated into the

“Generate To” file structure.

The Generate To location can be set using the Paths Tab. Control of the duplication function is

provided on the 4TQWebGen Document tab.

Important Note:

Linked Run files that are located outside of the SystemPath or have been linked using the full absolute

Pathname or UNC form are not duplicated.

For these links to function correctly from a user's browser, the file must be available to that user using the

address provided.

Document Tab Settings

The way hyperlinks to external documents
(particularly Office documents) behave is not
standardised.

Factors affecting the exact behaviour on a
particular machine include the type of Operating
System (OS) and its version, the documents
source application and its version and the
browser itself. Even the order in which the OS
and applications has been installed and upgraded
can effect the behaviour of the links.

Word (8 or 9) Document Templates provide an
example of the in-consistencies that you may
encounter. When using Word itself to open a
template, Word loads a new “copy” of the
Template with a new document file name
(normally Document 1). In a Browser navigating a
Hyperlink to a Word Document template may

1. Cause Word to open with a new document.

410 Process Web Generatee 1%
| lng file T eremsis T mxplorery
peth: | documens | opbon:

b Cimgae D peurmamt 12 poun g sl 15" v (el sieen palag
[T Cios reod oy i Dipoment s oulsde o 5 psianP st

Cipgarsg Hhs cioourssnts b yous *'geressis by csn meks &
SR b el FOUR ™ b artes kaCaton

* Crests s Hypsdek In e Dol
Iy sty combgurations of InbemedEaplores snd Mot

OFece, docisresnls™ well open ieedonk on i b baoseer
nztaid of n tha appopiale sale nebled Dffce Apphealor

™ Cresis s Mypederk In g UMC Shodout bo e Doourend

i

Uz tha oot i o o | b E st b ddemaibin ] all
docyarenis 1o that ey can be opered vl e comect
Pl

Thes opbon doess ol work il woa beowser & Nelsoage,

2. Open the document in the Browser’s Window. In such cases any user editing occurs in the
actual template itself and cannot it be saved as a new document.

The Document tab details the options available to assist you in setting the behaviour to achieve the

best outcome in your specific environment.

Copy Document to your “generate to” using relative pathing.

This option instructs 4TQWebgen to copy the referenced documents into the Webroot (Generate To

folder). Using this option makes moving or copying the whole Web-Site to another location or
removable media possible. To exclude documents that do not reside in the SystemPath from the

copy process select the second checkmark.

Create a Hyperlink to the Document

Selecting this option will force 4TQWebGen to create the Hyperlinks to reference documents as
direct references to the target document (Standard HTML tag). This option relies on the Browser /

OS to dictate the behaviour.
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Create a Hyperlink to a UNC Shortcut to the Document.

Selecting this option causes 4TQWebgen to creates a Hyperlink and a matching Windows Shortcut
file. This option removes the control of the behaviour from the Browser / OS / Application and forces
the target application to settings of the Shortcut file.

This option only works on Windows based platforms with MSIE.

The UNC must be set to the location of the Webroot (generate to) or the location to which the
Webroot and subfolders are optionally re-located.

If you are intending to provide CD-Rom distribution and the CD Drive identifier is consistent on all
target machine a dos Drive identifier pathname can be used.

Printer Friendly Links

Printing framed contents directly from a Site Plan A
Browser window does not normally provide the =0 Procedures List
results you require in a paper copy of the - 2 4T Example Process Map
document. 4TQWebgen will search for 2 NEW Managing Your 4TQ Systern
generated documents of each 4TQFlow E-{jassociations
process map contained within the framework, EHEIProcess Docurentation
and if found, will add them to the Site-Plan. Bl Documenting A Process

B printer friendly

..... (@] HTML

The links are located on the Site Plan directly | | | { i~ 19| DOC
under the Process label in the “printer friendly” | | | & . [21PDF

folder. See the diagram on the right showing  |{ | 7 & §]1. Process Summary

three printer friendly document types (HTML,  |{ ¢ ¢ © i 3] 2. Process Chart
DOC and PDF) -] 3. Process Detail
----- | 8] Appendix A
----- | 8] Appendix B
The HTML version will always be present. The | § { § i~ | ] Appendix C =
search checks for DOC and PDF versions of 3l il “““T’““ o _'|J
the Process map with a created date equal or
later than the last modify date of the map. The Expand All  Collapse Al Help Home
links are added to the Site-Plan only if the date Frames No Frames Floaling Menu

test is passed.

For information on convert the Generated Process Map documents refer to page 26.

Clicking the link will open the selected document type in a new browser window.
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Customizing your Web-Site.

Your 4TQWebsite can be customized in the following ways.

Customizing Site Home Page

The Site’s Home page is displayed in the main frame (lower right) when the site entry page (Site_index.htm)
is initially loaded or when the user selects the Home link on the Site Plan menu.

This page can be customized to provide the user with
¢ links to other company sites,
e Messages or instructions,
e Contact information,
e Copyright or other legal statements.

To edit the home open the Site_ Home.htm file in the Webroot (“generate to0”) with a suitable HTML editor
(like Microsoft FrontPage). Take care not to alter the HTML code above a below the dotted line contained
within the code. Do not use Microsoft Word to edit any of the 4TQ generated pages.
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Customizing Cascading Style Sheet

Default Cascading Style Sheets are installed into the SystemPath during installation and are copied
into the "Generate To" path every time the Generate button is pressed. To make permanent changes
to the default make sure you modify the CSS files located in the SystemPath. Notepad is a suitable
editor for the CS files.

The main CSS files used by the HTML generated by 4TQWebgen are;

CSS FILE APPLIES TO
4TQ-BASE.CSS All Frames

4TQ-CONT.CSS Overrides 4TQ-BASE.CSS in the process page type Left Hand
"Contents" frame. Not used when the access point is
Site_Index.htm.

4TQ-TITL.CSS Overrides 4TQ-BASE.CSS in Top "Title" frame. Not used when the
access point is Site_Index.htm.

4TQ-EXPL.CSS Overrides the 4TQ-BASE.CSS in 4TQExplorer based bottom details
frames. Not used when the access point is Site_Index.htm.

4TQ-ETTL.CSS Used by the “4FWK”"-FRAME frame entry point. (frames , No Java,
single framework). Applies to the Title frame.

4TQ-EXPL.CSS Used by the Title frame of 4TQExplorer framework based pages
accessed via the Site-index main entry point.

4TQ-FTTL.CSS Used by Process map Title frame access by the main Site-Index
entry point.

4TQ-PROC.CSS Applies additional control to the process based pages including -
Frame, -Main, -Popup and —Home.

4TQ-STTL.CSS Used by Site_Index3.htm, Site_Index4.htm entry points and
Site_Title.htm frame of the Site_Index.htm entry point.

4TQ-HACCP.CSS  yses on the HACCP module base report page. Only available when
the HACCP data module is present in the installation.

Site_styles.css Provides Styles for the License information page.

Note 1: Whenever you have made changes to the CSS Files check the effects obtained on each
Browser (type and version) that your users may use.

Note 2:“4FWK” denotes the 4TQExplorer frameworks file name without the file extension (.FLK).
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Managing your 4TQ Website(s).
The Explorers tab provides the features required to manage each 4TQWeb-site as a whole.

Once a 4TQExplorer Framework has been generated to a “WebRoot” (generate to) folder it's Title will be
listed. The list shows all of the generated Frameworks for that “WebRoot” folder. Change the location of the
“Generate To” setting (on the Option tab) to see the list appropriate for other “WebRoot” folders if required.

Deleting a Framework. 3l x|
There are two buttons associated with removing paths | cocumess | pors
a framework from the master Site Plan. ko e 1 i ] wwploanrs

[ | Gl | T | CRpsT |

The “del” button will delete all of the files on the E‘jmm

file that are contained in the selected framework.
The “del” button does not remove the Framework
item from the list or from the Site —Plan.

The remove button deletes all of the files required
for the current framework, the Frameworks item
in the Site Plan menus and its entry in the list.

Warning: After deleting the framework you
should re-generate all of the other Frameworks
still required within the Web-Site. This ensures
that all of the require Hyperlinks involving
common procedures are re-created.

Re-generating multiple Frameworks.

The Framework list can be multi selected. To select more than one Framework, click on the first required one
then use the Shift or Control keys to select (click) the other Frameworks required.

Clicking the Generate button will re-generate all the selected Frameworks.

To View the Web-Site Click the View button.

To open a selected framework in 4TQExplorer, click the Open button.
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4TQAction Records Module Overview.

The 4TQ Action Records (AR) module is an optional application that integrates with 4TQExplorer. Its role is
to provide a “register and workflow manager* of the actions required to maintain and improve the “System of
Work”.

The 4TQ Action Records activity cycle covers:
1. The causal event record. (What, Who and When),
Action categorization,
The immediate action taken,

A Risk Assessment,

Assignment against the effected Process,

2

3

4

5. Assignment of responsibilities,

6

7. Assignment against Business Unit, Locations, Plant and Equipment,
8

Infinite “Follow-on Action” trail,

9. Final Clearance write-off,

The 4TQAR module extends the traditional approach to managing CARs, PINs and OBS to achieve a full
Process Management loop closure.

Firstly by allowing the inclusion of other “System of Work” impact events like Customer Complaints (and any
other type you have identified) all of the potential sources of action provoking are consolidated into one
workflow system.

Next, to provide an accurate means to prioritise and schedule the Action tasks each AR has an optional
inbuilt “Risk Assessment” calculator.

Each AR has at “Post Implementation Review” scheduling function to provide the check that the “corrective”
actions taken have actually had the desired outcomes.

Finally, and most importantly the each AR can be associated back to the actual process that was involved or
impacted in resolution of the event. In a true “Process Management” system this is the essential loop
closure activity. It provides the Process Owner with the often-missing additional feedback of the performance
of their process outcomes.

An additional tab in the 4TQExplorer “Explore” window is used to access the Action Records Module. (Right-
Hand Pane). The tab only appears after the module has been installed in your 4TQToolkit system.

The Action Records module functions from within 4TQExplorer with or without a framework file loaded. If a
framework file is loaded you do not need write access to the Framework to use most of the Action Records
features.

Important Note:

If your are performing the role of the 4TQToolkit system manager you should review this document then
perform the initial administration steps outlined in the “The 4TQAction Records Administrator Form” before
using the Action Records module (starting at page 86).
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The 4TQExplorer Action Records tab.

To display the Action Records list click on the labeled tab in the Explore window. The Actions Records
window is shown below.

._!_ FTCpdnrer - O AT TA SEEGulde Ak . er::'—l
Ela Edt Procedurss Lpdates Joch Help
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- (5] Perscams © Performers | i FlowChart | ¥~ Cause B Effect | 43 Graph 4 Action Records
1D Procems P [ procaduen T, | Bction Due | B8R Tiis | Crested | Betion Type | Mo Ingect.,. | Sobus | Frioeky | Rt
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Working with 4TQExplorer frameworks.

In usual circumstance you would have a 4TQExplorer framework open when using the Action Records
Module. If you do not have a framework loaded, you can still operate most of the Action Records function.
Use the List All function to refresh the list as required.

The Action Records Tab List.

Sorting the list contents.
The column header row may be dragged into the column order required.

The list sort order may be toggled between ascending and descending by clicking on the Priority, Impact on,
Status, Created Date or AR title fields. The other fields are not available to sorting.

Controlling the list contents.

The Action Records list displays the action records for the selected part of the navigate window tree (Left
Hand window pane) of 4TQExplorer.

The Toolbar has three buttons to control the content of the Explore Mode lists including the
Action Records list. The buttons are shown on the right. e E = |

The first button will limit the list to only show the details of the currently selected procedure in
the Procedure list (Navigate or Left-Hand window).

The Second Button will limit the list to all procedures below the Procedure selected in the Procedure List
excluding the item selected.

The third button shows the details for both the selected Procedure and all of its children.
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Further control of the lists contents can be invoked with the first four buttons displayed on the bottom of the
list display. The full set of six buttons is shown below. Normal users will have the first five buttons.
4TQToolkit Admin users will have the last button available to access the Action records “Admin” functions.

Listall || Listfor Proc

The button removes the default Navigate window based constraint on the list filter to show all
Action Records in the system. You use this feature to list and locate Action Records that have not been
associated to a Process or part of the Framework.

Ty Listior Froc reapplies the navigate window constraint filter.

The B8] K tton opens up the advance additional filter dialog box. Use the | BEZMLZE] ytton to de-
activate the Advance filter settings

Use the | E=LEETR b tton to open the Action Records data entry form to add a new Action Record to the
system.

Administration Access.

Access to the AR System administration functions is provided via the | ZHUUBENER] b tton. Not all users will
have this button displayed. The Admin form requires a password to be entered for it to become active. Use
of this form is detailed starting on page 86.

Action Schedule Warnings.

The 4TQExplorer Action Records tab lists first column displays Due Date warnings for both the Immediate
action task that are scheduled and the AR’s overall completion target date.

‘[g Action Records

The [£8 icon indicates that the d:|-Erecedure [ 2%..] actionDue_[ ar Tite ys before
the date is set by the administrat [ND Related Procedure] a 13/03/2003  Customer raised issue

.Crndardised Document ... 0 10/03/2003

curnent & P ok Se 04 Audit 23 raised OF

Mgnk Meeting Documer

The . icon appears when the [
<] |

. Lizt Al Liztfor Proc || Set Fitter... || Clear Fitter |JCreate Mevw...|jddmin Toals..
The X icon shown when the ovtiam Acuun necuru LalyGL LUITIPIGUUIT DAl 1T1ad> padt.
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The 4TQAction Records Administrator Form.

Planning your system coverage and values.

Before starting to use the Action Records module it must be setup to reflect your organization’s
requirements.

You may need to do some planning before commencing making the alteration and entries into the system.

In order you should:

N o o &~ »

Entering the Admin password.

1l
Click the [LUBENES] on, the bottom of the bl Chack Prad
4TQExplorer AR tab to open the
Administrator dialog. Dot Do | Lsbvals | Topss Tl | Wideironga | Il andEsily] | DelelesS oo

Enter the Password into the password field
and press the Check Password button,

The password’s capitalization is significant. hitheitomaldey | TV

If the password is accepted the fields will
become accessible.

Date Warning lead setting.

The first Tab, labelled “Due Date”, contains diStsus  [ocomecies =
a numeric field that sets the number of day T T T pw— LI ll

prior to a scheduled date when the warning

Decide how many days you want as a warning period before an Action warning icon appears.

Check the terminology used to describe the classification types that are applied to each AR. It may
pay to repeat this step after completing the following configuration steps to take account of the
values you may have assigned within a classification.

Decide what kinds of action types your system will cover and make a list of these.
Decide the types of Priority you wish to have.

Decide the range of Statuses (or AR work flow steps) you wish to use.

Decide the range of Main Impact target you wish to use.

List the main functional units (Work Group) within your organisation to which you may wish to assign
the task of processing the AR.

For each Work Group add the responsible person information.

The rumber o days price the |, -
o D ke 1EcorT g T e

= _selnisnvie |

icon will appear for each Action Record.
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Customizing Labels.

The main labels for the classifying types
that 4TQAR displays may be changed to
reflect the names used in your
organisation.

To re-label an item:

1. Select the Labels tab.

2. Select the label to be changed in
the list by clicking on it.

3. Enter the new label text into the
lower right hand side
“Replacement text” field.

4. Click the Set New Values button.
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Managing Types

The values available for each classifying type
may be changed, add to or removed.

To Change an existing value:

1. Select the Type Table containing the
value you wish change.

2. Select the item to be change in the Left
hand list.

3. Click the “Rename” button.

4. Enter the revised text in the lower “New
Item label” field.

5. Click the Set New Value button.

To Add a new value:

AT} Artinn Recondineg - Adminksiraton Tools Tl =l
Erat tha cunenl
P s |—I

DoomDate | Labsin Tope Tables | wiokbirogs | InHandErsy] | Delie/Seoss |

Barnt i rebecied Tabla
High |
Hoamwasl
Lwa Hirvs
[I:nml
IJHH:DI
Tha cunenl proesy nstng hor He ol Mg Ny E]
i LIE ]
o 55 | eleoted hen
Smbactad Tubls cunsnd rorss Hewsi Bign Labesd
Proasy
db5ishy  [Hoconmecies
Ghoer | docu |

1. Select the Type Table to which you wish to add a new item.

2. Select the item above or below where you wish to add the new item.

3. Click the Above or Below button.

4. Enter the label text in the lower “New Item label” field.

5. Click the Set New Value button.

To Delete an existing value:

1. Select the Type Table from which you wish to delete an item.

2. Select the item you wish to delete.

3. Click the Delete button.
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Setting Workgroup names

The WorkGroups tab allows you to add and change functional areas and organizational group to which you
wish to assign the task of completing or progressing Action Record.

To Change an existing WorkGroup name:

1.  Select the Workgroup item you
wish change.

2. Click the Rename button.

3. Enter the revised text in the lower
“New Workgroup name” field.

4, Click the Set New Value button.

To Add a new WorkGroup:

1. Select the WorkGroup above or
below where you wish to add the new
item.

2. Click the Above or Below button.

3. Enter the label text in the lower “New
WorkGroup name” field.

4. Click the Set New Value button.

To Delete an existing value:

AT & Liwn eCordeag - Adidieslrslor Tesls
Enter e pymrend I | ; I

Pazsaced
DueDatn | Labsk | Type Tables 'woitBrngss | inHardEriid | Drlste/Seras |
Lt ol eirers Wisbioipugd

Tt e whvan macdiprg

nosancs Baokng

mweshresnl Flannarg

CoADorate B vl

T firal iesm in s Lisk
"UrespasCliad " o rodd bee:
rucclifiad o sl

i .1

chSishe  Fsconnecied

1. Select the WorkGroup you wish to delete.

2. Click the Delete button.

Note: Before deleting a WorkGroup check that there are no outstanding AR’s for that WorkGroup.
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Adding In hand Operators.
[ 410 Ackiom Reurdens - Administator Tesls 32| x|

DusDiatn | Labsk | Type Tables | ‘ot Groupe  InHandEnsin | Dnlste/Seras |

The In-Hand(Entity) tab is used to add:

1. The names and details of your R i L
organization key people who |rore = JUrepeciind =z
will be involved in Action M unassgned oWk, Group Carerny g b Wehodk (51 i
Records processing and MiFred fchatz CEL
resolution, v Liwiitre: B-agot. Samnsianon |

Wz Jirwwy Timrreai, Doy W anig
W1 Fion Aking. Buking Tean L

2. Details of other parties, I |
including Suppliers and Clients,
that maybe related to the

Actions Ede | Hud | f | Mol b 0 o«

Tos eruable Ak, £l & Dimlete oot ook i 3920 andl < Dualsorn Wiesh. Brop
3. Items of Plant and Equipment telimpeched & Desdcdion @ ionore and Add/Updade & Defele Ko

that may be related to the NS i ugadsie the dabs bees on aperstion
Actions taken. _I""’"" comre cepacaied foavife

dhbishe  [dscorecied Chem | Lt |
To Add a new Person:
1. Set the “Entity Classification filter” to
“none” and the “Work Group selector” to .
Unspecified Eamohs dsishass s Foid askas _I|
L—.ﬂhﬁlﬂm o
2. Click the Add button. Vit | G 1 | Eostd ks Db i |
Tike |H| --l _:mrurqﬂm :’
3. Enter the person’s details into the S -__ Bl 14 Iﬁ"
Individuals tab dialog. Furt m Pestnii LU
9 (T | TR ==
4. Click the Add/Update button. o 1BABT BEEE— Sarmmgy |7 AT =

fiai Dt JI® (CTRET =
[Urciiided ] Hughighieed Chismmes vl g vl

o et e
L] Carrfcetom e
[ =] Dt boorged Dhermberstumsd mecwttia F

To change an existing person’s —
. b | ddipie || Oow |
record:
Fata] wall ra b dart i ki S0l v Froaian od Cavapaty 17
Coacapocs e we s

1. Set the “Entity Classification filter” to “none” and the “Work Group selector” to “Unspecified”.
2. Select the person’s record to be changed in the Left hand list.

3. Click the Edit button.

4. Enter the revised text in the dialog box as required field.

5. Click the Add/Edit button.
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To Delete an existing value:

1. Select the Type Table from which you wish to delete an item.
2. Select the item you wish to delete.

3. Click the Delete button.

Records Management and Security settings.

The Delete/Secure tab provides direct x|
query access to the records held within Enter s cumrerd i n
the database. The query can be based e I S
on:
DusDatn | Lobek | Type Tables | 'iodkBroups | inHandEriiy) DsbeiaSacuse |
e Actions, P T Cectie 7 Tie ™ Serisily Passwond
» mcod pps © Enlily datsbrinbe [ Rscord Munber [ Seousty Level
e Entities, Ll #w.:&-e ™ Rsksssros D
e Procedures.
Select the type by clicking on the Radio
button on the upper left hand side of tab.
The query options will change dependent Gt Raconds | N | |
on the type selected.
A=l | | |
After selecting the query options, click the

“Get Records” button to populate the list.
Pop S e

Last D aliory

Lhrs Ahoul |

To work with a specific list item click on that item.

To delete the selected record click the Delete button.

The Secure Selected and Un-secure Selected buttons will be available if the record type is an Action Record.

Temporary Password assignment.

The use of the Secure button applies the password of “admin” to the record. Use this to replace a forgotten
password temporarily so that record owner can access their records again and then replace the temporary
password with one that may remember.
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The 4TQAction Records data entry Form.

To create an Action Record (AR) open  EEEEEEr = S 1
the Action Records Tab in Carprticion B : . 1
4TQEXxplorer. = femitin e j

" dancits murdluioy Fuld e . | Raced | Assecein]
If you have Framework loaded in B rewisdPoostesy | YR Pesisdactons | [ Moy | o Rk ssessmen |
4TQEXxplorer, select the label W G | By Dewopion | @ sctionTage | # ineesdweacons | P Frs dction

(Category, Sub-category, or
Procedure) to which you believe the

Syzzpar [l phora Pestionn Tt

Action Record is related in the Tree | =]
View Navigate window. If you are e
unsure at this stage of where the Action - e " R =l
record should be related, select the top bt L -
of the Framework (Framework Title). r r ERelemlryimes | © firHisra =]

- :‘-ﬂnl;imh_-hglr# Haninoect - <]
If you do not have framework loaded Ersten 2 susdsble [l mner Pyprmnecd _
the Action Record will be created [ Aok Girpuy [Ire=sanca Ercking =]
without a relationship being recorded. {rces gt thos et Lievwsl 0 oy be

shares] path passpssord entbc skon, Iri Hand

|H| S, Bokorg Tasm Lesds j

Prlasi Betn igpm il b 1| niHarsl By in Dhutlice [ il reilalile) [
You can add, change or delete

procedure / framework relationships at dhmhe fomecied Vi Mo Guids | i | [ Do
any time once the record has been Last Opeustion [rucicess Deeurart | b
created.

Click the |EE=EETR] htton to open the Action Records data entry form.

The Action Records dialog form has two view modes, “Tabbed” and “HelpGuide”. The Tabbed display mode
is shown on the right.

Help Guide Tabbed Pages

To toggle between view modes click on the
of each view dialog.

or button shown on the lower portion

There are a number of fields that must be completed before an AR can be save d to the database.

These fields are contained on the General and Description Tab of the AR dialog. The mandatory fields,
denoted with the * character are:

On the General Tab.
Title,
Type,
Priority,
Status,

On the Description Tab.
Created By
Details

These fields must contain information before you can save the AR. A warning message will advise you if any
of the fields are not valid.
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To add the Details of the AR T 2| x|

select the Description Tab and Curerd ACSon [3 rqmye 2chon Flscced Record Hal
click the Add Entry Button. e «f »]

The field will become available " denobes mandaton ekl m"”|§;;:,,""| Lt | S

for text entry and the Date, Time

and your system name will be & PetedProcedues | Relndacions | (B Himow | ol Riskdssenmen: |

entered automatically. M Gerwd B Decciion | @ AieTeget | ¥ ieeedesiciors | B Fradacion
Cieatndty | =] pae |

Type in the details of the Action _adEny | Eiy | Dutbezs 1 eMaf avadabie

Record, as you know them. Prass Aod Eniry i snabls ingut and ol snisred b =]

Espsscied Cornpletion Duste v - =
T ke Adiors A ecod

Saving the AR.

If you have completed the mandatory fields, and any other that you may already know, save the AR by
clicking the Save New Record button.
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Performing a Risk Assessment.

Each AR may have a Risk
Assessment recorded against it.

This assessment may help you
in deciding the priority of your
actions in response to the causal
event.

To add an assessment, click on
the Risk Assessment tab and
click the Do Risk Assessment
checkmark to turn it on.

Position the slider controls to
reflect your assessment of the
Probability and Consequences
of the event.

If you wish to include the
Exposure attribute in the
calculation click the Checkmark
above right of the middle slider.

The calculated assessment
value is shown on right hand
side of the dialog.

| aToadienRecorsms 1=
Dlﬂ_w ] thrd"ul—
B
g Cregte Meww | G oven Hew st
denolas mandshony Geld Bleoosd | Becd | el | Fusi I:II_
OB Gered | By Tescigion | @ ActiorTage | ¥ inwedamdciors | B Finalaction: |
& FReliniProceduss | YN Relamddcion: | [J] Hiven o Rk Acimrimen
¥ Do Rl Asbasirnent lod s Sction Pk Leenl

Brobabdiy of hazad causing peoblens
! L i J L gl ot o i e

Click the Update record button to save the assessment.
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Entering Immediate Actions.

The Immediate Actions are those actions taken leading up to the point where the Action Record can be
considered completed. It is usual to have more than one “Immediate” action, commenced one after another
on the way to identifying and resolving the underlying issue that caused the action trigger event. Immediate
Actions are directive, sayings what needs to be done next.

The evidence that supports the finding that the Action Record has been effectively resolved with should be
recorded on the Final Assessment Tab.

To add a new Immediate Action to the series, Click the Add Entry button and enter the details of the action
required. Use the Action Due Date to set the schedule for this action.

2
D‘ﬁ"w rd W satng mand Tespsiag st Hmd"ul—m
] »
. Creae Hew = Updste
Percentage Completed dersles mandstoey fekd Reoosd | Firpord | Fiecoed | [—
Control
. . & FelendPocedues | TR Relwsdaciens | (B Wiy | ol RikAmemnen |
The dialog displaysa O Gered | By Ducision | @ acimTepe ¥ Imeedenscion | B P aciom:
Percentage Completed slider
control. m ction [ [ate r? A0 =] dabi e
Hisiovice H-wt'rq,ll [z oo L sy b (b Do by B st
This Slider can be used to : =]
show the estimated level of e R Bt .55 2001

progress for the current status
for the Action Record. The
indicated Percentage figure is
shown on 4TQExplorer’s
Action Records Tab List. _|j

Dl tha rwnanhale o s Fane

|
F-mhﬂdIIT'i”””“.:lﬁ:

Click the Update record button
to save your changes.
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Assigning an Action Target

Each Action Record may be assigned against an asset of the enterprise.

Action Targets objects can include People, Customers, Plant, Equipment and locations. Your Administrator
will have set up the list of available targets objects immediately after installing the applications.

To assign an Action target open the Action Target tab on the AR form. Select the object type by clicking on
the appropriate tab (Individual, Company or Object)

Enter the known details into Commnd Aclion

: Higrd Hissting [ powrment piepais
at least one of the available Tig | T Mt Liooument prepeed bhe Racond Mo £l

field on the selected form. Croons Ho E — | Updete | ]
* darilas rrandstony Gk ol ol
Click the Find button. Fiecoid : Riecod Festesence 10 |
i FelndProcedues | YN Relsddcionr | [ Heow | o Rikdmsnmen |

O Gonwd | By Dmecigion W At Tugs | § ineediandciors | PO Pl Acson:

To reset all the fields use the
teakihaad 10 | Cornguary Inf | Coniaet e | Disect Infu |

Clear all fields button.

Tde Hr T ML pecied = |
Soararm Evplossld |
Fist Posiion T |
Weide e [ |
Click the Update record Do ol 002000 = | ddaddmase " rm
button to save your changes. Eith creorky
Firal Dotz 1 PO 04200 7]

Highlightes] Claspas will e st
=l o Add & Lpcate

Samch dslshaas on Meld vl Chear A0 ik
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Relating Action Records (Chaining)

Procedure | °.-"o..| Action Due | AR Title
.[Nu:u Related Procedure] 0 13/03/2003 Cuskarme
.Creating A standardised Docume,,, 0 10/03/2003 Magnt Me

It is common that when working on an
Action Record you reveal another aspect
of the resolution or a secondary cause that
may require independent corrective
processing.

EEZu:u:urnent A Process

Fetch Detail
Relate to Displaved Action Record

Relating an Action Records

To raise a new Action Record, to manage the secondary issue, add a new Action Record as previously
detailed earlier in this section.

Once the New Action has been created and saved, open (fetch) the initial Action Record and open the
Related Actions tab as shown below.

it the 41QExplorer Action 2lx
Records tab visible, Locate and
right click on the target (new) AR. Cuman cRan (g Mesing epsed Ly Rscard Mol ]
From the context menu select the R
“Relaéf to Displayed Action * denches mendetuay ekl e 4 | Hpdete | S
record”.

O Gieneisd | By Descigion | @ dctionTage | ® invedise dciors | B Fradaction: |

B Fonloimd Proceduaes T Felend Acken: (B Hotow | o Fick Arsmrmen

The Right Click context menu is R .
shown above right. i which Lie Sy ) vaeie (- Drouble Cick on Action

Cutiornes tased i of Lybe rors

Un-relating an Action Record

Locate the Action Record you
wish to disassociate from the
currently displayed AR. Click on
the AR in the list to highlight it,
and then click the Un-relate
button.

]

Click the Update record button to
save your changes.
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Relating to Procedures

ES] Process Reviews

..... W .

The “cause” of the event that triggers the Action Record is
in almost all cases a failure of the “System of Work”
processes to provide the desired outcome. 4TQAR’s ability

Toal
- In oot
o Ci Associabed Fies
2] Systen R File
Fum File Chieck
E] Sample

Wigw 4TQFlow Report

to link back to the processes that are involved in the event
is an important feature that should be used to gain on going
competitive advantage for your organization.

Reports on Review Schedules  #

Action Records

List Selected Procedure Action Records

Properties...

Relake to Displaved Ackion Record

Traditionally, Corrective Action handling as stopped short of locking in the CAR to the effecting Procedures.
This denies the organization the ability to retain and collate the potential derived learning (new knowledge)
catalogued against the “System of Work”. That is to say that the new knowledge is directly related to the
Process Management framework, closing the second level learning loop.

Relating a Process.

Torelate an AR to a
Process, perform the
following with the AR form
open.

In the left side Tree View
window (Procedure List)
right click on the target
process and select the
“Relate to Displayed Action
Record” option.

More than one process can
be related to an Action
Record.

Un-Relating a Process.

To Un-Relate a Process
select the target process in
the AR form’s Related
Procedure Tab list. With the
target process highlighted,
click the Un-relate button.
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Completing the Action Records.

If the cumulative effect of the Immediate Action series is that the Action Record is considered is considered
resolved then the Action Record need to be closed out. This closure of the AR is performed using the Final
Actions tab.

Closing the AR.

To close the AR open the AR form and select the Final Actions Tab.

e Set the “Completed by” field to the person attesting the AR is in fact resolved.

| aToAdimBecordin 2| x
e Click on the New Crarond Acon [t Hestrss Dooomert oiepared 13 =
Entry Tab and click T e o w5l
the New Entry button. CromNow | SamNe pdais
- demobes mendatmy Seid e T
& PebieiProcedues | TN Relwsdacion: | [f Hiew | ol Risk Asmsamant |

e Enter your finding and
validation remarks as
required.

M Gerwid | B Descion | @ AcieTeget | ¥ Ineeddndcion P Fraldcten

sy | Cumpleted by 52ghen Tranmms =] e |
Mistoricel e Eniy |
e Select the Checked

by person from the Edi By Pt Pt
drop down list. Dt T 103 12 34063 20013

Liit the szchire i el e bcair echragoii Bl e B s |
=~ Hhat Thae sobon 1 senkes

You can optionally set the
“Complete Action Review
Date” reminder field to ensure
that a post implementation
review is performed at some
appropriate time.
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Viewing History

: : | aroAction Recordims
The History Tab displays the 2l

life cycle of the current Action ﬂ"":;ﬁm Hgrt Missting Dooument peepased L Racord Hol =]
Record. | e
o ok ek Cimaba Flew I B e M | Uipdsts |
mrandatry Rewosd Feepard Feed mnlﬁ
O Geneisd | By Descipion | @ dctionTage | ¥ inmediedciors | B Feddacion: |
& FolbiriProcedurs | R Relind Acton: 0 Hoew | o ik Arammen:
Each alteration made to an AR, Histoscal Dl Entyy | 2202720031332 FH =]

from creation to completion will
be listed in the order shown on

the drop-down list. L
The Action Records history can
also be printed. See page 101
for further details.
[-]

[ragoniphion, |revesdists & Fredl Scton changesy ran te maiched by date by rekevard pages.
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Printing Action Reports.

The details for an Action Records can be printed to provide a working document.

To print an Action Records select the required AR from the 4TQExplorer list. Right Click and select the Fetch

Record menu item.

On the AR dialog click the Print button. Print Action Record

The Print Action Record dialog, shown on _
the right, will be displayed. Select the Frinter
additional component that you require and

click the Print button. Frint &ction Extra

x|

Syztem Printer [Brather HL-1260]

£ Full T arget Detail
" History Detail
" Related Action Fecords Details

Cancel |

Setup |

Pt Quslty :

Copies I 1 3:

Collate Copiez. @

Creating an Action Record Document

The details for an Action Records can be exported
a set of Word documents.

To create an Action Records document, select the
required AR from the 4TQEXxplorer list. Right Click
and select the Fetch Record menu item.

Generate Word Document

Dacument Extra
I Tiarget Detai
¥ Histary Detai

Cancel |

to

The General Information Report is always created. If you require the History Detail and / or the Target Details

documents check these two optional items.

On the AR dialog click the Document button. The Generate a Word Document dialog, shown on the right,

will be displayed. Select the additional components that you require if any, and click the Print button.

Your Word Processor will be started and the new document(s) displayed. Each Document will be in a
separate window. Dependent on the Version of word you are using you may have to select each document

in turn to view the reports.
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Compliance.

R6N

Ensure business outcomes with directive
Policies.
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4TQPolicy: Managing Compliance.

4TQPolicy is an optional module designed to manage the important links between the organization’s
Strategic Objectives and imposed obligations, the management system that drives them and the actual
System of Work that delivers the outcomes.

4TQPolicy deals directly with the governance and directive control of the organizations work.

The diagram right shows the normal
arrangement where individual
obligations (Laws, Regulations and
Standards) can be handled in many
ways. To make matters worse the
directives can be delivered in many
forms, like Policy Manuals,

Guidelines, Memo’s and staff training.

In one case, a specialized
manufacturer had to comply with 16
standards based systems. The
number of clauses (directive
elements) totalled 1,346. The
representative lines on the diagram
(right) need to be more like
superhighway to cope.

OBLIGATIONS System
Laws |-—______|_ of .
\ ——planagement
|_ P R Ci= |
!tnnllm':lﬁl 4
\ %
Contracts || * 4
\ I
L+ \ '""i System
|
Plans |~ \“H | of
e = ,,! Work
L

The sheer number and complexity of the external obligations alone imposed on a business can be an
overwhelming challenge to effectively manage (govern) on an on going basis.

4TQPolicy acts as a repository of the company’s source obligations and allows the common elements from
individual obligations to be consolidated into an integrated Policy set. This Policy set can be further refined
and tuned by 4TQPolicy multi faceted Risk Assessment for each Policy Clause.

The Policy information is available as a complete document and to the other 4TQTools that are used to
control the compliance issues within the “system of work” itself.

The second diagram shows the
unifying effect this has on structural
connection between the obligations
and the actual work performed.

The result is a clearly visible
connection between the business
drivers and obligations through the
consolidated outcome directives
(policies) to the ultimate outcome
delivery point in the actual process.
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Contracts
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Plan and Policy display modes.
<

4TQPolicy always opens in Plans mode. To toggle between two modes click the button on the Toolbar

or use the main menu’s Mode item.

Plan mode is used when you are working with your source obligations like Quality Assurance system

(1ISO9001 AS9100, etc), or Laws, Regulations, contracts and business plans.

Policy mode is used to consolidate (and map) the Plans into your organizations Policy Set (Manual).

Logging In ATOPwlicy Login x|
When 4TQPolicy is first started, the user is presented with the p =

login dialog shown on the right. The default password is

axion15. Easowand reguined for [stsbase soceds
Enter the 4TQPolicy password. [ lean | cacs |

After failing four login attempts the application will close.

Changing your password.

To change your user password select the Change Password -> T =
4TQPolicy Password item from the Plan menu. Enter your current -

password into the top field and press enter. Then enter and confirm the new
password and click the OK button. e e

Cobeafanmed | 000

Thas u e Hes Faased o tha ATOPAS il

| cud |

Following successful database login, 4TQPolicy automatically retrieves all existing Plans, which are then

displayed in the Plans/Systems window, each Plan/System occupying a separate Tab page.

L T Plana B Policy Manager

Flan Gdt Mode el

=101

Pl Sh i t4++ x 0=

PrantSysiem CIANEEE [ Caagoe: =]
[E5014800 | F]ASSIBIA | T is0am01 ) of

O 0 assone SECTONT
n 1. SODPE
011 Gersas
012 Asphcation

—u EETCddd TE T = Kr

Selected Policy Stabement Format

Of 150 S000-2000°

“EUALITY MANAGEMENT SYETEMS - AEROEPACE - REQUIREMENTS BASED
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Plans Mode

Adding Plans.

To add new Plans or to edit existing Plans ensure that 4TQPolicy is currently in Plan Mode. Set the Mode via
the main menu Mode option.

To add a new Plan —

e Go to main menu Plan and select Add Plan

e On the dialog, enter the Plan Abbreviation and Full .
- x
Name fields
e Optionally you can assign the Plan to category Pl Abbiavisi |.u: iy

group. By default, Plans are assigned to the All

i P g QUALEYS o 1503007
Categories group.

e Press Insert Plars kil e [Pl Pl Tie

fe g Ciisfuiiy O |
e A new Plan page is automatically added with the : S

details defined and Plar: Cat [ Cargered =]
e A New Clause label is inserted ready to build the Pl nawy calmgon of selact masting]

new Plan upon

puet | Laced |

To edit the title details for an existing Plan —
e Select the Plan page
e Go to main menu Plan and select Edit Plan
¢ On the dialog, alter the Plan Abbreviation, Full Name fields or assigned category as required.
e Press Insert

e The new Plan details are displayed

Take care when altering existing Plan details. These details are used internally as reference points for Policy
Mappings and may be lost if changed.
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4TQPolicy: - Importing Plans

Your installation 4TQ CD may have included and installed standard Plan outlines ready for you to import into
the 4TQPolicy database.

These plans are located in the 4TQ SystemPath Records Folder and have a filename /extension of
PLAN_xxxxxx.CSV.

To import a Plan. CELTEEE— EIET
Lok | - Fsoahs H ~moD

|| PERLACEWENT_FLEE
IFLAR_AIF - TAR-AEC FO0E.5
PLEH, _ALF-TAF:-AMC_ZDED. ors
FLAN _BECRIE: [4x
PLEH R4 EL] . oy
PLEM _BiEx_Pisin_Fywey _Prinocor
PLAK 13011400 | 2
FLAN 150 L2 o

1. Run 4TQPolicy.

2. Select the Plan Mode.
Ensure 4TQPolicy is in the Plans Mode.

3. Start the Import Operation.

Select the File -> Import Plan menu item.

4. Select the Import File. Fapes  [EXNER = [oee
Select the desired Plan (csv) file. . m&ﬁ_ — =
The supplied files are located in the SystemPath/Records folder and P A [PEEERET
have the CSV file name extension. np DALY w LR

Fanidawe |35 ALNEPALL AL
5. Add the Plan Names. i Sty v
Once the required file has been opened, the Import Plan dialog will be L 3
displayed (shown right). Enter the Plan abbreviation title and the Plan full PR Y T—.
name title. Optionally, you can assign the Plan to Category group. Bewilasin |

P Fuld Tolar [ ol s P Liiser
. Cigwrs Labei

6. Set the column assignment. Lia e ot Srarmrars [

The supplied import files are formatted so that column one contains the
Clause number (eg. 1.2.3), while column two contains the Clause label
and column three the Clause statement. In the supplied files, the
Statement column is blank.

The default settings of the dialog suit the column assignments of the
supplied files. To import from another source file, first check the column usage by opening the Record Detail
dialog (shown on the lower right) to view the contents of each field, make your assignment by altering the
Column selection thumbwheels on the Import Plan dialog. TeTTE

| [T
o e I =

Click the Import button when you have assigned the column to suit [T i
the file’s structure. s EhisA (LR 1S OFIFRLE LB

Note: The Clause Label is restricted to 127 characters.

7. Save the Plan.

Use the File menu Save Current Plan to Database item to save the o]
imported display plan into the database.
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Adding Clauses to a Plan

To add more Clauses to a Plan, simply select the existing Clause at which you intend adding and right
mouse click on your selection. Move the mouse pointer to Add Clause and then select either Peer or Sub-

Clause. Peer Clauses are — added
at the same level as the =10l
initially selected Clause. Sub- S S Mo Beb —
Clauses are added as |ﬂ' via Bl 4+ &4 x &
children to the initially PlanfSystem Clauses [ Csepres =]
selected Clause. [ 014007 | Hll"-smml T{[|3|}5M1] ol F"LAH.!I.BB‘LI‘]l

O o
Note: that the context menu Cwlet e : also
allows you to alter the text for e the
selected Clause (Rename), and to
Delete the Clause. Deleting | the
selected Clause also deletes selected Policy Stalement format any
associated child Clauses.

Editing the Clause list

Copying, moving and deleting Clauses. | 34X |

Standard editing Cut, Copy and Delete Item functionality is available by selecting a Clause and going to the
main menu Edit option. Each Edit feature operates on both the selected Clause and any associated Sub-
Clause.

The Paste Item is enabled only where suitable Clause information is available for insertion. Paste Item allows
the previously stored Clause information, stored via the Cut ltem or Copy Item options, to be inserted at the
selected Clause as either a Peer or Sub-Clause. Pasted Clauses are always inserted at the bottom of the
relevant list. Use drag and drop operations or the outlining buttons on the Toolbar to place Clause at a
specific position.

Drag and Drop functionality is also available and operates on both the selected Clause and any associated
Sub-Clauses. Select the Clause to move, and then place the mouse pointer on to the selected Clause and
with the right button depressed, move the pointer to the target Clause where the selected Clause is to be
moved. Then release the right mouse button. The selected Clause is inserted as a Sub-Clause of the target
Clause. If the target Clause has existing Sub-Clauses, the moved Clause is inserted at the bottom of the
Sub-Clause list.

To Drop a Clause at a specific target list position, press the Shift key down before releasing the right mouse
button. The moved Clause is inserted as a Peer to the target Clause immediately after the target position.
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Edit/Add clause statements.

The associated Clause Statement is automatically displayed for the currently selected Clause, in the
Selected Clause Statement window.

The statement editing window
Text field and can accept the
images and diagrams.

Take care when inserting
images as the embedded file
very large.

Try to select and copy your
format that handles the
information displayed in the
efficient way.
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=100 =]

Flan Gdt Mode el

14001 | 049001 | ASSD01AS? | ASSO0IAS] | AGED CARE | DISABILITY
PPSSI | 5ABS | SaFETYMAP | aE0 | 3806 | apo1 | mpp

ol &h wE |
Flandewses | = w4 o W [l | | Categonies - _

#H [ 0 Sieienis - Derensl

H- 0 1 STAMDARD 1 Commiman s Polcy
H- [ 2 STAMDARD 2 Flsnning

4+ [ 3 STAMDARD 3 Impleresrintion

# O] & STAMDARD 4 Metdrernent & Evaltion

- O &S 1AM0ART & Marsgsmant Syrteme Feaens: s improvsman
[ 51 Bemesnt 1 Frlcy

D 5.2 Baresnl T Obgeobiees, Targets and Pesrormanos ndcalors
] 53 Bemen 3 Srsiem Revies

_

Stabeweent for Sebected Qe | Edt Fomat Dpiiors

| v =] BrUlleFEA =P

The crgasizalion should regubscty review Srd Conbinually imgeis L2 syslems.
Thig leads 10 ke deselopment of conlinuous imprisemen] Sirategiss witfn tha
argarisalion

SCOPE: The anganisalion rmgulatly reasws iz
slgsupalions Hasllh Safly &d Walhns,

wrefiabiltalion and clms manepemenl syslems

®in congullalion sith ils employess or ther mprasanalives,
wwilks the abjective of improsing reerall pedammansce

is a Rich
pasting of

(pasting)
may be

image in a

most

Page 109 of 131



Saving Plans

o1 AT Plsns B Policy Manager
Plan EdE Mods Help

Plans may be saved either individually or all at once. An asterisk

Plan page tab label indicates that the Plans requires saving. ::;: "
Sevwe urrerk Flen ba Datubers
Attempted application close causes 4TQPolicy to check all Plans [T ——
requirement. In this case you will be warned of Save requirements A
close. Pl Catigors Conte...
“hange Pasoenrds.
Save Plans through the main menu Plan item using either the f__‘;"ﬂmmm
Plans or Save Current Plan option. Note the ‘current’ Plan is the
Esxport: b 4 TCmn, 141

currently displayed.

If you are overwriting an existing Plan (with an updated version)
asked if the save should overwrite the existing records or create
archived copy if the existing stored Plan first.

Deleting Plans.

Dozt iPha o 4 Tosudnnin TR .
Iriesiid Cleee Locshor ...

Exk

(*) on the

for a Save
prior

Save All
Plan

you will be
an

To delete a Plan, make the Plan ‘current’ by clicking on the appropriate tab label so the plan details are

visible. Then, from the main menu Plan option, select Delete Plan.

Publishing plans.

All Plans can be exported for use by 4TQExplorer and 4TQFlow within the Compliance Issues Properties.

To Export a Plan, Save the Plan, using the File Menu -> Save Current Plan to Database or Save All Plans to

Database items.

The dialog box, shown below right will be displayed.
the Plan(s) click the yes response button.

T enskds 470 Flos wred 4T 0 Esploter 1o aocess
this Plary e mitemaston maposted

mut b

Sulomatcaly sspo Plam ot completon of St

It would be usual to respond “no” to this dialog if the
to be integrated into the Policy set.

s |

™ Aoy Export Flans on Saves fov this ssezion

x|
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Policy Mode

Policy Mode Windows.

The policy mode window is divided into four areas.

The Derived Policy area (top left) displays the selected Policy set collection as a Policy tree made up of

sections, clauses and sub-clauses.

w470 Plans B Policy Manager

The Selected Policy Fokcy Gt Mods sl

=101 =

Statement area (bottom left)

[cD &8 i t 4 ¢ x B |

accepts and contains the
clause details for the clause
label currently selected in

[rerived Policy

= ’ Curmird Pobey
= ' i yrshiresr Rerparmmenids.

Exporied [

Policy Tree. This field = [ et e
accepts Drag and Dropped [ asubcuse
P & s seaion

' Hurrain Rescirces

Sebected Policy Sintement _ Format |

{6 Map €4 | PlanfSyelem CHUSES |Sandss

15040012000 | A53806 | AS4801 | 15014001 |
+ [0 & QUALITY HAKSSEMENT SvSTE

£ [ 5 WeRASEMENT RESPONSELITY

-] & RESOURCE MAMACEHENT

F- [ 7 PEOCISE MAMACEWTRT

+- [0 8 HEASUREWMENT, 2MALYEE and MPRIVEMENT

the

text.

Uabiap | Sebected Policy Mapped Cla

owr Clause slslement is rocosded

here.

o [ EE0S001: 3000 ) Gusity Manegement Gyshen

Policy types.

The Policy is a single document set derived from (mapped against) a

number of obligations (Laws/Plans/Systems).

There are 3 types or phases for a Policy.

Each Policy type can be opened via the main menu Policy item.

Draft Policy.

This is an unpublished Policy version undergoing construction. The Draft
Policy is most useful where construction is undertaken over multiple
sessions, or where a new Policy is under formation but not ready to

replace the Current Policy.

h.|- 1T} Plans B Policy Manager
Pokcy Edt Mode Hsip
P Policy
Oy Curriid Polsy frof Dl alidds
sy Dot Foicy Froen Dustatass
Copman Pask Poley from Ciast shasm. ..
Sl 5 Curreni PolCy (D Datsbass

At any time the Draft Policy may be Saved As and replace an existing Current Policy.

When you need to change a Current Policy load the Current Policy and then save it as the draft. Then open
the draft policy and work on the draft copy until you are ready to publish it as the new Current policy.
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Prokey Saem oplone

Current Policy.

At - ey ol el Cimed dababue )l DOnShon

]

wil o a e e Gichron B bod Lala 4TQF|0W

This is the published Policy that is referenced by both biradbekon ol |
and 4TQExplorer when exported. i\ ok I bseps daisbase uze o 8

AL

This export happens automatically when a Policy is save Oveivaie : ssplscas B daishase Cussnl Pakey sl as the

"Current Policy”. e e o Cusrend Py

[[Rhe |  Ovemis | Coesl |

When using the “Save As Current Policy to Database” you can choose to archive the existing “current”
policy” or to overwrite it without creating an archived or “past” policy. You should only choose not to create

the past policy records if the changes are of a minor (ascetic) nature

Don’t work on the Current Policy live. Make your changes and alterations on a copy of the current policy that

has been saved as a draft policy.

Past Policy.

i X
Past Policies are automatically created each x| time the
Current Policy is superseded. This occurs each B el e e e e T s eyt - time the
Current Policy is modified and Saved with the Archive
option selected. I 3/04/2003 j
ar

[ List all available Past Policy
Neither Past Policy nor any associated -
Statements may be modified. This allows for Cancel | future
reference to an “old” Policy that was in force at a specific
time.
Past Policy are located by the date range in which it was =|| Current.
To select the Policy that was in force at a particular date use T the
dialog shown on the left to enter the required date. Sl Pt Policy ko cpwn

Gpen |  Canca |
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Creating Your Initial Policy.
The 4TQPolicy application is supplied without any policy records.

Adding Policy Sections.

Policy Sections are used to divide a ﬁ :
comprehensive total company Policy into separate . SEE

parts. e Paste Clause/Branch Peer-Clause
. . . EI Sub-Clause

For instance a Policy may have sections Cielete Item

pertaining specifically to Quality, Environmental or Fename Ikem

Safety issues.
(o g Zet Review Date. ..

To Insert a Section, select a Policy item and right Risk Acsessment. .

mouse click on your selection. Move the mouse
pointer to Add Section and select. You can enter your own required section name or, select a section name
from the drop list provided.

The section can be deleted or renamed by selecting the required option from the context menu.

Scheduling Reviews for Policy Sections

Both the entire Policy and individual Policy Sections can be set for Review.

Select the top item, for Policy reviews, or a Policy Section item, and right mouse click on your selection.
Move the mouse pointer to Set Review Date and select. Set the date for Review and press OK. You cannot
set a date earlier than the current date. Note that the database detail is updated immediately on OK.

The label associated with the selected item will indicate any set Review Date. The label icon will
automatically change to include a red border when the Review date matches or is earlier than the current
date.

At which time the Review should be carried out and a new Review date set.

Adding Policy Clauses

To add Clauses to a Policy, select the =- ﬁ Current Palicy

existing Clause to which you intend El s h =action

adding, and right mouse click on your Fi
selection. Move the mouse pointer to Add | Pasie Cla"'semra”':h Beet-Clause

. o Sub-Clause
Clause and then select either Peer or |; Delete Ttem - lause
Sub-Clause. L g a

Rename Ikem

Peer Clauses are added at the same level o g Hurnan _ as
the initially selected Clause. Sub-Clauses oft Review Date... are
added as children to the initially selected Risk Assessment. ..
Clause.

Note that the context menu also allows you to alter the text for the selected Clause (Rename), and to Delete
the Clause. Deleting the selected Clause also deletes any associated child Clauses.
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Saving the Policy.

Saving of Policy is through the main menu Policy option.

Draft Policy

Normally Policy opened as Draft is saved as Draft. However, in some circumstances a Current Policy may be
saved as Draft prior to alterations being made, acting as the base of the proposed future Current Policy or, a

Draft Policy will be saved as Current Policy when completed and ready for deployment and use.

x

Current Policy Py S oo

Using the Save As Current Policy option will supplant the Current achéer . shores ol Hee cunent detabaes Fiomaton
wil o a aep e Sichren B bo Lale

Policy with the Policy information displayed on screen. The B e T o el
superseded Policy may be s re-saved as a Past Policy. i s 1o hoses dalabisss 2 b 4
Dewtivaile « ceplacet Fu dalshase Coserd Pokizy st
tha spphc sion Cunend Folicy

The displayed Policy will become the “Current” Policy. It is the
published Policy that is referenced by both 4TQFlow and [[Huchw |  oversis | Coresl |
4TQExplorer if exported.

This export happens automatically when a Policy is saved as the "Current Policy”.

When using the “Save As Current Policy to Database” you can choose to archive the existing “current”

policy” or to overwrite it without creating an archived or “past” policy. You should only choose not to create

the past policy records if the changes are of a minor (ascetic) nature

Don’t work on the Current Policy live. Make your changes and alterations on a copy of the current policy that

has been saved as a draft policy. Past Policy Locator x|

Enter date where required Palicy was Current -

Past Policy I /04,2003 j
Past Policy and associated Statements are read only. or
They cannot be modified. This is a security feature to I List all available Past Palicy

enable future referencing of a past Policy set at a
particular time.

E Cancel |

Past Policies are automatically created each time the Current Policy is (e oyt |
superseded. This occurs each time the Current Policy is modified and e e e
Saved with the Archive option selected. et it Py b e

Neither Past Policy nor any associated Statements may be modified.
allows for future reference to an “old” Policy that was in force at a
specific time.

Past Policy are located by the date range in which it was Current. To
the Policy that was in force at a particular date use the dialog shown on
left to enter the required date. | S

This

select
the
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Mapping Plan Clauses to Policy

Plan Clauses may be mapped to Policy Clauses via a number of methods.

Mapping Plan Clauses to existing Policy Clauses

After creating a Policy Clause via the context menu Add Clause option, to map a Plan Clause-

e Select a Policy Clause

e Select a Plan Clause

° Press L4 MHE L I

The mapped Plan Clause is listed in the Selected Policy Mapped Clauses list, the << Map << button is
disabled. Note that Sub-Clauses are not automatically mapped.

A tick E'in the icon associated with Plan Clause indicates a mapped Clause. A double red tick indicates
plan Clauses mapped to more than one Policy Clause.

The M button is disabled if a Plan Clause is flagged "Mapping not Required to Policy".
Using this method does not map any corresponding Clause Statement.
To Un-map a Plan Clause from a Policy Clause-

e Select the relevant Policy Clause

e Select the Clause to un-map in the Selected Policy Mapped Clauses list

e Press UnMap

When a mapped Clause is selected in the Selected Policy Mapped Clauses list, the relative Plan Clause is
automatically selected in the Plan Clauses window.

Note that only list Clauses marked are locatable. Clauses marked are missing from the list and require re-
mapping.

Use the Find Mapped Policy Clause option on the Plan Clause window context menu to locate Policy
Clauses to which a Plan Clause is mapped.

Locking the Mapping not Required option.
Also on the Plan Clause window context menu is “Mapping Not Required to Policy” option.
Use this option to indicate that, for this Policy the selected Plan Clause does not require to be mapped.

The icon of a non-required Plan Clause appears.

This is only a visual indicator to allow the user to quickly assess his/her progress. The option is disabled if
the clause has been mapped.

On selection, the user is asked if the selected Clause only or included Sub-clauses are to be tagged as Not
Required. Only unmapped Sub-clauses will be set to Not Required.
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Copying Plan Clauses to Policy
To copy a Plan Clause to the Policy-

e Select the Plan Clause

¢ Right mouse click on the Plan Clause for the context menu
e Select Copy Clause

e Select a target Policy Clause

¢ Right mouse click on the Policy Clause for the context menu

e Select either Peer or Sub-Clause (whichever is required), from the Paste Clause/Branch option

The mapped indicator for the Plan Clause is checked, and the mapped Plan Clause is listed in the Selected
Policy Mapped Clauses list. Note that Sub-Clauses are not automatically mapped.

This form of mapping does map any Plan Clause associated Statement to the Policy Clause.

Copying Plan Branches to Policy

To copy a Plan Clause with its Sub-Clauses to the Policy-

e Select the Plan Clause.

e Right mouse click on the Plan Clause for the context menu.
e Select Copy Branch.

e Select a target Policy Clause.

¢ Right mouse click on the Policy Clause for the context menu.

e Select either Peer or Sub-Clause (whichever is required), from the Paste Clause/Branch option.

The mapped indicator for the Plan Clause and all relative Sub-Clauses are checked, and the mapped Plan
Clauses are listed in the Selected Policy Mapped Clauses list.

This form of mapping does map any Plan Clause associated Statement to the Policy Clause.
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Policy Clause Risk Assessments.
Eﬁ Current Palicy
El g Palicy Section

Each Clause within your Policy can have a number ; of Risk
Assessments recorded against it. Each Assessment o @ ﬁ fdd 3 is
performed from a different perspective. Paste Clause/Branch
Delete Ikem
To add a Risk Assessment to a clause right click on Rename Ikem the
Clause label and select the Risk Assessment option _ from
the context menu. st Pz Date,
Risk Assessment. k
The Risk Assessment Dialog will be displayed.
Creating a Risk Assessment record.
Open the Risk Assessment dialog as detailed above.
e ]
; Mk Comuckstsben FET =| ]
Use the drop down list to select the :
Risk Consideration or viewpoint. Each Contech Mk P, O Coinih | Timsimn
clause can have many viewpoints. ecatn s . o ey 15 arpcivn
|

To add a Risk Consideration that is R
not on the list, select the <ADD i : ‘ PO S
CONSIDERATION> option and then ' -
complete the popup dialog. i I

F Topatas o lak 0a on

i r il et ki ek oo
. . —

Now enter the details that explain the [ T
actual Risk. In the “Describe the Risk”
Tab 1 -mrﬁ?-mm Ugdos Fearen Bassd o 08 Bae m

r I ﬂ"-‘dﬁ‘h‘:‘lﬂi;lﬂ“l ah Lls |
You can record the Current Control i i P Pt

and the Treatment method details on
the remaining tabs.

To set the assessment values move the Slide controls to the appropriate positions. To include the Duration
value in the risk calculation tick the duration check mark and position the slide as required.

Press the Apply button when you have finished.
You can add other Risk Assessments for other Consideration if required.
Click the Close dialog to close the Risk dialog.

When a Clause has one or more Risk Assessments attached the Clause icon changes as show on the left.

Risk Register Report

To generate a Risk Register Document (report) click the Risk Register Button. The report will be displayed in
your Word processor.

4TQToolkit User Guide Page 117 of 131




Publishing the Policy to 4TQ.

Both Plans and Policy can be are referenced within 4TQExplorer and 4TQFlow (Compliance issues

Property).

The Current Policy is automatically exported to 4TQExplorer and 4TQFlow each time it is saved.

Printing the Policy Manual.

& 470 Palicy Entire Policy and Plans, or parts of Policy and Plans can be printed out in a
standard format.

Pobcy Edt Mods Heln

Moy Pobcy
Under the main menu Plan or Policy item, select Print.
e Ad et wmw'm The Print dialog allows you to set page headers and footers. The default
Lo dig Draft Poloy o Detabass header and footer is derived from information supplied during 4TQToolkit
I , | installation procedure.
m&nﬁ
Mapping Matriz: (Eceel) 3
Pk Begarts (Excall B
v e Locator... You can also select the Print Range and include Clause Statements as
Exit required. The options available are shown in the dialog below.
Prist Polcy L

Frnker

Harm  [Evothe: HL1250 =| Bropesbes |

bss  Fieady

Troe  Biothes HLAED

hess  LPTE

Corerant:  HL1ZED on S TO0

Fagir Husaadei L Foobsi

Header  |Prbcy of Yous Company Hame

Fookw  |I=| Company Kamel

Fobcy Prist 1ange

% Entin Pricy

™ Sebsciid Seckon

™ Gebeoied Clsse

¥ luhoads Sl

[ luhads Rk Azpeesvertt

. G:m.l 1

Mursbesr of gopees: || 3—

W | Cogliain
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Policy Document Generation.

ke AT0 Policy Policy and Plans can also be generated as a MS-Word document.

Polcy Edt Mods  Help
Piewy Pobcy
required.

Save A Current Pobcy o [atabass
Sarwe fus Draft Policy to Ouskshass

e Fussmond b
Frirk
Fapging Matrix (Excil) g F
Fask Reports (Excal) ¥

Exat

You can further refine the format of the
generated Document by attaching the
Templates.

The default templates are located in the
Macros\Word8 directory, and the styles
contain is applied to the generated

The supplied templates are designated

The Dialog below shows the options that are available.

Cearate Docmaeat 3%

San | ‘3 Pleooick

=]~ @

L IRERLACEHENT PILES

Flapame.  |Poboy of Company Hars

Sve 88 per i Doscuweid [* doc)

Py Deaiisresrd Fonge

¥ Eiing Policy

1 G S

T Gusteohed [leins

' Inchuds Sistamani=

b Inchude Rk desesmens

i Pk T G "

Do Tarplale | TOFOLY oot
Lo zreend Informastion

Haada  |Poicy of Compang Hame

Facded |I|.I Commpary M ainé

P ||:l!'ﬂE'l!l Hsnage

Similar to the Print dialog, header/footer and Range options can be set as

Word

they
document

4tgpol1.dot and 4tqpol2.dot. Modify the heading styles in the templates to your own personal requirements,
or add additional templates using the 4tgpolx

.dot naming convention and install them into the Macros\Word8 directory.

For new templates make sure you copy the AutoOpen macro as in the supplied macros.

Once you press Generate, MSWord opens with the generated document.

Further format as required prior to saving and distributing.
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Mapping Matrix Reports

To create an Excel Workbook matrix of the mapping between the Policy
Polcy Edt Mode Heb Clauses and the Plans select the Mapping Matrix item from the File menu.
Mewy Pobcy
: Then select from the file menu’s sub menu options “Plan per Sheet” or “All
Plans on one sheet.

Sava Aa Currant Doy o Datsbass
Sawe g Draft Policy bo Cuskaboess

mpim *

Wait for MS Excel to complete building the Workbook before continuing.

Prirk:
FENET e DoCument

[ uspgtinis o)+ S

Rk Eleparts (Excel) L)

Irrealid Ose Locaton. ..

Exat

Risk Reports

To create an Excel Workbook matrix of the mapping between the Policy
Folcy Edt Mods Help Clauses and the Plans select the Risk Report item from the file menu.

sy Policy

Then select from the file menu’s sub menu options,

Servm g Current Policy to Dk sbase o Matrix of all Risk Categories per Clause.
Sawe s Draft Policy bo Duskabses
¢ Rated Clauses against the Greatest Risk Categories,
Orusfegi Paridsacids *
— e Rated Clauses for all risk Categories.
Gener ke DoLment
Magyping Matiiz (Exoe] *

Y 1 e o e

Rated Clauses per Risk Category (per page?

Exat

Wait for MS Excel to complete building the Workbook before continuing.
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Locating invalid Clauses.

Following the export of either Plans or Policy to the rest of the 4TQTools, prior Compliance Issues references
to 4TQFlow procedures may become invalid. For instance, where a Plan is deleted or a Policy clause is
superseded, the individual Clauses referred to by a particular procedure files are °

disconnected. T —— -
L P g | [T g
Fai b i i = e i |i'|r.-|||:'r| P L T e Lo

Using the Invalid Clause
Locator dialog.

Under both the Plan and Policy main
menu item, the Invalid Clause

Locator... item displays the Invalid
Clause Locator dialog. ook ko Pt o B T R

& Cimaeme Hisd 1, Bl W

To use the dialog to locate invalid Clause references, first press the Locate Procedure Directory button to
open the directory containing the 4TQFlow procedure files to be checked.

On selecting a directory, each referenced Clause for each procedure file is checked to ensure it exists in the
current 4TQAdmiIn.INI file. The left hand window displays the title of the procedure files checked. If “Show
Invalid Procs Only” is enabled, only those procedure files having invalid references are listed, otherwise all
procedure files in the selected directory are listed.

The right hand window displays a list of invalid Clauses found for the procedure file selected in the left hand
window. The first column shows the Figure ID pertaining to the figure referencing the invalid Clause.

With “Show Invalid Clauses Only” enabled, only those Clauses referencing an invalid Clause are listed,
otherwise all Clauses for the selected procedure file are listed.

Selecting different Procedures in the left hand window will cause the procedure file Clauses to be checked.

Double click on the procedure in the left hand window to open it in 4TQFlow and remover the invalid
reference.

4TQToolkit User Guide Page 121 of 131



4TQ HACCP Module

PROCESS MANAGEMENT

4TQHACCP Module Overview.

The 4TQHACCP module is based on the seven principles of HACCP according to the Codex Alimentarius —
reference Food Hygiene Basic Texts (1997) and is designed to work as an optional add-on module to the
4TQFlow process mapping and documenting tool.

The 4TQHACCP module supports both food safety (from the Codex) and optionally food quality hazards to
provide a single system to manage the overall production of food products.

The Process Map outlining the Codex’s application via the 4TQHACCP module is presented on the next
page. lIts source 4TQFlow file (HACCP_LS.flw) is available in the samples folder of your 4TQ installation.

Use of the 4TQHACCP module requires that you have recorded the production process for the food product
in line with Codex’s core Logic Sequence before performing the Hazard identification.

Terms used in this section.

CCP = Critical Control Point for Food Safety.
CQP = Critical Control Point for Food Quality.
CP = Control Point for Food Safety.
QP = Quality Point for Food Quality
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Logic Sequence Map.
0

ISSN 0259-2916 (2001)
Logic Sequence for the Application of HACCP (Adapted.)

Start chart
Version Owner FAQ/WHO Food Standards Programme

Created 14/08/2002  Modified 08/03/2003

1 2 3

Identify and list all
Assemble HACCP team Products. Describe each Product.

4l 5 6

Identify the intended use On-site Confirmation of
of each Product. Construct Flow Diagram flow / process diagram

7

List all potential hazards
for each process step

8 9
Conduct a hazard Consider Control
analysis for each Measures for this
Step/Hazard. Step/Hazard

10

Determine CCPs (use
Decision Tree)

Is a CCP
indicated by the decision
tree for this

Is there any
more hazards or Steps?

14
Establish Critical Limits Establish Monitoring
for each CCP System for each CCP,
17
16 15
Establish Documentation Establish Verification
Are there more Products? and record keeping Procedures
Yes

Sequence pass complete
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The 4TQHACCP Form Window

ﬂ
§3SLREY

FP saved.

o

To open the HACCP Form place the mouse cursor on the required Step in
the Production Process (4TQFlow Process map) and the right click on the
figure. Select the Data>HACCP menu item to open the HACCP form.

NOTE: The Data menu item is not available if the process map has not been

If there is one or more existing Hazard for this process step then the first record will be displayed. The
number of Hazards for this step and the current record number are displayed on the upper left of the form.

Use the record selection controls to move between the records.

If no Hazard records exist for this process step the
fields on the lower tabbed portion of the form will be
will be grayed (un available for editing).

The HACCP form has the View - Keep on Top”
feature set as a default and will remain on screen
even if you return the 4TQFlow window.

Use the view menu item if you wish to remove the
“On Top” setting.

The Upper portion of the form is always read only
and the fields are grayed. Use the Tab fields to enter
your information.

To enter a new Hazard condition. (P1)

To add a new hazard condition Click on the [+] Add
Record button.

Hlilbllll
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|
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e — | =
b e | Pericad Codaan
' i
Srrerrwand Mol
'l_---.-nu el mpparts e e arad Lbadhacd sirg =}

In the Hazard Field enter the details of the hazard condition on the Principal 1 tab.

Use the check marks to indicate whether the hazard is related to Food Safety or Quality. This information is
used along with the decision tree to decide if the Hazard is has a CCP or CQP rating. The Food Safety Radio

button is pre-selected as the default.

You may save the record at this time by clicking the save button El on the form’s toolbar.
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Assessing the Hazard Impact.

The Hazard Impact slider has three possible “settings, Major, Moderate, and Minor. Set the slider to the
appropriate setting for this hazard. The table below may be used to guide your decision.

IMPACT > Major Moderate Minor

unlikely people will get

people WILL get sick may effect people sick (or suffer injury)

Food Safety

(or suffer injury) mildly
unlikely there will be a
. there WILL be a major may be a quality lity fail
Qs quality failure failure quality tarure

Assessing the Hazard likelihood of occurrence.
The Likelihood Slider as five possible settings, Almost Certain, Likely, Possible, Unlikely and Rare.

The slider positions are translated to the instruction shown on the upper portion of the HACCP Form. The
form of the instruction is “You MUST/MAY/SHOULD use the Decision Tree” where the directive modifier is
substituted based on the results of the assessment. The table below shows the method used to make the
assessment.

If you decide to proceed with the Decision Tree click on second tab to continue.

Calculation method.

Major (5) Moderate (2) Minor (1)
Certain (5) 25 10 5
Likely (4) 20 8 4
Possible (3) 15 6 3
Unlikely (2) 10 4 2
Rare (1) 5 2 1

Above 7 = Decision Tree MUST be performed. (Key word = MUST)
Between 6 and 3 Decision tree is optional. (Key word = SHOULD).

Below 4 Decision Tree may not be required (Key word = MAY).

Assessment Note.

The Assessment Note Field (bottom) can be used to record the reasoning or known facts used to support the
Impact and Likelihood setting. Note this field in not included in the reported HACCP Report Table.
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Performing the Decision Tree analysis. ho[» 1] =] wl] 7]

(P2)
Roced 1 "o T Fwewm
The Decision Tree is used to determine the rating of Franig r|
the Hazard. =l
ligrmg ey oed T T o o Dl Hoaad 7
Duasion ol d@ haimd |
1

Click on the second Tab (Principal 2) to display the

Decision tree for this Step- Hazard condition. et ey M.
Pawpa | P | Femssl 1§ P 0% | Faregal &7

Answer each question in turn, start with the top e L

question first. As you answer a question the Prwitech i i s e b i T

availability of the following Question will change to -~

only show the questions that are still valid. Always

answer the questions in order, starting from the top of -

the list. F
Himg |IF

The Rating indicated by the decision tree can be
overwritten. Note, if you change the Rating by hand and then alter the Decision Tree’s answers the Rating
with be set as dictated by the Decision Tree logic.

If a control measure has been added (Principal 3 tab) and you have answered “No” to the last question (Q5)
then the Rating will be set to CP/QP. The table below shows the hazard rating results for all conditions that
are possible.

Note that the results are modified for non CCP/CQP conditions if you optionally decide to enter a Control
Measure on Tab 3.

Hazard Rating Truth Table.

Decision Safety Quality Safety Quality Status
Tree
No Control Measure With Control Measure

Q1 No »Q2 »Q2 »Q2 »Q2 Incomplete
Yes »Q3 »Q3 »Q3 »Q3 Incomplete

Q2 No Not CCP Not CQP Rating Done
Yes MODIFY MODIFY MODIFY MODIFY Warning

Q3 No » Q4 » Q4 » Q4 » Q4 Incomplete
Yes CCP CQP CCP CQP Rating Done

Q4 No Not CCP Not CQP Rating Done
Yes »Q5 » Q5 » Q5 »Q5 Incomplete

Q5 No CCP CQP CCP CQP Rating Done
Yes Not CCP Not CQP Rating Done
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Decision Tree Map.

Hazard identified.

ISSN0259-2916 (page 44)
HACCP Decision Tree (CODEX ALIMENTUS (2001))

Version 2001 Owner FAO/WHO Food Standards Programme
Created 14/08/2002  Modified 08/03/2003

3

N

Do
preventative
measures exist?

Is the step

level?

Modify process step,
processor product.

specifically designed
to eliminate or reduce
the likely occurrence of a
hazard to an acceptable

CCP condition identified

4TQToolkit User Guide

Is control
at this step

necessary for safety? No

7
Could
contamination with
identified hazard occur No <
in excess of acceptable levels N This Hazard is not a CCP.

or increase to
unacceptable
levels?

will a
subsequent step
eliminate the hazard or
reduce likely occurrence to
acceptable levels?

Yes
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Detailing the Control Measures and the control Limits.(P3)

Click on the Principal 3 tab.

NOTE: If you have not completed the
Decision Tree tab, this Tab (P3) and the
other remaining tab P(4-7) will not be
available for data entry.

Entering Control Measure
details.

Enter the Control Measure details into the
tab’s upper field. Once text is entered into
the field the “Is there a Control Measure
check mark will become ticked (Yes).

The Check Mark cannot be changed
directly. To reset the Check Mark to the
“No” condition delete the text from the
Control Measure field.

Entering Limit values.

Enter the Specification Limits into the
lower Field. It may be useful to also

R
Be Becord Eon Mew  Hep
Wl ] v |v] +|—] @] B
Fecord 2 "of 1 lkaslep
|'F'n-u |
=
Hassel e aSalepHazard 7 7 |5 s Quslly Hazerd 7 0
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o MUST ure the Cecison Tiem Fisirg |I:F
Frincpal 1 | Principal 2 Pircical 3 | Principsl 445 | Parcical 67 |
Iz thess: & Cumant Conbol mesaus? 7
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Ut thiz Fekd tp dstad B conhol messure et sre appbed =]
Xl
Liwdts
=l
=

include the source of limits you intend to apply.
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Entering the Monitoring. (P4) g gy
Use the Principal 4/5 tab to record how the Mielev) -] Wief B
Monitoring of this control point will be done, when it Pacwd 0 "ol 1 s is
done and who is responsible for doing it. F““ j
M A iEEpiead T o Dl Hosd 7
| 3
Entering Corrective. (P5) e it e S FJ"'_
Pirepsl | | Frimr 2| Fermsl ] Pt 05 | Faepal 67|
Enter the details of the corrective action required L
should the Specification Limits is detected by the Ry 'm‘_ T
monitoring. L cte e
e e Pt ooss e waraoong
The Codex requires specific corrective actions be - s Tire Do e e —_
developed for each CCP in your system. i
Verification Procedure details (P6)
pn bl | P Gt St - ks ==
o o e Becard Foen fwm fein
Enter the Procedures title into the Verification Wi [0 0] =] =] T
Procedure name field.
R 1 o & e
If the procedure is available as a file on your system [Frewa |
you can add the file’s path address to the ' =
Verification Path name field by using the browse Husasd HeFio oty Humr ™ 7 |y Dl i P
button located to the field left. r-w-d _JI
When a valid file is linked in this way the open Yoy LT ookt B T [ -
button will be active and the procedure document gl P | ot 2 e P 5
can be open click on this button. > i
[HALTP Dcammn T ms [CODD AL ISITHTLE D01 e |
i ‘Wi Frooacis Flath
If the procedure has been documented with i IT OO TS wapley HALTP_DT FUw [ ]
4TQFlow, use the Browse to link to that Process e
map. The name field will be automatically filled in |
with the Process map Title. i,
Hicavia |

Forms Used (P7)

The codex requires that you keep records of the CCP monitoring activities, Deviations and corrective actions
taken and modifications to the HACCP system. Use the lower two fields on tab 6/7 to detail the Form’s name
used to record the activity for this Step/CCP and its path name (address) if it is available on your file system.
The Browse button allows you to link to the source file.
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Generating the HACCP Report Table.

File Edit Utiities Zoom 32 Options Help

To generate the HACCP Table report for the current
Process Chart select by clicking on the 4TQFlow >File
(Menu) > Reporting > Generate Data > HACCP menu
item as shown below.

Generate Data

Mlew Chrl+h
QpEn.. . kel
Save Ckrl+5
Save As. .. F1z
Prink. .. Ckrl+3hift+F12
Printer Setup...

Page Setup. .. Ckrl+P
Change Template. ..

Reporting

Print Check Sheet, ..

Exit alk+F4

View Data g
Generake Standard. .,
Wiew Standard. ..

1 C:. . \WINEGRAPES FLW
2 i, \GLARD LW

After the report document has been generated you can view the table by selecting the 4TQFlow >File
(Menu) - Reporting > View Data > HACCP menu item.

The document will be loaded by your Word-Processor and displayed. The Table document is in HTML form
making it suitable to distribution to your target readers via a HTML browser.

If you have 4TQWebgen as a part of your 4TQ Toolkit installation the generated Web Site will include the
HACCP table for each Process map in the “Printer friendly” links section of the “Site Plan” tree control.
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The 4TQToolkit (R6) consists of nine component applications. PACIKCESS FABNBGENENT

The table below details the system requirements for a complete installation.

Minimum Recommended
Operating System: Windows 95b /98 /98SE / Me Windows 98SE / Me
Windows NT4.0 SP3 Windows NT4.0 SP6 or higher
Windows 2000 Windows 2000 SP2 or higher
Windows XP Windows XP (Home or Pro)
Video: VGA SVGA (800x600) or better
RAM: Refer to specific OS. Refer to specific OS.
Network: Windows Compliant Windows Compliant
App Disk Space: 25 Megabytes 35 Megabytes
User Disk Space: 30 Megabytes 100 Megabytes

Companion Applications
Word Processor: MSWord 97 (Word 8) MSWord 97 (Word 8)
MSWord 2000 (Word 9)
MSWord XP (word10)
SpreadSheet. MSExcel 97, 2000, XP

HTML Browser: HTML 2.0 compliant IE5.5 or higher.
(For use with 4TQWebGen type 1)
IE5.5 for 4TQWebgen type 2

Data Access MS Data Access Components Latest Version of freely
installed equal to MSOffice 2000 available MDAC_TYP.EXE
(2.7) or higher.

(supplied)

Not required for basic packs
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4TQ Toolkit R6

Network Installation Notes:
Last updated: March 2003

PROCESS MANAGEMENT

Overview

This software may be installed on LAN networks.

If you are installing onto a peer to peer network, and the software will also run on a PC that is acting as a
file server, please follow the Peer to Peer notes (Page 8).

If you are installing on a dedicated server, please follow the Dedicated Server notes (Page 5). After
installing the applications onto the server, follow the Workstation installation notes for each Workstation in
turn.

If you are installing on a Microsoft Terminal Server installation please refer to page 10.

The directory locations and structures used by the 4TQToolkit are explained on page 3 of this note.

You should review the directory information and decide beforehand the location
and drive mapping(s) that will form your layout.

Anti Virus programs may interfere with the 4TQ installation Program. Please ensure it is
disabled while installing the 4TQ applications. Remember to re-enable your Anti-Virus
application after completing the installation.
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Selecting Directories for Single & Multiple site Network
Installations

General Recommendations:
There are three key file locations required for a network installation of the 4TQTookit.

Before installing the software for use by your users, the location of these three directories must be decided. Altering
the locations after the installation of the workstation(s) is not a supported option. Contact Axion Support if the need
to alter these locations arises.

First Step:
Select the location of the "ProgramDir" Folder.
This folder is used for the actual Executable's and Libraries. It will also contain Sub-folders.

It must consist of a mapped Drive identifier and at least one directory. Do not use UNC forms. Do not use a "root"
drive.

All files in this Directory Structure must be available with "read and execute" permissions. On Novell systems the
"Shared" attribute must set on. Write permission is not needed or recommended.

As a general guide the ProgramDir should co-located with any other general use applications to assist with
administration and minimise drive identifier usage. For example if X: drive is used as a common source drive of
applications then X:\4TQ would make a suitable ProgramDir location.

When the 4TQToolkit Software is to be provided to the user community by more than one server and the users
require access to a common data area, it is essential that all users access the programs with exactly the same
drive identifier and folder.

Second Step:
Select the location of the Systempath.

This folder is used by the user community to store their work (data files). It also contains configuration files that are
accessed and controlled by the 4TQ administrator.

It must consist of a mapped Drive identifier and at least one directory. Do not use UNC forms. Do not use a "root"
drive.

Unlike the ProgramDir, the SystemPath must be consistently mapped for all users. One of the key functions of the
ATQToolkit is in its internal 1ISO9000 compliant version and access control features. Failure to use a consistent
drive identifier and directory for the SystemPath will cause users to be denied access.

It is strongly recommended that the actual SystemPath Folder be available in Write mode only for the 4TQSystem
administrators and Process Owners (people who will author and modify documents). The remaining general users
only require read access.

Third Step
Select the location of the WebRoot.

This location is used to accept the generate output of the Web site Generator. You do not need to alter the default
if the 4TQWebgen product is not included in your license. The default location is a sub-folder of the SystemPath. It
may be relocated as required. Ensure consistent Drive Identifier mapping is used for all users. 4TQWebGen can be
set to run a batch or command script when the site generation as been completed. You can use this feature to re-
locate or duplicate the site contents as required.

Commencing the software Installation

Once these locations have been defined, proceed with the installation as described in the following pages.

R6 Page 2 of 10



Di recto ry Stru Ctu re Detai IS AN Setup - Custom lnstallalion

Irlad bt
[ 'uiim i [acineimy
The Setup Installation Program(s) has a Set Directories dialog to provide easier ¥
initial application configuration options. W Cops Piogesm Files [Ny p— 1T &6
The new dialog is available when performing a "Custom" installation from the "Set k¢ Copy Ciplional Fiss Sulact llwm= AT
Directories" button (upper right) of the Custom Installation Dialog. B Do Progears Acion: O adact Braa o
W [ioptional Actions Gdact Items i}
General Recommendations -
When creating directories (folders) try to maintain the DOS 8.3 convention. Irisdstion [ries: [ \airdory [ries: [
If this is not possible, try to avoid long pathnames with whitespace characters or dos ﬁlﬂ ;ﬁg ﬁm 13“!1'%111“53
reserved characters. Especially do not use folder names with two whitespace
characters or the “.” character. The ShellExec function on some OS versions can in
some cases misinterpret such names with unpredictable results. Bersanee | e Ent | Hele

Program Path

The Program Path location is used by all 4TQ component applications for executable (. exe) and Dynamic Link Libraries (.DLL). It is essential
that all 4TQ application component applications be located in the same directory.

The Program Path is viewable after installation from 4TQFlow Options Customise Dialog. It cannot be changed from within the dialog. Users
require “Read” access right to this directory.

System Path
The System Path defines the location there the 4TQ applications will store your data files.

Users who will create and modify Process Maps will need “Write” access rights to this directory.

The System Path is used by 4TQFlow, 4TQExplorer and 4TQWebGen to define the M

top level Directory of the 4TQ Process Guardian System area.

When the 4TQ Process Guardian features are activated 4TQFlow maintains an Piezse specily the installstion, diechonies
1SO9001/2.3 element 4.5 compliant protective shield over Process Map files located
within or below the SystemPath directory. Progrors Path m J
4TQWebGen uses the SystemPath setting to define the upper boundary directory of Syston Fadh | halle J
the Process Maps and 4TQExplorer files that it will be included in the Generated Web-
Site. Weblien Path [L AT 0 weRa ]
ATQEXxplorer uses the SystemPath setting to locate "Company System" 4TQExplorer Cuoe blingd
perspective files that appear on 4TQExplorer's File menu. -

-~

As a general principal it is worth creating folders (directories) under the SystemPath for

users to store specific process maps and reference and Policy documents. In such

cases it may be advantageous to restrict the SystemPath to read-only rights for all fasck | Cordirass I Lyt | Help |
users, and then specifically grant the Process Management System administrator’'s
account write permission to the SystemPath Folder and sub folders. Process Owners
and Process Reviewer as a group can be granted write permission to the areas covered by the SystemPath’s Sub-Folder as required.
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The Systempath contains the following sub-folders.

Archive

The ArchivePath is used by 4TQFlow to place the archived Process Map files. The same relative pathing
is maintained from the ArchivePath location to the archived files as was the pathing of the current version
Process Map file relative to the SystemPath. Both the SystemPath and ArchivePath locations must be
valid for the 4TQ Process Guardian feature to be active.

Users who will create and modify Process Maps will need “Write” access rights to this directory.

Macros

The Macro folder contains sub-folders for each Word Processor version supported.

Template

& SM35E0_D (L]
=1 410

----- 7] auchive

- IPMS

-] Records
-7 Samples
H-_ Trairing
-] webRoot

The Template Path setting is used by 4TQFlow, and the Word-Processor Template macros to locate the 4TQ Template file (.FLT).
Normally users require “Read” access right to this directory and in most cases it should be the same as the Program Path directory.

Records

The Record Path is only used by the 4TQ Word-Processor template macros. This directory is used to store the reference files used by
the macros and also the MacroLog.csvV file which records the generation of Process Report Documents. Users who will generate

documents from 4TQFlow will require Read / Write access to this directory.

WebGen

The WebGen Path defines the default target location of the HTML files generated by 4TQWebGen.
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The Software must be installed from a Workstation connected to the

Server. T ool P 5100
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e Map a Drive(s) to the location(s) on the Server that you wish to :'Egﬂ:'i?n-_f.;m:m
install the applications. Make sure the Drive identifiers are same one
that will be used by the other workstations. Ensure that you have full
rights to the mapped network drive, and the local machine's Windows

and System directories and the registry. T PR T - =]

e Close all other applications on the workstation. Sl o wethod eppkosbls b e gl
T sl o rersowe Shard siore: r
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e Disable virus-checking utilities. echde il oo bast wecdh. ties

Dutonn | | | Eg

e Run the Setup.exe program from the CD-ROM'’s QuickStart Menu
e |f a Select Script dialog appears then

Select the “Network master” script, click the "install or remove Network files ..." Radio button and Click the
Custom button.

If the Express or Custom dialog is displayed, select the Custom Option and then select the Network Installation
Option.

If you are performing a Standalone installation the Custom installation dialog will be displayed. If you are
performing a Network Installation the “ Set Directories” dialog be displayed as shown below.

. Click the "Set Directories” button (if required) and set the

files locations as required. If you selected the “install or remove % Fazae speciy the installation deectnes

Network files...” the Set Directories dialog will automatically

displayed. Paogrer Pt ISRV .. ]

An explanation of the use and rights required for each —

directory is included at the start of this document. FmPaty . -AT0 -
Weblien Path [L ATDVwesFia ]

The Program Path sets the location of the application’s executable Shate: kings i

components and users only require read execute access to this =

directory. Changing the Program Path will update all the paths £

listed below it

Bock | [Cowwe] Ew | b |
The System Path sets the main location of the user data area. In
general terms users require write access to this folder and it's sub folders. Altering the System Path will update all
of the paths below it. Always ensure that all of the path locations include a directory, avoiding the use of the
“root” directory of a drive.

The Browse buttons on the right of each field can be used to navigate and select the required directory locations if
they already exist.
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When all of the directories have been set as required Click the Continue button to return to the Custom Installation
dialog. The path information is recorded and used to setup each workstation. It is important to enter this information
exactly as required as this information is recorded on the server’s script copies and will be used by the setup
program for each workstation.

. Click the Install button.

The Setup program will record its actions in a text file (setup.log), in the temporary directory, on the
installing workstation during installation. If the installation is successful, the setup.log file is moved
(appended) to the 4TQ-application directory.

The Setup.log file may be reviewed in a text editor.

o After the Setup program has completed, test the application(s).

Special note for Novell server installations

If you have installed the 4TQ program files on network where they will be shared by a number of users you
must change the Novell attributes of all .exe and .dll files in 4TQ program directory to ReadOnly and
Shared.

Workstations must now be installed from the network 4TQ directory. Follow the Workstation Installation
Notes for each Workstation in turn.
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Workstation Installation Notes:

The 4TQ applications must be correctly installed on your server before attempting to install any Workstations.

To install the 4TQ applications on a Workstation follow the steps below.

Log-on to the network.
Close all other applications on the workstation including Anti-virus applications.

Map the required Drives to the locations of the 4TQ applications on the Server. Ensure the Drive
identifiers used are the same as the Drive identifiers used during network installation procedure.

Run the setup.exe program from the 4TQ-application directory.

Select the desired script for this workstation, check the install single Workstation option and then
click the Express button.

Wait for the program to complete and the application(s) to be displayed.

Check the user’s permissions are as required.

Workstation Un-install Notes:

To remove the 4TQ applications on a Workstation follow the steps below.

Log-on to the network.

Map a Drive to the location of the 4TQ applications on the Server. Ensure the Drive identifier used, is the same as
the Drive identifier used during network installation procedure.

R6

Run the setup.exe program from the 4TQ-application directory.

Select the desired script to be removed, check the remove single Workstation option and then click
the Express button.

Wait for the program to exit.
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Peer to Peer Notes:

If the PC that will act as a file server for 4TQ applications is running Windows95/98, please refer to Special Windows95/98 Server notes below.

From a workstation, map a drive identifier to the location on the Server machine, where you wish to
create the 4TQ applications directory structure. Make a note of the Drive identifier you use. You must
use the same identifier to install all of the other workstations. Ensure that you have full rights, to the
mapped network drive, and the local machine's Windows and System directories.

Close all other applications on the workstation.

Disable virus-checking utilities.

Run the Setup.exe program, and select the Custom option.
Select and click the "install or remove Network files." button.
The Custom installation dialog will be displayed.

Click the "Set Directories" button alter the file location to the required mapped network Drives and
paths. Ensure that the application directory (default: C:\4tq ) is located in a directory under the Mapped
drive. Do not install 4TQ applications into the root of a Mapped Drive. Always install the
software in a Directory (folder) of a mapped Drive

Click the Install button.
You will be prompted to change disk if required.

The Setup program will record its actions in a text file (setup.log), in the temporary directory
(environment variable TEMP or TMP), on the installing workstation during installation. If the installation
is successful, the setup.log file is moved (appended) to the 4TQ-application directory.

After the Setup program has completed, test the application(s).

You can now install the other Workstations directly from the network. Please refer and follow Workstation
Installations notes below.
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Special Windows 95/98/Me Server notes.

Windows95/98 does not support drive mapping (redirection) of a local hard disk. If your network consists of
WindowsNT / 2000, and Windows95/98/Me machines, it is recommended that the application be installed on a
WindowsNT /2000 machine. If this is not possible, and you wish to use the applications on the Windows95 machine
that is acting as a Server, follow the steps below.

Note: 4TQExplorer must not share files with the other Workstations.

e From a workstation, map a drive identifier to the location on the Server machine, where you wish to
create the 4TQ applications directory structure. Make a note of the Drive identifier you use. You must
use the same identifier to install all of the other workstations. Ensure that you have full rights to the
mapped network drive, and the local machine's Windows and System directories.

e Close all other applications on the workstation.

e Disable virus-checking utilities.

e Run the Setup.exe program and select the Custom option.

e Select and click the "install or remove Network files." button.
The Custom installation dialog will be displayed.

e Click the "Set Directories" button alter the file location to the required mapped network Drives and
paths. Ensure that the application directory (default: C:\4tq ) is located in a directory under the Mapped
drive. Do not install 4TQ applications into the root of a Mapped Drive.

e Click the Install button.
You will be prompted to change disk if required.

The Setup program will record its actions in a text file (setup.log), in the temporary directory
(environment variable TEMP or TMP), on the installing workstation during installation. If the installation
is successful, the setup.log file is moved (appended) to the 4TQ-application directory.

e After the Setup program has completed, test the application(s).
e Exit the 4TQ applications on the Workstation.

e Move to, and Logon to the Windows95 Server Workstation.

e Run the Setup.exe program from the 4TQ applications directory.
e Select the Custom installation option.

e Select the Workstation installation option. (NB: Do not use the Standalone or Network Installation
option.)

e Enter the Workstations User Name and Company Name.

e Wait for the program to complete.

You can now install the other Workstations directly from the network. Please refer and follow Workstation
Installations Notes below.
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Installation Notes for Microsoft Terminal Server

The 4TQToolkit installation consists of two steps. First the software must be installed on the server.

Once installed on the server a workstation installation needs to be performed for each client using the software.

Server Installation

1.

a > w D

© © N ©

10.

11.

12.

When the CD is inserted the installation program begins automatically. Cancel the install immediately
by selecting the Exit option.

Select Add/Remove Programs from Control/Panel.
Click Install button.
Click Next button

The system will try to locate a file called setup.exe. It should find the file on the CD. If a different
setup.exe is located use the browse button to select setup.exe on the CD.

Click Next button
Select the “Install for this user only option”.
Click Install button.

The standard 4TQToolkit installation will commence. The 4TQToolkit must be installed in network
mode. To do this select Custom Install followed by Network Installation when prompted during the
installation process.

At the end of the 4TQToolkit setup 4TQExplorer and the 4TQToolkit help file are opened. Close these
applications.

When the 4TQToolkit installation is complete click the Finish button on the Install./Remove Programs
dialog.

The installation of the software on the Terminal Server is now complete.

Client Installation

1.

2
3.
4
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Select Add/Remove Programs from Control/Panel.
Click Install button.
Click Next button.

The system will try to locate a file called setup.exe. The setup.exe that needs to be used is located in
the 4TQ Program Directory (where the 4TQToolkit was installed on the server). Use the Browse button
to locate this file.

Click Finish

The standard 4TQToolkit installation will commence. The 4TQToolkit must be installed in workstation
mode. To do this select Custom Install followed by Install Workstation when prompted during the
installation process

The workstation setup is complete when 4TQExplorer and the 4TQToolkit help file are opened.
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